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Introduction

Symbols

The following symbols may appear in the product documentation or on the product.

symmeltry-PACs

&Only

Device

by or on the order of a licensed healthcare
practitioner

Prescription Devices

Symbol |Symbol Name |Symbol Description Standard Number Symbol
and Name Reference
Number
Manufacturer Indicates the name and address of the ISO 15223-1:2021 5.1.1
manufacturer
Authorized Indicates the Authorized Representative, ISO 15223-1:2021 5.1.2
Representative in [responsible for the device in the European
the European Economic Area (EEA).
Economic Area
(EEA)
Date of Indicates the date when the device was ISO 15223-1:2021 5.1.3
Manufacture manufactured.
Caution Indicates information that is important for ISO 15223-1:2021 5.4.4
preventing loss of data or misuse of the
software.
Batch Code Indicates the full Software Release / Version ISO 15233-1:2021 5.1.5
LOT number
r Serial number Indicates the manufacturer’s serial number sothata |ISO 15233-1:2021 5.1.7
SN specific medical device can be identified
Catalogue Number | Indicates the manufacturer’s catalogue number so that | ISO 15233-1:2021 5.1.6
R E F the device can be identified
] ’. Consult Indicates the need for the user to consult the ISO 15233-1:2021 5.4.3
1 instructions for instructions for use
use
Prescription Caution: Federal law restricts this device to sale |21 CFR 801.109(b)(1) |N/A

BS EN ISO 15223-1:2021 Medical devices - Symbols to be used with information to be supplied by the manufacturer -
Part 1: General requirements
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Indications for use

EXA™ is a software device that receives digital images and data from various sources (i.e. CT scanners,
MR scanners, ultrasound systems, R/F Units, computed & direct radiographic devices, secondary capture
devices, scanners, imaging gateways or other imaging sources). Images and data can be stored,
communicated, processed, and displayed within the system and or across computer networks at
distributed locations. Lossy compressed mammographic images are not intended for diagnostic review.
Mammographic images should only be viewed with a monitor cleared by FDA for viewing mammographic
images. For primary diagnosis, post process DICOM "for presentation" images must be used. Typical users
of this system are trained professionals, nurses, and technicians.

Training

Users of this software must have received adequate training on its safe and effective use before
attempting to operate the product described in this Instructions for Use. Users must make sure they
receive adequate training in accordance with local laws or regulations.

Regulatory and compliance

Konica Minolta Healthcare Americas, Inc.
2217 U.S. Highway 70 East
Garner, NC 27529 USA

Tel: 1-800-366-5343
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System requirements

The following are the system requirements for clients of Symmetry PACS based on typical usage
scenarios. For the recommended requirements of your specific implementation, contact your Konica
Minolta representative.

/N

RECOMMENDED: To avoid loss of functionality and data during a power loss, connect an uninterruptible
power supply. When running the system by the UPS alone, always save data immediately after
modifying.

REQUIRED: Install anti-virus software on the server and each client.
Server

Component Specification

Processor Intel® Xeon® Gold 5120 CPU @ 2.20GHz
Physical Cores 14

Memory 31.5GB

Storage 1.2 TB SSD

NIC Single 1000 MB/s

Workstation - User

Component

Specification

CPU Intel® Core™ i5 or later
RAM 8 GB or more

NIC Single 1000 MB/s
Storage HDD, 500 GB or more
(05 Windows 10 Pro, 64-bit
Monitor 20 inch, 1600 x 1200

Workstation — Reading Radiologist

Component

CPU

Specification

Intel Xeon® E-2176G (3.70 GHz, 12 MB) or later

Graphics Cards

2 NVIDIA® Quadro® P1000 cards

RAM

32 GB or more

500-000577A
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NIC Single 1000 MB/s
Storage SDD, 500 GB or more
(0] Windows 10 Pro, 64-bit
Monitor Diagnostic displays
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Calibration and measurement accuracy

Measurement accuracy partially depends on image quality, which is subject to various factors including
the skill of the technologist, the precision of the modalities, and image resolution. However, clinical users
of Symmetry PACS can help ensure diagnostic image quality and accurate measurements by using
appropriate viewer settings (such as window/level and zoom) and by calibrating monitors (see "Calibrate
monitors").

The clinical user is responsible to judge the accuracy of the measurements based on the image quality
and based on the accuracy of placed measurement points. For a table of measurement accuracies, see
"Measurement Accuracy Limits" in the appendix.

Help us improve!

If you find any errors in this manual, would like us to explain something better, or would like us to cover a
new topic, please let us know by visiting our online portal.

https://support.kmhapub.com/PremierCustomer/Home.aspx

Monitored: 8:00 AM-8:00 PM EST

A

For urgent issues, please call the Hotline.

500-000577A 7


https://support.kmhapub.com/PremierCustomer/Home.aspx

Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Getting started

Configure your working environment

Before using Symmetry PACS, you must configure settings and information used in various parts of the
program. This section helps with the most common areas of basic configuration. For help with other
detailed settings, contact your Konica Minolta representative.

Set up credentials, browser, and monitors

Configure the language in Chrome

You must configure the browser language of your client computer as follows.

Procedure

1. In Chrome, select the customize : button, and then select Settings.
2. On the left pane, select Languages.

3. Ifthe local language and culture does not appear in the list, select Add languages, and then add
the language.

Note: The culture must be correct. For example, in Canada, ensure that English (Canada) is
installed.

4. Select the more actions : button for the local language, and then select the Display Google
Chrome in this language checkbox.

5. Select the more actions : button again, and then select Move to Top.

6. Select Relaunch.

Sign in to the Exa platform

You can sign in to the main application or a portal.

1. In Chrome, go to the URL given to you by your Konica Minolta representative.
Enter your sign-in credentials.

Select the I agree to HIPAA Privacy Notice checkbox.

A wWN

Do one of the following:

e To sign in to Symmetry PACS, select LOGIN.
e To sign in to a portal, select a portal button.

500-000577A 8
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About two-factor authentication

If your facility purchased two-factor authentication (2FA), administrators can use it to increase security
by requiring an additional sign-in procedure. During sign-in, Symmetry PACS sends a character string
called an authentication token to your email address, or one is generated by a mobile app called Google
Authenticator. You then enter that authentication token on the Symmetry PACS sign-in screen to finish
signing in.

Administrators: To make two-factor authentication available for a user, you must configure the user’s
email address.

See also:

Create a user
Sign in using 2FA with email
Sign in using 2FA with Google Authenticator

Sign in using 2FA with email

If your administrator made two-factor authentication available, you will receive an email from the server
with a verification code. Using that code, follow these steps.

Procedure
1. Sign in to Symmetry PACS in the usual manner.
2. Inthe EMAIL VERIFICATION PENDING box, paste the verification code and select VERIFY.
Result: Symmetry PACS signs you out.

3. Sign back in to Symmetry PACS, select REQUEST TOKEN, type the token sent to the email
address, and then select LOGIN.

Note: Every time you sign in in the future, you must repeat this step, using a different token each
time.

See also:

Sign in to the Exa platform
About two-factor authentication

Sign in using 2FA with Google Authenticator

Sign in using 2FA with Google Authenticator

After you have signed in using 2FA the first time, if you prefer, you can use Google Authenticator to sign
in in the future rather than an email token. To use Google Authenticator to sign in, follow these steps.

Procedure

500-000577A 9
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1. Download the Google Authenticator app onto your mobile device.

2. In Symmetry PACS, on the burgerE menu, select the blue Konica-Minolta ﬂ globe.

3. Inthe My Profile dialog, in the Two Factor Authentication box, type your sign-in password, and
and then select the Enter key.

4. Select SHOW QR CODE.

5. In Google Authenticator, tap Scan a QR Code, and then scan the QR code displayed by
Symmetry PACS.

6. In Symmetry PACS, in the One-Time Password box, enter the code from your new Google
Authenticator profile, and then select VERIFY.

See also:

About two-factor authentication
Sign in using 2FA with email

Reset your password

If you forgot your password, contact your Symmetry PACS administrator for instructions on how to reset
your password.

Change your password
You can change your sign-in password.

Procedure

1. Select the burgerE button.
2. At the top of the burger menu, select the blue

Konica Minolta globe:

% or (user avatar).

3. Inthe My Profile dialog, select CHANGE PASSWORD.

4. Enter current and new passwords, and then select SAVE PASSWORD.

Add an avatar

An avatar is an image such as a photo that represents you in various parts of the program.

500-000577A 10
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Prerequisites: Prepare a PNG image to use as the avatar.

Procedure

1.

2
3.
4

At the top of the burgerE menu, select the blue Konica Minolta ﬂ globe.
In the My Profile dialog, select Choose File.
Browse for and select your avatar image, and then select Open.

Select SAVE.

Edit your user profile

Each user of Symmetry PACS has a profile with sign-in credentials and other information. After signing in,
you can view and edit your information.

Procedure

1.
2.

Select the burger E button.

At the top of the burger menu, select the blue Konica Minolta globe or user’s avatar:

or * (user avatar).

Result: The My Profile screen appears.

500-000577A 11
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My Profile EXA Version 1.4.32-p3-1

UDI (01)0081710002019

User Name iztek

Name = FPacyg | Viztek

Mobile Phane / Email | Mobile Phone Ernail

Default Device * « [0 Auto Open Dictation on Device
Default Location ® e omnany w [ Always Open Schedule Book in a New Tab
Rows to Display a0 w Themes | default » Culiure | English-US w

O Pin Burger Menu [J Hide worklistlcons [ Hide Order Menu

E

Bandwidth Select w

Sesszion Interval 300 min (10-600)

Default Scheduling @ Radiclogy

3. Enter the following settings.

User Name Type a user name for sign-in purposes.
Name Type your true name.
Mobile Phone/Email Type your mobile phone number and/or email address. An email address is

required for two-factor authentication.

Default Device [Unused]

Auto Open Dictation on Device | [Unused]

Default Location Select a facility as your default location. When you sign in, this facility
appears in various parts of the program by default. You must configure
the facilities that you want to make available in this dropdown list.

Always Open Schedule Book in | Select to cause the program to open a new browser tab for the schedule

a New Tab book automatically when you open it.
Rows to Display Select how many rows to display on the worklist.
Themes Select a default theme of Bright (default) or Dark.

500-000577A 12
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Culture Select the language/culture of the user interface.
Pin Burger Menu Select to keep the burger menu open in the left pane of the screen.
Hide Worklist Icons Hides the lower toolbar and study row buttons on the worklist. Hidden

functions remain available in shortcut menus and other controls.

Hide Order Menu Hides the navigation menu within the Edit Study screen.

Bandwidth Select the expected speed of the network on which your client installation
runs. This helps to optimize performance in your networking
environment.

Session Interval Type the number of minutes to elapse before the program times out and
returns to the sign-in screen.

Default Scheduling/Radiology | [Unused]

4, Select SAVE.

View version information
You can view version information about the application, host system, services, and external tools.

Procedure

1. Select the burgerE button.

2. At the bottom of the burger menu, select the white Konica Minolta globe.

-

IOHHICA MINOLTA

Result: The About screen appears.
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App/DB/Misc Services
Exa: 1.4.32-p3-135 C-Move Service: 1.4.32.50
Mode: v16.16.0 DICOM Service: 1.4.32 50
PostgreSQL- 14.4 Fax Service: 1.4.32.50
NGINX: 1.23.1 fimpeg: Mot Found
Redis: Mat Found imageserver_http:> 1.4.32.50
TxTransportation: Mot Found Image Service: Mot Found

MWL Service: 1.4.32.50
System Opal Listener Service: 1.4.32.50

Opal Sender Service: 1.4.32 .50
Dicom Print Service: 1.4.32.50
Storage Commitment Service: Not Found

035 Type: Windows_NT
03 Platform: win3z
05 Architecture: xA4

Total System M 1200 GB
otal System Memary: | Tools

Opal Teols Setup: Mot Found
Opal Viewer Setup: Mot Found
EXA Trans: Not Found

EXA Doc Scan: 1.0.11.0

Create a shortcut for Symmetry PACS

You can create a shortcut for the local Windows user to Symmetry PACS and
place it on the desktop.

Procedure

1. In Chrome, go to the Symmetry PACS sign-in page.

2. Inthe address bar, drag the lock ® icon onto the desktop.
The Exa Login shortcut appears.
3. Optional. To change the shortcut icon:

e Right-click the shortcut and then select Properties.
e Select Change Icon, and then browse for and select an icon.
e Select OK.

Calibrate monitors

Especially after a new installation or upgrade, you can use Symmetry PACS to calibrate your monitors to
ensure accuracy of length and other measurements. If all images you work with contain pixel spacing
information, you can skip this procedure.

Prerequisite: Enter Calibration Width and Calibration Height settings for your monitors.

Procedure

500-000577A 14
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1. Open animage in the viewer.
2. Optional: For higher accuracy, on the image shortcut menu, select View > Actual Image Size.
3. Hover over the upper-right corner of a frame, right-click E, and then select Recalibrate.
4. Select two points on the image.
5. In the Dialog dialog, type the length between the points and then select OK.
Note: If prompted to apply calibration to the series, select OK.
Results
e The calipers are modified.
e Previously annotated measurements are redrawn.
e Future measurements will appear according to the new calibration values.

See also:

Set up connected displays

500-000577A 15
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Configure Symmetry PACS

This section describes core settings that you should review or configure prior to using Symmetry PACS.
For other settings, see the following topics.

See also:

Worklist settings
User settings

Viewer settings
Configure the viewer

Set up the office: Companies

Company here means the parent hospital, clinic, or other institution where Symmetry PACS is installed.
After configuring your company you can configure its child facilities (see Add a facility) and other locations
as needed. In configuring your company you enter basic settings such as its name and address, but also
—depending on product and configuration—you can customize Symmetry PACS for your company's needs
by adding preset options for such things as: sex, body parts, and ethnicity; patient alerts, critical findings,
cancellation reasons; MRN and accession number formatting; passwords; and billing modifiers.

Configure your company
To add your company to Symmetry PACS:
Procedure

1. Go to SETUP > Office > COMPANY.

Code * 0 Mamvs * My Castpding Tirmtnes * L5 Eastatn » O EnstleL0AF [ Frsble PCops Seisics [ Drslic Payment Gatewny

[ Teiggm Beuting an Sudy Flag Changsd m

2. Enter the following settings.

Code Type your internal code for your institution.

Name Type the name of your institution.

Timezone Select the time zone used by your institution.

Enable LDAP If your institution uses an LDAP or Active Directory server, select this
option to display the LDAP CONFIG sub-tab, and then see Configure all
LDAP settings.

500-000577A 16
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Enable RCopia Service

Select to turn on the RCopia service, if available, and display the RCOPIA
CONFIG sub-tab. Enter settings in the sub-tab, and then select SAVE.

Enable Payment Gateway

SAVE.

Select to turn on the Payment Gateway service, if available, and display the
PAYMENT GATEWAY sub-tab. Enter settings in the sub-tab, and then select

Changed

Trigger Routing on Study Flag

changes a study flag.

Select to reprocess routing (DICOM transactions) automatically when a user

3. Select SAVE.

4. Enter additional information as needed by following the steps in later subsections.

Note: When finished, select SAVE again at the top of the screen on the right side of the Trigger
Routing on Study Flag Changed checkbox.

General settings

Enter the main contact information for your company and other basic settings relating to scheduling,

billing, documents, security, image viewing, and peer review.

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select Office.

3. On the COMPANY tab, on the GENERAL sub-tab, enter the following settings.

Enter the company address and contact information.

Contact Information

Scheduling

Highlight new Patient exams on
ScheduleBook

Select to highlight new patient appointments on
the schedule book for easier identification.

Highlight Color

Select the color to use to highlight new exams on
the schedule book.

Default Distance from ZIP Code

Select the default distance for finding facilities near
patients.

Enable schedule rule reason

Select to require users to select a schedule reason
when creating a schedule block.

Enable reschedule reason

Select to prompt for a reason when rescheduling
an appointment.

Enable pause reason

Select to prompt for a reason when a technologist
pauses an exam.

Billing Information

Corporate Office Type

Select Person for an individual practice. Otherwise,
select Non-Person Entity.

500-000577A
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NPI No. Type your national provider identifier.

Taxonomy Code Type your NPI taxonomy code.

Tax ID Type your national tax ID.

EDI Submitter ID If using an EDI service, type your submitter ID.

EDI Receiver ID If using an EDI service, type your receiver ID.

Modifiers in Order Forces the user to enter modifiers before creating
an order.

ICD9 to ICD10 Select to automatically convert diagnostic codes

from the ICD9 to ICD10 standard.

Documents File Store Select a file store for scanned documents at your
company. This is separate from the file store used
by AEs to store images.

Security Account Lockout Threshold Set the maximum number of sign-in attempts.
Viewer Viewer Titlebar Text Select to display the patient name or the accession
number on the title bar when opening a study in
the viewer.
Email Information Server Address Type the address of your outgoing SMTP/mail
server.
Port Type the mail server port number, provided by
your ISP.
User Name Type the account administrator user name or

email address.

Password Type the email account password.

Sender Address Type the default sender address (the
administrator's email address).

Email Subject Type a default email subject to use if no subject is
configured on the notification template.

4. Select SAVE ALL INFO.

Settings

Settings here means presets that appear as options in other parts of the program, mostly related to
people (such as staff and patients).

Procedure

1. Go to SETUP > Office > COMPANY > SETTINGS.

500-000577A 18
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COMPANY

Gty *

Aty Company

Timezong

) Tz Resating an Study Flag Chasrged m

Wari ol 5wt
Eax

Doy Paria
Employer Flmlon
inZmErialy

Hacial identity
[thnaciy

Relationateg

e H el

2. On the left pane, select a category.

3. At the bottom of the screen, in the Description box, type a setting.

User Titles

User prefixes, such as Mr., Mrs., and Dr.

Marital Status

Patient marital statuses, such as Single, Married, and Divorced.

Sex

Patient sexes.

Body Parts

Patient body parts under examination.

Employee Status

Statuses of employees at your institution.

Credentials

Physician credentials, such as Ph.D. and M.D.

Racial Identity

Patients’ self-identified races.

Ethnicity Patients’ self-identified ethnicities.

Relationship Relationships of people to patients (including self).

Priorities Priorities that can be assigned to studies in the worklist. These are separate
from STAT levels.

Sources Sources of patient arrivals, such as clinic referral, attorney office, hospital
transfer, or emergency room.

Orientation Lateralities as they pertain to the study.

500-000577A
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Languages

Patients’ preferred languages.

Specialties

Healthcare worker specialties such as oncology or sports medicine.

Communication Preferences

Patients’ preferred methods of communication, such as cell phone or
email.

Administration Site

Immunization modes.

Regions

Geographical regions, such as for grouping markets.

Units of Measure

Units of measure, such as for doses of medication or contrast material.

Needle Gauge

Available needle gauges.

4. Select SAVE.

App settings

App settings here means presets that appear as options in other parts of the program.

Regarding STAT levels

Because different PACS systems use different STAT levels, you need to translate the STAT level of
inbound studies to the STAT levels you configure in Symmetry PACS, and conversely, you need to
translate the STAT levels of studies you send to other systems to their STAT levels. To do this, as

symmeltry-PACs

described in the following table, select the value of the (0040,1003) Requested Procedure Priority tag
to translate "from" in inbound DICOMs, and to translate "to" in outbound DICOMs.

Procedure

1. Go to SETUP > Office > COMPANY > APP SETTINGS.

500-000577A
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GNP
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2. Inthe list on the left side of the screen, select a setting.
3. For each option in the following table, enter settings.

States Description | Type states, provinces, prefectures, or other regions used in various parts of
the program.

Scan Document Description | Type descriptions to assign to documents to be scanned, such as “Photo ID”

Types or “Explanation of Benefits.”
Requires Select to require review of the document before moving to the next status in
Review the current workflow. See Require document review.

Stat Level Description | Type descriptions for each of the STAT levels (0-5).
Color Click in the text box, and then use the color picker to select a background

color for studies on the worklist having the STAT level.

Text Color Select a text color for studies on the worklist having the STAT level.

Inbound Select the requested procedure priority of inbound studies to assign to the
DICOM STAT level you are configuring.
Outbound Select the requested procedure priority to assign to outbound studies that are
DICOM in the STAT level you are configuring.

TAT Description/ | Select the edit ¢ icon of a TAT to modify its description, text color, and
Colors background color. You can set the max TAT for a facility under Setup > [all

uppercase menu] > Office > Facility.

Patient Arrival Waifl Use the following settings to configure color-coded descriptions corresponding to lengths of]
Times time that a patient waits upon arrival. These bands of time appear in the wait time monitor
at the top of the Patient Arrival Worklist.

Description | Type a description for the band such as "Short Wait" or "Long Wait."

500-000577A 21
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Color Background color for arrivals at the current wait time.

Text Color Text color for arrivals at the current wait time.

Minutes Type the maximum number of minutes that a patient waits to remain in the

band.

Access Reasons

Reasons for accessing confidential patient records when using the Break the Glass function.

Code Type an internal code for the reason.

Description | Type a name or description of the reason such as, "Direct patient care."

Ordering Facility
Types

Description | Type a description such as "Assisted Living" or "Prison."

4. Select SAVE.

Reason codes

Reason codes are text strings that identify reasons for taking various actions such as cancellations, follow-
ups, and rescheduling. You can preconfigure them for use in various parts of the program.

Procedure

1. Go to SETUP > Office > COMPANY > REASON CODES.

e *

biarvs *| M Carmieg Tinetans * LS Eastun

) Tiegase Aiunting oo iy Fidey Chansed m

Abot Resmcne
Ll Catagorms
Crtcal Findings
Prelow-llp Hesmans
HE Coraaris
Patier Alaris
Reason for Daath

Trareqroriation Reasons

B R

Chitd Caow

Fhyaicsl LimBalions

s b

chaciiing Dorfict

T Tl b3

B Huds inpciive

2. On the left pane, select a category.

3. On the right pane at the bottom, type a reason.

500-000577A
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4. Optional: To make the reason temporarily unavailable, select Hide Inactive.

Cancel Reasons Description Type reasons for such canceling such things as appointments or
exams in progress.

Abort Reasons Description Type reasons for aborting exams in progress.
Call Categories Description Type reasons phone calls, such as to patients for scheduling.
Critical Findings Description Type critical findings you can assign to studies, such as "Acute
Positive."
Follow-Up Reasons Description Type_ reasons to follow up on a study, such as "Benign but
suspicious."
Code Type your internal code for the finding.
Follow Up Type and select the length of time until the follow-up.
HIE Consents Description Type indicators as to whether a patient has consented to release of

demographics and medical data through a Health Information
Exchange for treatment, payment, and health care operations

purposes.
Patient Alerts Description Type alerts to assign to patients, such as "Patient is claustrophobic."
Reason for Death Description Type reasons for death.
Color Assign unique colors to each schedule rule reason for easy

identification on the schedule book.

Transportation Reasons | Description Type modes of transportation such as "Medical Transport" or
"Personal Vehicle."

5. Select SAVE.

MRN information

MRN information here means your internal format for MRNs at your company. To Symmetry PACS can
assign MRNs automatically according to the following settings.

Procedure

1. Go to SETUP > Office > COMPANY > MRN INFORMATION.
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COMPANY

el * M =

a Tilgger Rooting on Study Fles Cranged

MR# inlormaticn

MRH Type * Do auslt b
Frafix
Suffix
Pl Suite: Max ] Fieed Length
Lengih
LLLFFY

Eraview

2. Enter the following settings.

My Corrpany Terszord *  |SS/Eariem

ﬁ Can £t

[ allow Dupficenss

MRN Type Select Default to use the default formatting included with Exa PACS/RIS, or
Custom to define your own formatting.

Prefix Type a prefix to prepend to the MRN. To be able to modify the prefix,
select Can Edit.

Suffix Type a suffix to append to the MRN.

Allow Duplicates

Select to allow duplicate MRNs.

Prefix/Suffix Max.

Select Fixed Length (above), and then type or select the maximum length
of the MRN prefix and suffix.

Fixed Length

Select to enter a maximum length of the MRN.

3. Select SAVE.

Accession information

Accession information here means global modifications you want Symmetry PACS to make to accession

numbers.

Procedure

1. Go to SETUP > Office > COMPANY > ACCESSION INFORMATION.

500-000577A

24



Symmetry® PACS 1.4.32_P4 User's Manual symmeltry-PACs

Code * 1y MHame * &by Comany Tavsapsna ¢ EEaelm - I: Enable LOAS

L_ Enadle R opia Serace n Enatls Payrrees| Gatrvay '__ Trigges’ Reasang on Stady Flag Chargsd m

Hoos suian lnlormstian

2. Enter the following settings.

Prefix Type a prefix to prepend to the accession number.

Suffix Type a suffix to append to the accession number.

3. Select SAVE.

AE filter

This sub-tab is currently unused.

Payment gateway
If you selected Enable Payment Gateway previously (see Configure your company):
Procedure

1. Go to SETUP > Office > COMPANY > PAYMENT GATEWAY.
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COMPANY

Cada * A Mama * phye Compary Tinezand *  |JS/Eastern

Enaile RCopa Service B Enable Payment Soteway Trigger Aouting on Study Flag Changed ﬂ

GEMERAL BETTIHGS APP SETTINGS [EASON CODES MRH INFORMATION

PAYMENT GATEWAY COPIA COMFI PABEAWORD kT

Gateway Information

Gateway * w
el -
ChentiD *

Client Sworey *

Statiz URL *

2. Enter settings to make a payment gateway available, such as PayPal.

3. Select SAVE.

LDAP configuration
See Configure all LDAP settings.

RCopia configuration

If you selected Enable RCopia Service previously (see Configure your company):

Procedure

1. Go to SETUP > Office > COMPANY > RCOPIA CONFIG.
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COMPANY

Code * MC Hame * My Company Timazons *| US/Eastem w [ EnableLDas

Bl Enable BCcpia Zenice B Enable Payment Gateway Trigger Rowling on Study Flag Changed SAVE

PAYMENT GATEWAY RCOPIA CONFIG HL7 PASSWORD MGT MODEFIERS LINK ERCRYPTION

RiCopia Service Daotails

Yandor Mams * venrdoe M e FiCooia Practice User Roopia Practice Uast Ma

Blamae
Wendar Password *

ANS LT * hittpe:tanseer drfiratcan Fortst 2 isipm Hame P

ANE Urd2 * rftps Y anscent? difirst.oo Trang. lnterval ]

App Hame pACS Hotity Intarval 5

ApE Versiod 1.0 Acogia Uaer 1D 0

Practice Mame Reoopla External Lisar 1D Roopta Fxismal
Wendor Seoret Key Vendor Secrel Ky

Slala Lt

m B Save Request Files

Sawe Responss Files

2. Enter RCopia service details.

3. Select SAVE.

HL7

This sub-tab is currently unused.

Password management

You can customize requirements for passwords that users create to sign in to Symmetry PACS and other
related client apps.

Procedure

1. Go to SETUP > Office > COMPANY > PASSWORD MGT.
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COMPANY

Coda = 3 Hame * by Camparty Timezone *  US/Eastern w ) Enahle LOAE

Enable RCopla Servica Enable Payment Sateway B8 Trigger Routing on Study Flag Changed m

APPSETTIMG BEASON CODES BARH INFORS ATION CESSH0 N SEORRMATION SE FILTER

o LT Bl Erji Fit Ed O
PAZSWICED MGT. L L Cri . ENCEYPTEON

Pazrmord Requirements Dither Setlings SAVE
Pazaword Moot Be between | 3 and 30 Characlers Uiy Wisl Thange Passwand an Mext Loain e Chasked by Defaull

|:| Pazswards Must Comain Uppencase Latbers ] #arce Usera ta Reast Their Fasswand on a Set Schedule

[0 Pas=words Must Conlain Lowercase Lotters O Apply Password Requiremants to Patient Partal

[0 Pazswords Must Contan Numbers

O Passwards Must Coniain Symbals ar Epecial Characien

2. Enter the following settings.

Password Must Be between-:- Type a minimum and maximum number of characters that passwords can
contain.
Passwords Must Contain - Uppercase Letters Symmetry PACS validates passwords

based on these selections.
Lowercase Letters

Numbers

Symbols or Special Characters

‘User Must Change Password Select or clear to assign the default state of the setting.
Next Login’ Is Checked by
Default

Force Users to Reset Their Select to require password resets of a specified interval.
Password on a Set Schedule

Apply Password Requirements | Select to use the same password requirements for Patient Portal accounts.
to Patient Portal

3. Select SAVE.

Modifiers
Modifiers are codes that provide additional detail to billing transactions.

Procedure
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1. Go to SETUP > Office > COMPANY > MODIFIERS.

Cade # J1 Hama * Wy Compary Timezeew * IS Easiem

B Enalile ACops Service Enable Payment Gateway B Tripgsr Routing on Sudy Flag Changsd m

Modifiens
KT AHEHT
LT LEFT
| BILATERAL
B =0 CAETIMCT FROCEDURESSERVICE
B =2 REDUCED SERVICES
o 25 FROFESSIOAL COMPOMENT
™ TECHMICAL COMPO0ENT

Coda *

O implicn

2. Move to the bottom of the screen, enter the following settings.

Code Type the CPT modifier, or other modifier code.

Implicit Select to visually exclude the modifier from submitted claims.
Description Type the description for the code.

Fee Level Select the fee level in the dropdown list.

Fee Override Type the fee override code which takes precedence over any modifier

created previously. To configure an override amount: In the first
dropdown list select an operator (+ or -), in the box type an amount, and
then in the last dropdown list select Value or %.

M1-M4 Select the modifier number to which to assign the code.

Display on Schedule Book and | Select or clear to control visibility of modifiers.
Print Order

3. Select SAVE.
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Set up the office: Other assets

Add a facility

You must add at least one facility to your institution.
Procedure
1. Go to SETUP > Office > FACILITY.

2. Select ADD, and then enter the following settings for the facility.

Code Type your internal code for the facility (up to eight characters).

Name Type the name of your facility.

Market Select the market that the facility serves.

Contact No. Type the phone number of the primary contact person at the facility.

Fax No. Type the fax number for receiving approved reports.

Send Reports to Fax No. Select to automatically send reports to the fax number you entered
previously.

Email Type the email address of the primary contact at the facility.

Email Report Link Select to automatically send an email when a report is created to the email

address entered earlier that contains a link to view the reports on the
ReportLink service.

Report Password Type the password needed to view reports on ReportLink.

Email Attachment Select to receive reports by attachment.

Timezone Select the time zone used by your facility.

Mammo License ID Type the facility’s mammography license ID.

Max TAT Type the maximum allowed turnaround time, in minutes, before a breach

of contract occurs.

Enable Alt. Acc. No. Select to use of more than one account number for a patient.

Required SSN Select to require a social security number to provide treatment.

Require Primary Phys. Select to require a primary physician’s information to provide treatment.
PokitDok Response [Unused]

Upload Logo Select Choose File, browse for and select a logo for the facility, and then

select Open. Logos can be in JPEG or PNG format.

Remove Logo To remove the current logo, select REMOVE LOGO.

[Address] Type the address of the facility.
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Modality Display Width Type the column width for each modality room, in numbers of pixels.

File Store Select the default file store to use at the facility.

Show Patient Alerts Select to show a patient alert window when scheduling in the schedule
book.

Show Recent Schedules Select to display the recent schedules dialog when: 1) scheduling a

preorder; and 2) double-clicking a patient in the Patient tab of the New
Appointment screen.

Days: Type the number of days in the past and future to control which
exams appear in the recent schedule screen.

Enable Veterinary Registration | Select to be able to register veterinarians as physicians.

Mobile Rad Dispatching Type the address of the office that dispatches mobile radiology.
Address
Do Not Allow Overlapping Select to prevent users from scheduling more than one procedure in the

Procedures to Be Scheduled same timeslot in the schedule book.

Import Documents into Study | Select to automatically convert documents to DICOM images before
as DICOMs importing. If not selected, the user can select whether to convert at the
time of import.

Global Auto-Print Select to automatically send radiology reports to printer that is configured
on the Exa server.

Abbreviated Receipt Select to use an abbreviated formatting for payment receipts.

Custom Receipt Select to use a custom receipt for payments, such as co-pays.

Exclude from All Portals (All Select to exclude studies associated with the facility from portals and the
Portals & Break the Glass) Break the Glass functions.

Required Fields at Scheduling | Select options to require when scheduling an exam.

Study Status When Patient Select the status to assign to the study when the patient arrives at check-
Arrives in.

Study Status When Patient in Select the status to assign to the study when the patient arrives in the exam
Room room.

Report Delay to Patient Portal | Type the number of days to wait before making reports available on the
patient portal.

Formal Name Type the formal name of the facility, if different from the commonly used
name.
MRN Information: Inherit Select to copy the MRN from your company settings or EMR of origin.

Clear to define a dedicated format for the facility.

Other MRN settings See MRN information.

3. Select SAVE & CLOSE.
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Add modalities

You must set up each modality available to your facility or institution in Symmetry PACS. In particular, you
must add modalities before entering DICOM settings.

A Do not add non-DICOM modalities, as this could result in problems sending studies to external
PACS.

Procedure

1. Go to SETUP > Office > MODALITY.

MODALITY

H Hide Inactive

NO.  CODE MARE
ZH @ ED Bone Denstiometry
e TR ER BR Modality
AT EEa oT Camputed Tomograghy
2. Select ADD.
|!'.-u:j-:- A Bh O snactive
Mame BR Modalty O Hidden on Fhysicias Portal

3. Enter the following settings.

Code Type the standard DICOM modality code. For example, for ultrasound, type
us.

Name Type a unique name for the modality.

Hidden on Physician Portal Select to hide the modality name on the physician portal to prevent
unwanted scheduling. Useful for hiding non-scheduled modalities such as
SR.

4, Select SAVE.

5. In the list of modalities, select the ® @ buttons to order the new modality.
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Note: During modality-related tasks, Symmetry PACS matches modalities by the order in the list.
Therefore, for example, you should list MG before SR.

Add modality rooms

Modality rooms are named locations where modalities are used for exams, and must be configured for
use in scheduling exams. Add a modality room for for each modality at your facility.

Avoid common mistakes

e Give your modality rooms intuitive names that are easy to find when creating schedule
templates

e Set the From date to a date in the past to view past scheduled appointments

e Setthe To date to a date in the future (such as 1/1/2099) unless you plant to permanently
close the room.

Prerequisites: Add modalities, Add a facility, and DICOM modality worklist (see Configure application
entities).

Procedure

1. Go to SETUP > Office > MODALITY ROOM.

MODALITY ROOM

Hide Inactive

FACILITY CODE = MODALITY ROOM COLOR CODE

&5 W srinika Facility 1 AT LS seaning
& i srinlka Faciity 1 A0z €T scaning
S Angie Facility ang Angig

2. Select ADD.
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Lode am ) trisciive Mndalities * DRAWY
| O =0 Kodalies
Facisy =
Harma * L% soaning L ek
| ::E BR
Fram DisteTo Date * L) Pl S A T el
— 8 T
Color Code FETHang |
[ - O me
Disglay Order * |

O wA

O iea

|
Click here to view/edit Schedule Templates appiled to this room

3. Enter the following settings.

Code Type your unique internal code or name for the modality room.

Facility Select the facility where the modality room is located.

Name Type a name for the modality room.

From Date/To Date Select the long-term date range in which you plan to keep using the
room.

Color Code Select in the box, and then select a color from the picker to assign to the

modality room. The color appears in a bar below the name of the modality|
room in the schedule book.

Display Order Type a number to determine in which column the modality room appears
in the schedule book. Lower numbers appear on the left side of higher
numbers.

Modalities Select all modalities that are in use in the modality room. All appointment

types with the modalities you select become available to schedule in the
room (unless excluded by schedule rules).

DMWL Select the AEs in the room to which to serve the worklist. Only the selected
AEs will receive orders for that room.

4. On the MODALITYTIMES sub-tab, select the here link, and then add a schedule template to the
room.

5. Optional: On the LINKED RESOURCES sub-tab, select which treatment resource is associated
with the modality room (technologist or Mobile RAD vehicle), and then type or select the name of
the resource.

6. Select SAVE.
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Add a notification

You can pre-configure notifications to appear on the dashboard and/or portal sign-in pages under
"Organizational News." These notifications are fixed messages, and not related to email or fax
notifications.

Prerequisite: Add at least one facility.
Procedure

1. Go to SETUP > Office > NOTIFICATION.

MOTIFICATION

Maw Hires
Welcome cur new providera!

2. Select ADD.

MOTIFICATION

CLEAR BACK

Titla * Mew Hires D Inactiva Shiowwe i Pravider Portal Login D Sheow on Atlornay Portal Login

Descriptan Weleome our new providers!

O all Lecations
Office Location * B Angie Facility
D Gohika TestFacility
O

Meera Fasility

L R e s

3. and then enter the following settings.

Title Type a title for the notification.

Show on Provider Portal Login | Select to display the notification on the sign-in page of the physician
portal.

Show on Attorney Portal Login | Select to display the notification on the sign-in page of the attorney portal.
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Description Type the body of the notification.

Office Location Select one or more facilities to which to send the notification.

4. Select SAVE.

Add tasks

Administrators can add tasks for marketing representatives, such as “Tell referring physician offices that
we will start offering 3D mammography in January.”

Procedure

1. Go to SETUP > Office > TASKS.

TITLE £ DESCRIFTIOM COMPLETE DUE DATE
all L
Offering marmmaography in April

Ref Phys Reminders X Q3 E 2023
- Mew intake farms

% i
& B

2. Select ADD.

TASKS

Title + Ref Phys Reminders O completed

Description * - Offering mammaography in April
- Mew intake forms

Due Date o3/31/2022 | [

3. Enter the following settings.

Title Type a title for the task.
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Description Type a description of the task.
Due Date Select a due date for the task.
Completed Select when the task is completed.

4. Select SAVE.

Add authorization rules

Authorization rules prevent you from scheduling an exam on a date sooner than the amount of time
required to obtain insurance authorization. Exa PACS/RIS automatically adds a warning (red star) to
studies on the worklist that match the criteria in your rules (such as facility, modality, and procedure
codes) that are awaiting authorization.

Prerequisite: Configure at least one procedure code and insurance provider.
Procedure

1. Go to SETUP > Office > EXAM AUTHORIZATION.

EXAM AUTHORIZATION

FACILITIES MODALITIES DY ALLOW SCHEDULING PROCEDURE CODES INSURANCE PROVIDERS
v | Al w All i
: angie Facility BOCTRRMG MA MMIZ o I Salected 3 Sefactad
& B Mirmille Test Facility X 2 ' 2 Soleched 2 Selected
F- i T snnika Facilthy 1 GTLUS KA 3 ' 2 Selecisd 1 Sefected
2. Select ADD.
Facility * () Select all current and future facilities ® Choose facilities
ANGIE FACILITY =
Medality * ALL SELECTED (17) ~
Days * 2
B Allow Scheduling

Procedure Codes 3 CODES SELECTED
Ingsurance Providers 3 PROVIDERS SELECTED
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3. Under Facility, to make different authorization rules for different facilities, Choose facilities.

4. Configure the following settings.

Facility Select one or more facilities in the dropdown list that will use the authorization
rule.

Modality Select one or more modalities to which the authorization rule will apply.

Days Type the minimum number of days required for authorization (the exam cannot

be scheduled during the number of days you enter).

Allow Scheduling Select to allow users to schedule exams that are currently unauthorized, but that
can be authorized in the future. Gives the user the option to schedule the exam,
create a preorder instead, or cancel.

Procedure Codes Select one or more procedure codes. The authorization rule only applies to the
procedures you select.

Insurance Providers Select one or more insurance providers. The authorization rule only applies to the
providers you select.

5. Select SAVE.

Create a study flag

You can create a study flag that users can apply to studies and orders on the worklist. Sorting the worklist
by flags is one way for users to easily find groups of studies or orders to work on. You can also use them
to trigger routing rules. When you create a study flag, you can restrict its availability by institution, facility,
modality, and other parameters.

Procedure

1. Go to SETUP > Office > STUDY FLAG.

STUDY FLAG

DESCRIPTION = HETITUTIONS FACILITIES MDD ALITIES COLOR CODE

Al -

i Flagz
il Flaga

2. Select ADD.
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STUDY FLAG

Description * Flag O imactive O awveilabis in Parial O wiew 5t iify Flaeg Calor Code
an Schedule Book

Inatititians Facilities Madalitias

O &8 insttutions O allFacilitiss O Al readsliies

BD

H
Ll

O

BN

WG

Oooao

T

3. Inthe Description box, type a name for the flag.
4. Enter the following settings.

Available in Portal Select to make the flag available in the physicians’ portal. If selected, all
other settings become unavailable.

View Study Flag on Select to show any study flags added to a study on the appointment
Schedule Book card in the schedule book.
Color Code Select a color in the picker. This color appears in the Study Flag

column in the workilist.

Institutions Select the institutions for which the study flag is available.
Facilities Select the facilities for which the study flag is available.
Modalities Select the modalities for which the study flag is available.

5. Select SAVE.

Set monthly goals
You can set monthly goals for the number of studies to perform, for example.
Procedure

1. Go to SETUP > Office > STUDY FLAG.
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MONTHLY GOALS

MOOALITY CIOAL PERMID (MGNTIHS PADH THLY S L WWORK NG By PET MOSTH Crdny Chiohd

g 3 MG Febray 1005 (e 1] 21 5

2. Select ADD.

hodality * MG

Kaeal Period (Month/Year) * B March 2023
bdonthly Goal * 100

Werking Days per Monih * 21

3. Enter the following settings.

Modality Select the modality for which to set a goal.

Goal Period Select the month for the goal.

Monthly Goal Type the target number of studies to perform with the selected
modality.

Workri]ng Days per Type the number of days in the selected month.

Mont

4. Select SAVE.

Configure macro notes

Macro notes are pre-configured blocks of text and metadata that you can add as notes to items in various
parts of the program such as studies, schedules, and claims. Configuring macro notes ahead of time
saves you from having to re-enter the same notes on multiple occasions.

Procedure

1. Go to SETUP > Office > MACRO NOTES.
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MACRO NOTES

DESCRIPTION = TYPE FACILITIES MORALITIES
£ S study notes Study Nty CompanyMrmilla Test Eaclity sinica Fa al
2. Select ADD.

BAVE RESET BACK
Dhescrighion ™ S Aty notes
Macro Types * “ Facilties * 3 SELECTED = hodality * ALL SELECTED (17] =

Pelazra Tiut * Procaduras

Testing - notes scenarios EDIT APPOINTMENT TYPES
Al appointbmsant typas:

3. Enter the following settings.

Description Type a short description for the macro note to appear as the selectable
option when adding notes in other parts of the program.

Macro Types Select the context in which the macro note is available.
Facilities Select the facilities where the macro note is available.
Modalities Select the modality with which the macro note is available.

Edit Appointment Typeq Select to add or remove the appointment types for which the macro
note is available.

Macro Text Type the text of the macro note.

4. Select SAVE.

Configure portal links

You can add up to two custom links (URLS) to the patient, provider, or attorney portal. For example, you
could add a link to the patient portal that sends your patients to your company’s payment website.

Procedure

1. Go to SETUP > Office > PORTALS.
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PATIENT PORTAL PROVIDER PORTAL ATTORMEY PORTAL
Labsl Qur Patiant Portal 1
Link bittgefwvateatpportal.no

2. Select a portal sub-tab, and then enter the following settings.

Label Type the link text that appears to the user. For example, Pay Now.

Link Type the URL. For example:

htt ps: \ ww. our conpnane. com cust oner _paynment _site

3. Select SAVE.
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Configure all LDAP settings
Symmetry PACS supports the LDAP and LDAPS (LDAP Secure) protocols.

Synchronize AD groups
To synchronize AD groups with the LDAP server:

Procedure
1. Onthe burgerE menu, select SETUP.
2. On the OFFICE menu, select User Management.
3. On the AD GROUPS tab, select SYNC. AD GROUPS.
4. Inthe left pane, select the groups that you want to synchronize (add to the server).
5

Select CREATE SELECTED GROUPS.

Synchronize AD users
To synchronize AD users with the LDAP server:

Procedure

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select User Management.

3. On the AD USERS tab, select SYNC. AD USERS.

4. In the left pane, select the users that you want to synchronize (add to the server).
5

Select CREATE SELECTED USERS.

500-000577A 43



Symmetry® PACS 1.4.32_P4 User's Manual ngmetrgPAGS

Configure providers and resources
You can set up individual healthcare providers, their groups and facilities, and provider pay schedules.

Add a provider organization
A provider organization is a parent entity for provider groups and locations.

Procedure

1. Go to SETUP > Office > Providers & Resources > PROVIDER ORGANIZATION.

FROVIDER DRGAREATION

CODE PROVIDER ORGAMITATION & FROVIDER SRCUPE

FEM Prewiger Crganization Test My Provider Groupd, AgieTegth

2. Select Add, and then enter the following settings.

Code Type your internal code for the organization.

Description Type a description.

3. Select SAVE & CLOSE.

Add a provider group
If your institution works with a provider group, add it to the system.
Procedure

1. Go to SETUP > Office > Providers & Resources > PROVIDER GROUP.

2. Select Add, and then enter the following settings.

Code Type your internal code for the group.

Name Type the name of the group.

[Address] Type and select the address and country or region of the group.
Phone/Fax No. Type the primary contact information for the group.

Email Type the email address of the primary contact at the group.
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Report Password Type the password that the provider group must use to view reports
generated from exams that they ordered.

3. Select SAVE.
4. Use the PROVIDERS sub-tab to view or edit the list of configured providers.

5. Use the SUMMARY tab to display a list of patients or studies associated with the current provider
group.

6. Use the MARKETING REP sub-tab to add a marketing rep to the provider group.

Add aresource

A resource is an attorney, nurse, provider, laboratory, radiologist, technologist, or referring provider. You
can add individual resources and add them to one or more provider groups.

Procedure

1. Go to SETUP > Office > Providers & Resources > RESOURCE.

RESOUACE
RELOAD EXPORT
CODE®  MAME JISE MARKETIMG.REI ADDRESS FHOME & FAX & EFECIALIT AESOURCE MARKET ACT BYE
&l w Al w Al w | w| W
* Jom Test, Attamay 2217 LS Highwa sy eyt Astomey s
4+ ZHoz dftomey, GobikaTest AutsTeatdddress iy '
#+ llangz Aagin, Ang 58 wast 5t Agfomring P b
2. Select Add.

Note: The settings available differ depending on your selection in the Type dropdown list.

2b/Subtab

RESOURCE Type Select an Symmetry PACS provider type.
Code Type your internal code for the provider.
Name Type the name of the provider.
Title Type the academic credentials of the provider (e.g. MD)
NPI No. Type the national provider identifier of the facility.
Taxonomy Code The Medicare/Medicaid taxonomy code (refer to CMS.gov).
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ab/Sub-tab

Dr. Office Name Type the business name of the provider’s office.

SSN Type the social security number of the provider.

Federal Tax ID Type the federal tax ID of the provider.

EIN No. Type the employer identification number of the provider.
ETIN No. Type the ETIN to be able to use electronic transfers.
Medicare UPIN If the provider has no NPI, type the unique physician

identification number of the provider.

Market Select the market that the resource serves. All facilities in
the Facilities list that are associated with the selected market
become selected.

Facilities Select all facilities with which the provider is associated.
Specialty Select the specialties of the provider.
License No. Type the state medical license number of the provider.

Medicare Provider No. | Type the Medicare provider number of the provider.

Medicaid Provider No. | Type the Medicaid provider number of the provider.

Prov. Agreement Code | Type the code for the legal provider agreement code.

POS Type Displayed when Referring Provider is selected as the
provider type.

Fee Schedule Displayed when Referring Provider is selected as the
provider type.

Max TAT Assigh a maximum turnaround time for the provider, in
minutes. Symmetry PACS divides this time into 4 segments
on the TAT monitor on the worklist.

Locations / Code Type your internal code for the provider.

Contacts
Group Select the provider group to which the provider belongs.
Email Type the email address of the provider. This is required to

receive email reports, notifications, or attachments.

Contact Name Type a contact name, such as the name of the
administrative assistant of the provider.

[Address] Type or select the country or region and address of the
provider.

Provider Alerts Type any alerts for the provider, such as “only takes
referrals.”

Office Phone/Fax Type the contact information for the provider’s office.

Mobile/Pager No. Type the mobile and/or pager number of the provider.
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2b/Sub-tap

Phone No. Type the personal phone number of the provider.

Fax No. Type the personal fax number of the provider.

Primary Contact Select to send reports to the referring provider only.
Reports to Email Report Link Select to send reports to the individual provider
Me/Contact Email Attachment location/contact, and select which methods to use.
Information Postal Mail

Fax Note: If you select Email Report Link and/or Email

Office Fax Attachment, you must enter the recipient email address in

the Contact Information area.

Reports to Group | Email ReportLink Select to send reports to all members of the provider
Email Attachment location/contact's provider group, and select which
Postal Mail methods to use.
Fax
Office Fax

Report Password | -- If you selected Email Report Link previously, type the

password that the provider must use to view reports
generated from exams that they ordered.

Reports to Patient | Delay Type the number of days to wait before posting reports on
Portal the patient portal.
Image Delivery Cb Select which media to use to deliver images.
Options Film
Paper
Notification Email Select to receive notifications by email and/or fax.
Settings

Receive When Added as| Select to have the provider receive notifications by email if
CC Provider they are added as a CC (carbon copy) provider.

3. Select SAVE CONTACT and then SAVE & CLOSE.

See also:

Configure a technologist
Deliver reports

Convert or merge a system provider resource

When Symmetry PACS receives a study with providers that it does not recognize, it automatically creates
a system provider resource and associates the study with that system provider. System providers are not
available in other parts of the program, but you can convert them to a usable provider or merge them
with an existing one.

Procedure

1. Go to SETUP > Office > Providers & Resources > RESOURCE.
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RESOURCE
SEARCH FOR PROVIDER ON WER EXPORT
CoDE= NAME NPz MARKETIMG.REI ADDRESS FHONE & FAK # EFECIALIT AESOLURCE MARKET ACT BYE
all 1| = il o | |
* Jom Test, Attamay 2217 LS Highwa sy eyt Astomey s
#+ oz Aftomey, GobikaTest AutaTestaddress Axtarey b
* 2 ang2 fagin, Ang 58 waost 5t Agfomring P -

2. Onthe SYSTEM PROVIDER column, select Yes.

CONVERT SELECTED SEARCH FOR PROVIDER ON WEB
CODE = MNAME MPle MARKETING ADDRESS SPECIALITY RESOURCE ACTIVE SYSTEM PROVIDER
ng All w | Al sl ves v Yes w
+ HCPZIRE MR KRISTY SU {=YsTEM PROVIDI Refaring Pr. o v

1. Select a system provider in the list, and then select CONVERT SELECTED.
2. To create a new provider, select CONVERT DIRECTLY.

3. To merge with an existing provider, select USE EXISTING, and then select a provider in the list.

System provider management

How would you like to convert the selected
system providers?

EHRCEL

4. Select SAVE.

Configure a technologist

Technologists have access to special features in Symmetry PACS, and therefore require a slightly more
detailed configuration. For example, you can select which appointment types the technologist is allowed
to perform, and assign schedule rules to the technologist, which prevents scheduling them for an
appointment that they are not allowed to perform. To configure a technologist:

Add a technologist resource

1. Follow the steps in Add a resource to add a resource of type Technologist, but do not select
SAVE & CLOSE.
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On the ALLOWED APPOINTMENTS sub-tab, select ADD.

In the Edit Appointment Types dialog, select the checkboxes for all appointments that the
technologist is allowed to perform, and then select SAVE.

Optional. On the SCHEDULE RULES sub-tab, select an edit button to modify a schedule rule.

Select SAVE & CLOSE.

Create a technologist user role

On the burgerE menu, select Setup.
On the OFFICE menu, select User Management.

On the USER ROLES tab, select ADD, type a hame and description of the role (such as
"Technologist"), and the select SAVE.

In the User Role Permission area, select the Technologist user right, plus any other rights you
want to grant all technologists.

Select SAVE & CLOSE.

Create a technologist user group

1.
2.

On the USER GROUPS tab, select ADD.

In the Roles dropdown list, select Technologist (or the name of the technologist user role you
created earlier).

Enter other settings for the group (see Create a user group), and then select SAVE.

Create a technologist user

Configure an individual technologist as a technologist user.

1.

2
3
4.
5

On the USERS tab, select ADD.

In the Linked Provider User Type dropdown list, select Technologist.

In the Technologist dropdown list, select the technologist resource you created earlier.
Enter all other settings for the user (see Create a user).

Select SAVE.
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Configure scheduling and codes
You can set up information related to scheduling exams, including fees, body parts, appointment types,
diagnostic and procedure codes, and various kinds of templates.

Configure a facility fee schedule

It can be useful to configure individual facility fee schedules: if your fees differ by facility; for
teleradiology; of if you generate the Fees by Facility or Fees by Modality report.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > FACILITY FEE SCHEDULE.

FACILITY FEE SCHEDULE

WAME # START DATE END DETE
I Hrrville Tast Facdiy 127312 002030
2. Select ADD.
Fee Name * Nirmilia Test Facility O nactive

Start Date/End Date * 01,/01 /2023 5 | ovaisco50 =

Facllities * O all Facilities

Mirmilla Test Facility

Madalities [ &l madalities Muadality Fee o000
O eo
O er
Oer .

Summary

CR: £50.00

Us: £100.00

XA 5£50.00

3. Enter the following settings.
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Fee Name Type a name for the facility fee schedule.

Start Date/End Date Select a date range during which the schedule is valid.

Facilities Select one or more facilities to which the schedule applies.

Modalities Select one or more modalities to which the fee applies.

ey ez Type the fee for the modality, and then select the plus button. You
can add multiple modality/fee combinations.

4, Select SAVE.

Configure body parts
You can define body parts for use in other parts of the program.
Procedure

1. Go to SETUP > Office > Scheduling & Codes > BODY PARTS.

MAME ALT, KRAME

T Akdaman Abchorrmen
B ankie Bkl
Am &
2. Select ADD.

3. Type the name and alternative name for the body part, and then select SAVE.

Configure diagnostic codes
You can enter SNOMED, ICD, or LOINC codes for use in other parts of the program.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > DIAGNOSTIC CODES.

500-000577A 51



Symmetry® PACS 1.4.32_P4 User's Manual

symmetry-rpAcs

2. Select ADD.

Code *
Description *

Code Type

DIAGHOETIC CODES

DEECRIFTION

Chalera de ta Wibrio choletae 07, bivar ehoderae

Chabera due o Vibrio cholerae 01, bioiar siioe

Cholera, unzpecified

ADO.0 O inactive
Chaolera due to Vibrio chol

3. Enter the following settings.

Code - Type the code to enter.

Description - Type the code’s diagnosis description.

Code Type - Select the code standard to which the code belongs.

4, Select SAVE.

Import diagnostic codes

TVFE ACTIVE
all w Ve W
Ly -
o L
b -

If you obtain exported diagnostic codes, such as from the CMS or AMA, you can import them.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > DIAGNOSTIC CODES.

2. Select IMPORT.

DHAGHOSTIC

DESCRFTICE:

Chalera e ta Vibrio chelerae 07, biover choterae

Chalera due fo Vibrio cholerae 07, biovar efioe

Chaobera, unzpeciind

TYFE ACTINE
Al g e w
oo v
eyl -
i 1 i
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3. Select Choose File, browse for and select the file to import, and select Open.
4. Optional. To replace existing facilities, select the Update Existing checkbox.

5. Select IMPORT.

Configure procedure codes

A procedure code is an internal code that identifies a medical procedure. Additionally, procedure code
entries serve as detailed sets of information about procedures that Symmetry PACS uses for billing,
ordering, and other functions.

When you configure a procedure code, you can add NDCs that technologists can select when performing
the exam. This makes the process of searching for and adding the appropriate contrast material and
other medications more efficient and accurate.

Prerequisites: For adding NDCs to a procedure code, complete the steps in Configure NDCs.
Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.

FROCEDURE CODES

ADD HRELOAD IMPORT CRT
B Hide inasctive
CODE= DESCRIPTION EXAM PREP INSTRUCT GLOBAL FE DURATION FACILITY WDDALITY BIIDFIERS SERVICETYFE  RVU
WA w A -

& 0001A RS ADIMAN SARSCON2 o 15 wrisika Faclity 1 nge Fac urdelesd

& 000 BRT FAILURE ASEESEE i 15 arinika Facdity 1,Angee Fac

£ Dza i ALK LRG0V i} 15 windka Facddy 1,Anges Fag uroefred

2. Select ADD.
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Facifities all Frcilities Senvice Typa - Select
Ref. Code 000 A
NODC Code
MHEE Measure
Calor Code
Gode © ooota [ imactive SDE Study O
Short Description * IMBA ADBAN SARSCONZ 3
Description * IR ADRAN SARSCOVE 3
GENERAL f KA | I f EMFLA EXA
Body Part Salect W Duration * ]
] mon-Transcrbabte [] Reguire Copay Default Units '
[ Require Fhysician O Redquire Waiting Time R
Notes Leval Selent v
Modalities * O =o
O er
Charge Type w CJer
s SRS

3. Enter the following settings.

Facilities

Select one or more facilities that perform the procedure.

Code

Type your code for the procedure.

Short Description

Type a short description for the procedure.

Description Type a full description of the procedure.

Service Type Select the service type to which the procedure belongs.

Ref. Code Type the reference code of the procedure. In most cases this can be theg
CPT or LOINC code.

NDC Code Type the national drug code associated with the procedure, if any. For

a more advanced NDC function, see later steps in this topic.

NDC Measure

Type the unit of measure for contrast and/or liquid medications. The
value for this is usually UN.

Color Code

Select in the box, and then select a color in the picker to assign to the
procedure.
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SDE Study Select the checkbox if the procedure is associated with echo
ultrasound.

4. Select SAVE.

5. Optional. On the GENERAL sub-tab, enter the settings in the following table, and then select

SAVE.
Body Part Select the body part associated with the procedure.
Non-Transcribable Select if the procedure cannot be transcribed.
Require Copay Select if the procedure requires a copayment.
Require Physician Select if the procedure must be performed by a physician.

Require Waiting Time | Select if the procedure requires a waiting time before beginning (such
as drinking Barium some number of hours before a procedure).

Notes Type notes for the procedure as needed.

Duration Type the expected duration of the procedure.

Default Units Type the number of procedure units.

RVU Type or select the relative value units of the procedure for Medicare

reimbursement.

Level The provider level code that determines the pay rate to the radiologist.

Modalities Select one or more modalities used in the procedure.

6. Optional. For EXAM PREP. INSTRUCTIONS, see Configure exam prep instructions.

7. Optional. To add diagnostic codes (other than standard ones already on your system), on the
DIAGNOSTIC CODES sub-tab, select codes from the dropdown list.

8. Optional. To associate a diagnostic code with the procedure code, on the DIAGNOSTIC CODES
sub-tab, select a code.

9. Optional. To select a report template to be used for the procedure, on the DEFAULT REPORT
TEMPLATE sub-tab, do one of the following.

e Under Template List, select an existing template.
e Select NEW TEMPLATE, type a template name, create a template in the word processing
area, and then select SAVE TEMPLATE.

10. Select SAVE & CLOSE.
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Import specimen catalogs
If you obtain specimen catalogs in CSV format, you can import them.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.

FPROCEDURE DODES

Select SPECIMEN CATALOG.

v A W N

Select IMPORT.

Import procedure codes

ADD RELCAD IMPORT CPT
B Hide inactive
COpDE= DESCRIFTION EXAM PREP [NSTRUCT GLOEAL FE DURATION FECIITY MDY
& ooma W ADMN SARSCO o 15 aneiin Facdity 1 Anges Fac usdelesd
£ 00F BRT FAILURE ASEESEE i 15 arinika Facidity 1,Angee Fac
£ DL PR ADMAK SARGCOND ij 15 srinlka Facddy 1, Angie Fag undefired

EPECIMEN CATALOS

WIODIFIERS SERVICE TYFE R

o Al W A ak

Select Choose File, browse for and select the file to import, and select Open.

Optional. To replace existing facilities, select the Update Existing checkbox.

If you obtain exported procedure (CPT) codes, such as from the AMA or third-party billing companies,

you can import them.

Procedure

1. Go to SETUP > Office > Scheduling & Codes > PROCEDURE CODES.

B Hide nactive

CODE = DESCRIPTION EXARE PREP [NETRUCT GLOEAL FE DURATION FECIITY MODLITY
& DomaA WhY SDMK EARECTN [} 15 arieikn Faclity 1 Anges Fac usdelesd
£ DO0F BRT FAILURE ASEESEE i 15 arini ki Faciity 1,Angie Fao
= DD RN ALK SARGCD i 15 mrindka Facdity 1, Angie Fag undefred

2. Select IMPORT CPT.

RIODFIERS

SERVICE TYFE R

W Al W A ak
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3. Select Choose File, browse for and select the file to import, and select Open.

4. Optional. To replace existing facilities, select the Update Existing checkbox.

5. Select IMPORT.

Configure study statuses

Workflows in Symmetry PACS are status-driven. To create or tailor workflows, you can create a set of

study statuses, and then configure how studies move from status to status (see Configure study flow). To
add statuses:

Procedure

1. Go to SETUP > Office > Scheduling & Codes > STUDY STATUS > STUDY STATUS.

STUDY STATUS

STUDY STATUS STUDY FLOW

Facility * My Company * | Searcl

B orp/ordered o

PR/Precheckin  [orer|

SCH/Scheduled | omer

B con/Confirned | geer

CHI/Checkdn | ome

B s Tech Start

I TE/Tech End
2. In the Facility dropdown list, select a facility, and then select ADD.
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STUDY STATUS STUDY FLOW

P i b & =
Qerieral Infomation Things fo Malidata O aways show Validaticn wWindow

Satus Code * ] Patient address O crrcods
p— ) i [Bafchrees, City, Stabe, ZIF]
L el 1 Study Sharcul Meru on Warklist

-

Ciagnosts Code
ik ;i : L] Patient 520
Fmius Descrpton CJ mobileRad Related (] Patient pberts
T . [ Patient Coatact
Culuy Gl L] Crder Related et [Home o L) Reason far Study
Mohils) _
EAax Wait Time min [=5] O pecumens Review

[ Rofemeg Physician

Matefication Settings

Emall Template -

3. Enter the following settings.

General Status Code Type your internal code for the status.
Information
Add to Study Shortcut Select to add the status to the study row shortcut menu
Menu on Worklist on the worklist.
Status Description Type the name of the status.
MobileRad Related Select if the status is for Mobile RAD. For use with the

Mobile RAD app.

Color Code Select in the box, and then select a color from the picker
to color code the status.

Order Related Select if the status is related to orders only.

Max Wait Time Type the number of minutes to complete check-in. If the
time is exceeded, the “Exceeds maximum time limit”
count at the bottom of the worklist increments.

Things to Validate| Always Show Validation Reserved for encounters.
Window
[Other checkboxes] Select the items that Symmetry PACS validates (checks
for inclusion) before moving the study to the next
status.
Notification Email Template Select templates that determine whether and to whom
Settings notification is made when a study arrives at the status.

4. Select SAVE.
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Configure study flow

Symmetry PACS provides a graphical representation of the flow of studies from status to status at each
facility. You can define these flows, and also apply routing rules to control whether data can move to the
next status in the flow. The easiest way to define a new flow is to copy an existing one from another
facility, if available.

Note: You do not need to apply routing rules for manual DICOM send operations.

CAUTION: Changing the study flow incorrectly can “orphan” studies, leaving them unable to move to the
next status in the workflow.

Procedure
1. Go to SETUP > Office > Scheduling & Codes > STUDY STATUS > STUDY FLOW.

2. In the Facility dropdown list, select a facility.

STUDY ETATUS STUDY FLOW

E GabikaTostFacility
? Muera Faclity

My Comnany

. Schedubed - 1. a |
P - ik /
o
Fiit
I o Tech Sact |
[ enfrmed
Chegin
-

Ehaek Dt ) Tt End i ari
- Tech Siar

3. To modify the flow:

e Copy an existing flow to your new facility by select the source and destination facilities in the
lists (see figure).

e Drag the orange bar in a status node to another status, and drag arrows.

¢ Add a routing rule between statuses by selecting the triangle on an arrow them, select a
routing rule, and then select OK.

4, Select SAVE.
See also:

Configure study statuses
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Add a transcription template

You can add a template for use during transcription. A transcription template is for formatting a

transcription, whereas a report template is for final formatting of approved reports. To create a
transcription template:

Procedure

1. Go to SETUP > Office > Scheduling & Codes > TRANSCRIPTION TEMPLATE.

TRANSCHIPTION TEMPLATE

TEMPLATE HAME =

2 L Tergpleie New
B Testiwe

B Ry HAND

2. Select ADD.
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BAVE HAVELCLOEE

Template Hame © m AT MSEAT  PAGELEYOUT REPOETING W  PRACORNG  PERMISIONS Sk Bulhon
XREY HAND - - Tampine Na
e o w2 e A A W o
I P Ol [ 5 - —
O macsve B St ki L TR A O B o - e | Ot Er = —
Macsn Keyword
teur Faumm
* -t & l\. i I i i .
Uszer
-
|
Exam: RADIOGRAPH OF THE _ HAND
Technique: P4 cbioue and lateral views of the  hand are submitted
Appesramant Typas Clinical Data: Pain
-
Priar Studies
Findimgs: There is regional ostecpena. Scattered moderate degenesative changes with
int space narrowing Sclenasis and spuming presanl. Emty erciave changes FIF and DR
jaint kevets, and first carpal-metacarpal joint. Comrelate with erosve ostecarihngs
Crmfedicalofiod densily along he base of the st metacamol may refiact 5ol lissue
changes assoaated with previous rauma. Soft issues are unremarkable. Mo distnd
aouie frachre or other acute osseus abnommalty
L] Regues &l Match Impression:
Facililien
: Recommendation:
Madslity * L2432.15

-

3. On the left pane, enter the following settings.

Template Name Type a name for the template.

Global Select to make the template available to all users.

Macro Keyword Type a macro keywords that can be voice-recognized to open a template.
User You can restrict availability of the template by assigning users to it. Select a

user in the list and then select the plus + button. You can assign the
template to multiple users.

Appointment Types Restricts availability of the template to studies of the selected CPT code.

Require All Match Restricts availability of the template to users and studies who match all
criteria entered in these settings.

Facilities Select one or more facilities to which to assign the template.

Modality Restricts availability of the template for use with one or more modalities.
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Body Part Restricts availability to the template for use with one or more body parts.

Study Description Restricts availability of the template to studies with the entered study
description.

Institution Select one or more institution to which to assign the template.

4. Select SAVE.
5. In the template editor, type text and apply formatting for the template, and then select SAVE.

6. Optional. To paste items onto the template that you copied from outside Symmetry PACS, on the
HOME tab, select Paste, and then in the button shortcut menu, select Paste.

7. To add merge fields, select REPORTING (1) > Insert Merge Field (2), and then select a merge

field (3).
i
-+ 2. __ e e v L ot o
F f.':l {'E -.-:I I I:.:l :‘:!: ..-.. P . [ndoire Criotaal

sy dasl fopond rani DpalR e pRa .

AERE

1

8. For formatting options (4), right-click in the body of the template.
9. When finished with your template, select SAVE & CLOSE.

Configure functional and cognitive statuses

Functional and cognitive statuses are preset descriptions of a patient’s level of physical and mental
functioning that can be used in other parts of the program.

Procedure

1. Go to SETUP > Office > Scheduling & Codes.
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2. Onthe FUNCTIONAL STATUS tab, in the Description box, type a functional status and then
select SAVE.

FUNCTIOMAL STATUS

DESCRIFTION
faly m J'-'|."'I"'I::l'_*|.at|‘.'|r:|.'
& i Cane/walker

Dascription *

o

3. Onthe COGNITIVE STATUS tab, in the Description box, type a cognitive status and then select
SAVE.
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COGNITIVE STATUS

DESCRIPTION

& a Mitd aphasia
& o Memory impairment
Descripgtion
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Configure DICOM settings
You can configure DICOM settings such as by configuring AEs, setting up file stores, and defining receiver
and routing rules.

Note: The default AE title for Symmetry PACS is EXA_SCP, or EXA_MWL when acting as a worklist
source. These titles are configured elsewhere in the program by a Konica Minolta installation engineer.

Configure application entities

In Symmetry PACS, an application entity (AE) title is a named configuration for a DICOM application that
includes information such as its type, host computer, and port number. You must set up AE titles for
Modality Worklist, send, receive/store, print, query/retrieve, and other functions to make them available
on Symmetry PACS. To configure an AE, use the following procedure.

AN

Failure to correctly configure application entities can cause general failure of DICOM communication
between Symmetry PACS and those entities.

Procedure

1. Go to SETUP > Office > DICOM > AE TITLE.

AE TITLE

E%. HEET PORT DESCHIFTION FEE ZTORE &ETTPE
<l EXAARA2 W0 KT 26 TE ek} EXE- A2 VER Eda Serigr ifagss SEMDRECENEQUERYRETHI
o l OLD_ARCHINE QLD _ARCHIWE EEFAULT ETCHE RECENE
0 OPAL32.33 D237 26100 At OPFAE_33 33 Exa Saraar Imiagss EEMDRECEIVEQUERY/RETHRI
2. Select ADD.
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AE Tyee B senp AE Flag Selct ~
B reibT
nsmiion
B mecenve
Fie Stone Sect W
. CUERY/RETRIEVE = C L
HE Titw [Remane] * O it Port * ] Require 550
[ ignore Soan Doca (S Transfes Syneas {Sand) mlact w
Wy AE Thie Traneler Syntax Sedect 4
Host Mame 5 Peeceier|
ek ! " \imhicle
bescription L) Diseide GLALIVE
Retraes 1 ] send Single nsance per Soud
LJ Send SIngie InSTance per Shady
Mai Corourtent
SOF Modatity 0
Faciliy *
neElude Appr et PEgor |_
Sand ARNOTAnENE & Salect w
Send Unigus Image WD 7]
Fiom 'Wewer
Ignome inbound Stag 0 %
walue
CATL Wgdaitieg * 0 8o
O or
O cr -
DAL Fachities © O - éngie Facany
E CobikaTesiFaciliny
0 sieera Fasiiiny
11 b Dvmnaere -
Issuer Type * B pene O Satie Diyrudr

3. Enter the following settings, and then select SAVE.

Note: Depending on the AE type, not all of the following settings are available.

AE Type

Select one or more transactions that Symmetry PACS makes with the AE.

AE Title (Remote)

Type the title of the AE. If an AE title is pre-configured on the device
hosting the AE, use the same title.

Ignore Scan Docs (Send)

Select to prevent sending of scanned documents to the AE (only DICOM
studies are sent).

My AE Title Type a title to set the identity of Symmetry PACS individually for each
DICOM node. In most cases, leave blank to use the default (EXA_SCP for
PACS/RIS functions, and EXA_MWL for modality worklist functions).

Host Name Type the host name or IP address of the AE.

Description Type a description for easy identification of the AE.

Disable QC2LIVE

Select to disable the automatic transfer of studies from QC to live.

Retries

Type the number of times the system attempts to reconnect with the AE
after a communication failure.
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Send Single Instance per Study| Select to send one image per study.

Max Concurrent Type the maximum number of concurrent threads that the system can use
for the transaction.

Facility Select the facility to associate with the AE.

Ignore Inbound Stat Value Select to keep the Stat level of the study from Exa PACS/RIS.

Clear to use the Stat level of the study as received.

Send Annotations as Select how to process annotations for sending.
Burned in: “Flattens” the image and overlay into a single image.

DICOM Overlay: Converts the annotations to a DICOM overlay and sends
along with the study.

GSPS/PR Object: Converts the annotations to a presentation state and
sends along with the study.

Send Unique Image UID from | Select to generate a new UID for each image (rather than just for the

Viewer series or study).

DMWL Modalities Select to which modalities to serve a modality worklist.
DMWL Facilities Select to which facility to serve a modality worklist.

Issuer Select the issuer of PIDs.

AE Flag Select one of the following services to use to send studies.

DICOM: C-MOVE

DICOM SSL: C-MOVE, secured
HL7: Standard HL7 protocols.
OPAL: The Opal Transfer service.

Institution Type the name of the institution for easier identification.

File Store Select a file store for storing received data.

Port Type the port number through which the AE can connect to Symmetry
PACS (the Symmetry PACS listening port).

Require SSL Select this checkbox if: 1) you selected the DICOM SSL AE flag; and 2) the
port number requires an SSL certificate.

Transfer Syntax (Send) Select the transfer syntax for sending.

Transfer Syntax (Receive) Select the transfer syntax for storing and receiving.

Vehicle Select vehicles to which to assign received studies.

SDE Modality Select if the AE is a dedicated echo ultrasound.

Include Approved Reports Select to include approved reports in transactions.

See also:

Configure a DICOM printer
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Configure a DICOM printer
Configure and save AE with AE type of “Print,” and then perform the following procedure.

Procedure
1. Go to SETUP > Office > DICOM > AE TITLE.
2. Configure a print AE, and then under Extra Printer Options, enter the following settings.

Extra Printer Options

ARTIM Timseowt tdax POU Length
Read Timesn Bliwdes Margins 2
Wrizo Timaaut Trua Slza

Printer Configurations

REFRESH ADD CONFIGURATION

Harme Madium Filen Slzu Border Dunsgily daslimation orlarilathsi Magnificatlon Emply Dansity Mamery Allocotien
FE Pl PAPER EIMK TOIN BLACK MAGAZIME PORTRAIT REPLICATE BLAGH T
ARTIM Timeout Type the number of minutes to wait for an acceptance or rejection

response to an association request before timing out.

Read Timeout Type the number of minutes the printer waits to receive data before
timing out.

Write Timeout Type the number of minutes the printer waits to send data before timing
out.

Max PDU Length Type the maximum number of bytes of a protocol data unit that the
printer can receive.

Border Margins [Unused]

True Size [Unused]

3. Select ADD CONFIGURATION.
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a o
Configuration b
Name Fim Destination MAGAZINE
Fiflm Orientatian PORTRAIT w
Mediem
e Magnification REPLICATE w
PAPER -
Empty Density BLACK
Film: Size

EIMX TTIM e

Border Density BLACHK w

Memory Allocation (KB}

4. Enter the following settings.

Name Type a name for the printer.

Medium Select the printer medium.

Film Size Select the film size for the printer.

Border Density Select a border density of Black or White.

Memory Allocation (KB) For most printers, accept the default of Auto. Otherwise, type the

amount of memory in kilobytes to allocate for a print session.

Film Destination Select the destination for exposed film.

Film Orientation Select the orientation of the film.

Magnification Select a magnification factor for printing images.

Empty Density _Select the density of the image box area on the film that contains no
image.

5. Select SAVE.

Configure a file store

File stores are directories on servers that Symmetry PACS uses to store files received in a DICOM
transaction, such as images from a modality.

CAUTION: Changing an existing file store can prevent the study from opening.
Procedure

1. Go to SETUP > Office > DICOM > FILE STORE.
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FILE STORE

MAME & HOTES OO, DIRECT o
CEFALIT STORE Linprosseassed DICOM shudies FAES Ak Lingmowen DR ORES
[ ExnSenes mages Frocassd DHAOM shades FAERBMEaGes
7 Ecanned Doos Scanned Domaments o Patient Cass FrExavEcanned images
2. Select ADD.

3. Type the server name, root directory, and notes, and then select SAVE.

Configure routing rules

With routing rules, you can define how certain types of data flow between Symmetry PACS and other
AEs. For example, you could create a routing rule that tells Symmetry PACS to automatically send all data
that it receives from ultrasound modalities to another PACS. You can also add criteria to your rule for
more precise control. For example, your rule could limit sending of ultrasound data from only a specific
facility.

Use the following procedure to configure a routing rule, and then apply the rule by following the steps in
“Configure study flow.” It is not necessary to apply routing rules for manual DICOM send operations.

Procedure

1. Go to SETUP > Office > DICOM > ROUTING RULES.

ROUTING RULES

HLULE HAME = AETITLE FRIORETY
W
B mutel EXAAITNIE 2
2. Select ADD.
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Rule Mame * ] Inactive
Fulel Priarity * 2

Type * Attempts * 2
SEND -

AE Title * EXA-VI-VIZ v

3. Enter the following settings. The available settings change depending on the AE type that you
select in the Type dropdown list.

Rule Name All Type a name for the rule.
Type All Select the transaction to perform with the AE (for example, SEND).
Interface/Trigger] HL7 Send Select an interface and/or trigger for HL7 send actions.
Name
AE Title SEND Select the AE with which to perform the transaction (for example, select
Remote_Hospital to send to that AE).
PRINT
QUERY/RETRIEVE
Send Report (Opal)
LOCAL_CACHE
Priority SEND Type a number to indicate which rules to evaluate first. Lower numbers
take higher priority. Refer to your current list of rules on the ROUTING
PRINT RULES tab to determine the priority to use for the rule you are adding.
QUERY/RETRIEVE
Send Report (Opal)
HL7 Send
LOCAL_CACHE
Attempts SEND Type the number of attempts the program should make to apply the
PRINT rule.
QUERY/RETRIEVE
Send Report (Opal)
HL7 Send
LOCAL_CACHE
Priors QUERY/RETRIEVE Type the number of priors to retrieve. Type 0 (zero) for all priors.
Modality QUERY/RETRIEVE Select an option to filter which priors to retrieve.
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Number of SEND Type the number of priors to send along with the study.
Priors to Send
LOCAL_CACHE
Auto Send Priors| SEND Select to send any priors found in the system along with the current
study.
LOCAL_CACHE

e The system sends as many priors as it can find, up to the Number of
Priors to Send.

e The system sends the most recent priors first.

Relevant Priors | SEND Select to send relevant priors when auto-sending, along with any non-
relevant priors that the system found. Enter criteria to define what is
LOCAL_CACHE relevant.

e If you do not define relevant priors (see "Define relevant priors" later
in this topic), the system considers relevant priors to be studies of the
same modality and/or body part.

e The system sends as many relevant priors as it can find, up to the
Numbers of Priors to Send.

o If the system finds fewer relevant priors than the Number of Priors
to Send, it adds non-relevant priors up to the number.

Force Relevant | SEND Select to send only relevant priors.
Only
LOCAL_CACHE o If the system finds fewer relevant priors than the Number of Priors
to Send, it does not send any additional priors.
[Define relevant | SEND Available when you select Relevant Priors. See "Define relevant priors"
priors] later in this topic.
LOCAL_CACHE

4. Optional. Configure a criterion for the rule:
a. Inthe Field dropdown list, select an argument and a logical operator.
For example, Modality and Is
b. Select a matching value for the argument.

For example, in the Modality list, select MG.

Aule Name * |,: Inactive
Fulel Priarity * 2

Ty * Attempts * 2
SEND w

AE Title * EXAAF-VEZ w
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c. Select ADD TO RULES.

Result: In this example, when Symmetry PACS receives an MG study, it automatically sends it
to the AE named Remote_Hospital.

6. Optional. Add more criteria.

7. Select SAVE.

Define relevant priors

Defining relevant priors allows you to send only priors that are relevant to the current study based on
study description, modality, or body part. To write definitions for which priors are relevant you use a
syntax called relevant prior logic:

STRING or (STRING STRING ...){.*(STRING STRING ...)}

"A single string, or multiple strings delimited with a bar, optionally followed by ".*" plus multiple
strings delimited with a bar."

Enter your relevant prior logic in a table, such as in this example:

Prior settings on the left... ...main study settings on the right
Main
Priar Stucy Main Study Body
Madality Prior Body Part Prior Description Madality = Part Main Study Description
o1 MR £
(KMEEIFATELLA) KINEE L |
[HEEL|CALCL*[LEFTILTIS) {HEELICALC).*(LEFT|LT|BI) # g

Row 1: Does not require relevant prior logic. When the main study is an MR, relevant priors are
CTs.
Row 2: When the main study is of the knee, relevant priors are either of the knee or patella.

Row 3: When the main study description contains "HEEL" or "CALC" followed by "LEFT," or "LT,"
or "BI," relevant priors are those whose descriptions also contain "HEEL" or "CALC" followed by
"LEFT," or "LT," or "BI."

Note: You can also define relevant priors that you want to auto-open in the viewer (see Configure

modality-specific viewing options).
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Configure AE scripts

You can write scripts that modify DICOM tags when carrying out a DICOM-related transaction such as
sending, printing, or receiving.

Procedure

1. Go to SETUP > Office > DICOM > AE SCRIPTS.

AE SCRIPTS

FRIIAM AE TYFE AETITLE CESCRIFTION
all wo o oall w

“ B 1 SEHD EXAAAZEE Scripls

2. Select ADD.

AE Type * Select v O Inactive

AE Title * Seleet ~. [J All

Script Description

O Asynchronous

Script * 7

3. Enter the following settings.

AE Type Select a transaction and node. The script runs when Exa makes the
selected transaction with the selected node.

AE Title

All Select all AEs of the selected AE Type.

Script Description Type a description of the script.

Asynchronous Select to run the script asynchronously.

4. In the Script area, type the script to run when the previous conditions are true.

Note: For syntax, select the help ? button.

5. Select COMPILE, and correct any errors that occur.
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6. When the script is free of errors, select SAVE.

Understanding receiver rules

A receiver rule is a detailed set of criteria and instructions that tells Symmetry PACS where to place studies
that it receives, and what status to assign them. For example, you can configure a receiver rule such that
studies with unrecognized account numbers are placed on the QC tab to await reconciliation by the user
before going live.

Note: Receiver rules also have an important role in accelerating the processing of incoming data.
Symmetry PACS processes each receiver rule in order on a particular computer. Therefore, to
improve speed, you can apply different rules on different computers.

To understand how receiver rules are evaluated and applied, it is helpful to imagine a 4-step process that
Symmetry PACS performs for each incoming study.

e Find a receiver rule that matches the study.

e Validate the study against existing PACS studies and/or match it to existing RIS orders.
e Process the successes (studies that passed validation and/or matched orders).

e Process the failures (studies that failed validation or did not match an order).

A detailed explanation of each of these steps follows.

Step 1 — Find a matching receiver rule

When Symmetry PACS receives a DICOM study, it evaluates the study against each receiver rule on
the RECEIVER RULES tab in order of “Priority” (starting from the top) until it finds one that matches.

PRICRITY =  RULENAME

2 M * ¥ 12 Kforwarder7
a1 + ¥ 13 Kforwarderd

7 2 PMTZ

Z W € 14 MMD Live
2 W 4+ ¥ 2 PMT

.. .'. .|5 _
7 W 1+ 4 3 File Import
From top... ...to bottom

If no user-defined rule matches, Symmetry PACS uses a “default” rule that has a minimum number of
criteria to ensure that all legitimate studies match at least one rule. (If a study did not match any
rule, Symmetry PACS would not receive it.)

To evaluate whether a study matches a rule, Symmetry PACS compares the settings you enter under
Rule Info and Filter (in the green box in the following figure) to the information in the study. If all
relevant criteria match, the rule becomes active, and the process continues to step 2.
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Rule info and Filter

Rule Name * [ Inactive
AE Title All ¥

Facility All b
Modality Al -

Institution

Status Unread v

Interval (Sec) * 120

Trigger RoutingRules O

Step 2 — Validate and match against PACS and/or RIS

A “rule” is actually not a single rule, but rather a combination of the previous “Rule Info and Filter,”
plus one of four possible preset “Applied Rules,” such as in the following figure.

Applied Rules

» Reconciliation Mode: Pacs only site
Emit Live Update
Precache Study
Precache Priors
MNao. of. priors: 3
Pick study description fram DICOM
Patient
* Account #/Dicom Patient 1D
» Last name
» Date of Birth
+ Macve Anyway (Even in exception)
» Move to live when there is no-malch
= Study
» Study UID
= Macve to live when there is no-match

Figure: Applied rules in the PACS ONLY preset.

Symmetry PACS compares the items in the green boxes from the incoming study against PACS, RIS,
or both, depending on the reconciliation mode (the first bullet item in the figure). The items under
Patient (such as “Last name” in the figure) and Study (“Study UID”) must match a patient in PACS
and/or a RIS order. Symmetry PACS stores the result of the match (success or failure) in this step,
and then evaluation continues to step 3 or 4.
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Step 3 — Process successes

If matching succeeded, Symmetry PACS waits the number of seconds specified in the Interval setting
from step 1, moves the study from the QC tab to the ALL STUDIES tab (the study “goes live”), and
assigns to the study the status selected in the Status dropdown list from step 1. At the same time, it
performs the actions and applies the options in the blue box in the following figure.

Applied Rules

Reconciliation Mode: Pacs only site
Emit Live Update

Precache Study

Precache Priors

No. of. priors: 3

Pick study description from DICOM

Patient

e Account #/Dicom Patient ID

e Last name

» Date of Birth

« Move Anyway (Even in exception)

* Move to live when there is no-match
Study

¢ Study UID

¢ Move to live when there is no-match

Step 4 — Process failures

If matching failed, the study initially remains on the QC tab with a status of Confiicts to await
reconciliation by the user. However, there is one more set of evaluations left to make, based on the

items in the orange boxes in the following figure.
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Applied Rules

* Reconciliation Mode: Pacs only site
e Emit Live Update
e Precache Study
¢ Precache Priors
e No. of. priors: 3
* Pick study description from DICOM
e Patient
e Account #/Dicom Patient ID
e Last name
» Date of Birth
* Move Anyway (Even in exception)
* Move to live when there is no-match
s Study
e Study UID
¢ Move to live when there is no-match

If any of these items are present, the study status is set to Completed in the QC tab. Additionally,
each item results in the following.

Move Anyway (Even in exception)

If duplicate matching demographics are found, or if at least one matching criterion fails, the study
also appears on the ALL STUDIES tab with a status of “FIX_.”

Patient: Move to live when there is no-match

The study moves to the ALL STUDIES tab even if patient demographic validation fails. Generally,
this is used only when no modality worklist is available.

Study: Move to live when there is no-match
The study moves to the ALL STUDIES tab, even if no matching order is found.

Note: If “Move to live when there is no-match” is present both under Patient and Study,
Symmetry PACS processes the study as a success.

See also:

Configure a receiver rule

Configure a receiver rule

You can configure receiver rules to tell Symmetry PACS where to place studies that it receives, and what
status to assign to them. For more information, see Understanding receiver rules.

Procedure
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1. Go to SETUP > Office > DICOM > RECEIVER RULES.

RECEIVER RULES

FRIDREETY FLALE PFAME AETITLE FACILITY MAODALITY HETITLTIOH STATUS:
All - 1 ¥ &l - Al e

B 1 IMFORT OFALIMPORT All All Unread

: - -AII L =) ol

2. Select ADD.

Rule Information and Filter Applied Rules

Rule Name * Ruled O tnsetive = Reconciliation Mode: PACS Only Site
* Emit Live Update

AE Title Al -

= Precache Study
Fasty Al s Precache Priors
taddality Al - + Mo, of Priors: 3
_ = Select Study description from DICOM
e = Patient
SHatus Unread w ¢ fAccount Ne /DICOM Patient |D
Interval {Sac) * 120 s Last Name

+ Date of Birth

Trigge Routing Rules - [ « Move Anyway (Even in Exception)
Igzuer OF Alernate O * Move to Live on No-Match
Accaunl Mumber - Stud}'
Recemver Rule . Study U|D

Example showing the PACS ONLY rules
3. Onthe RULES tab, select ADD.

4. Under Rule Information and Filter, enter the following settings as needed.

Rule Name Type a name for the rule.

AE Title Use these settings as filtering criteria. For example, to evaluate the rule
only against mammography studies, on the Modality dropdown list,

Facility select MG. To evaluate the rule only if the study comes from a specific
AE, select one under AE Title.

Modality

Institution

Status Select the status to assign the study if it matches the rule.
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Interval Select a number of seconds to wait before moving the study from the
QC tab to the ALL STUDIES tab (go live).

Trigger Routing Rules Select to force evaluation of matching studies against routing rules.
Issuer of Alternate Account Select to make alternate account numbers available. See Use alternate
Number account numbers.

5. Select one of the following preset buttons to assign a reconciliation mode and to add “applied
rules” (matching criteria and actions to perform) to your receiver rule.

PACS ONLY PACS Validate patient and study items against existing
PACS records.

PACS/RIS PACS + RIS Validate patient and study items against existing
PACS records and/or RIS orders.

PACS/DMWL PACS + RIS --same--

MIGRATION PACS Use when migrating data from another PACS. Allows

everything to be received.

6. Select SAVE.

See also:

Understanding receiver rules

Configure matching rules

See Work with Display Management.

Configure hanging protocols

See Work with Display Management.

Manage jobs in the transfer and SR queues

DICOM studies that you send appear as jobs in the transfer queue. You can view and change job status
and priority, cancel jobs, and requeue failed jobs.

Procedure

1. Go to SETUP > Office > DICOM > TRANSFER QUEUE or SR QUEUE.
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HOTOCOLE THANSFER JUEUE

REPROCESS SELECTED AEPROCESS FAILED REFRESH RELOAD

CURRENT STATUS CUELIED OATE LABT UPLATED DATE STUDY DATE ROCEESION Bk PATIENT HAMI

A w I R0EE - 0313023
2. Perform any of the following tasks.

View job status

In the list of jobs, the status is listed in the CURRENT STATUS column. The available statuses are as

follows.

Queued Processing not yet started.

In-progress Sending of data has started but not finished.

Completed Sending of all data is finished.

Canceled Sending of data canceled by the user. You can only cancel a job with a status of
Queued.

Error Sending was aborted due to failed association or the request was rejected by the
destination.

View demographics

To view the demographics of a study in the transfer queue, select the expand *+ button.
Change the job priority
To change the priority of a job, select the 7 edit button, select a new priority, and then select SAVE.

View job details

To view demographics and other queue details, select the view &l button.

Cancel a job

To cancel a job, select the cancel @ button.

Requeue a job

To requeue a job means to repeat or retry sending. If the status of a job is Queued, Error, Completed,

or Cancelled, you can requeue the job by selecting the requeue E button. Requeued jobs remain
in the transfer queue for 15 minutes before reprocessing begins.
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Reprocess non-failed jobs

Rather than requeuing jobs one at a time, you can select multiple jobs for reprocessing, and then
select REPROCESS SELECTED.

Reprocess failed jobs

Failed jobs are ones with a status of “Error.” You can select a range of failed jobs (such as by filtering
the worklist) and reprocess them all at once.

1. On the transfer queue, select REPROCESS FAILED.
2. Inthe date boxes, enter a date range of jobs to reprocess.
Note: To select all dates, leave the boxes blank.
3. Inthe AE Title dropdown list, select the AE whose jobs you want to reprocess.

4. Select REPROCESS.

Reprint DICOM Print jobs
1. On the transfer queue, find a job with type PRINT and status Completed.

2. Right-click the job, and select REPRINT.

Cancel a DICOM Print job
1. On the transfer queue, find a job with type PRINT and status Queued.

2. Right-click the job, and select Cancel.

Configure an issuer of a PID

See

500-

lternate account numbers.
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Man age users
Administrators can configure individual users, user groups, Active Directory, and assign roles (rights) to

users. In Symmetry PACS, you assign user roles to user groups, and then you assign user groups to
individual users.

AN

Incorrect user configuration can lead to security risks such as leaked patient information.

Create a user role

A user role is a named collection of user rights that you can assign to user groups. To create a user role,
complete the following steps.

Procedure

1. Go to SETUP > Office > User Management > USER ROLES.

USER ROLES

ROLE HAME = ROLE DESCRIFTION
& 8 dhling Biling
¢ B Facility sdmin Faciiny sdmin
B Frocadesk Feonl-desk

2. Select ADD, type a name and description of the role, and the select SAVE.

For example, type BI LLI NG, and then select SAVE.

3. Inthe User Role Permission area, select all of the user rights that you want to assign to the user
role.
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Role Name *

Role Description =

Billing

Billing

User Role Permission

O] Inactive

[ eilling/Setup

Billing Codes
Billing Class
Claim Status
CAS Group Code

Provider ID Code Qualifier

4, Select SAVE & CLOSE.

See also:

Create a user group

Create a user

Create a user group

Order ICD

Order Referring Provider
Grder Studies

QC Delete

QcC Edit

OO0O0O0OO0OaOo

OC Maove to Studies

A user group is a named collection of individual users to which you can assign roles and access to certain
document types and areas of the program.

Prerequisite: Create a user role.

Procedure

1. Go to SETUP > Office > User Management > USER GROUPS.

USER GROUPS

[ shaw Inactive

GROUECODE

2 i Fap
& @l FRDE
2. Select ADD.

GRCUP HAME

BILLING

Faciity Admin

Fronc-tes

GROUP DEECRIFTION 2

BILLING

Facility Administrator

Feoiis gk parsannet
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Group Code * BiL O nactive All Bocuments

Group Mame * BILLING D T B b Card

Group Description = BILLING B Inzurance Card
] Reparis:

Raoles Mavigation

B Billing [0 pashkoard

[ Facility Admin Wiorklist

[ Frontdask [J Patient Arrival Workliat

O Paortal Patiant

O raD Fax Manager

O rer Schedule

O 1EcH Eilling

O TrRans Payments

3. Enter the following settings.

Group Code Type your internal code for the group. For example, RAD.

Group Name Type your internal name for the group. For example, Radiologist.

Group Description Type a description for the group.

Document Types Select the document types that group members can access. For example,

select All Documents.

Roles Select all user roles that you want the group members to have.

Navigation Select the areas of the program that group members can access (items
available on the burger menu).

4. Select SAVE.
See also:

Create a user
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Create a user

A useris a member of a user group for whom you can configure custom rights and limitations in addition
to those defined in user roles.

Prerequisite: Create a user group.

Procedure

1. Go to SETUP > Office > User Management > USERS.

O shee Insstive

BSER MAME 2 HAME ORGUF NAME LISER TYPE MARRET
¥ Al -
&l adesk ADusk, Angla Froen-dask Others
S Arnaber a1 Anna Faciby admin Others Bdmrketi
ZEaagin Faien, g Faiity Admin Otheis

2. Select ADD.

SAVE SAVE & CLOSE UNLOCK ACCOUNT CLEAR BACK

Group Hamm * select Group =
oF Access Expires Afice days w
ﬂ Hide AD Groups

|:| Cne-Time Access

Mamg *
B user Must Change Fasswoed Next Login
[J Assign Claims ta Follew-Up Guius far Anather
Mohile Phana Mabil User
E-bAaill Erml [ User esn charge scoounting dates
Uigar Nama ? i Maer [T snactive O Rragom 360

Wharkat MNOME SELECTED =
Passward Pasing
Confirn Password * seriliier Paaawd Eriiy s =

Sassion Inbordal Linked Provider Wser Type | Salect w

O akow Emargency Access O Hide Qrder Mer

3. Enter the following settings.

Not all settings may be available depending on your product and configuration.

Group Name Select the user group to which the user belongs.
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Name

Type the user’s name.

Mobile Phone/
E-Mail

Type the user’s mobile phone number and/or email address. The email
address must be unique, and is required for two-factor authentication.

User Name

Type a sign-in user name for the user.

Login with Google

When selected, the user can sign in through their Google account.

Netcare access

Select to grant permission to access Alberta Netcare (Alberta only).

Password

Type a sign in password for the user. This option is only available the first
time you configure the user.

Session Interval

Type or select the number of minutes before the user’s session times out.

Allow Emergency Access

Select to assign “super user” rights to the user regardless of roles or
groups.

Linked Ordering Facility

This dropdown list becomes available when you select Ordering Facility in
the Linked Provider User Type dropdown list. Select ordering facilities to
appear on orders the user creates in the Ordering Facility portal.

Access Expires After

Type and select a duration after which the user’s account expires. Leave
blank to keep the account open indefinitely.

One-Time Access

When selected, the user can sign in only one time.

User Must Change Password
Next Login

Select to force the user to create their own unique password after logging
on the first time.

Assign Claims to Follow-Up
Queue for Another User

Select to give the user the ability to add claims to another user's follow-up
queue.

User Can Change Accounting
Dates

When selected, the user can edit accounting dates under Billing >
Payments.

Dragon 360 [reserved, do not select]

Market Select the market that the user serves. This setting narrows search results
in other parts of the program. For example, when the user searches for a
patient chart, Symmetry PACS only returns charts of patients in the same
market as the user.

Facilities Select the facilities that the user can view and modify.

Linked Provider User Type

Select the user type if linking to one. If you select Ordering Facility, the
previous Linked Ordering Facility and Ordering Facility dropdown lists
appear.

Ordering Facility

Appears when you select Ordering Facility in the Linked Provider User Type
dropdown list. Select the ordering facility into whose portal the user can
sign in.

Search Type

(Available when Provider or Ordering Facility is selected.)

Select the range of patient and other data that the user may search: full
patient database, or only the associated patients in the portal.
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Scheduled By (Available when Ordering Facility is selected.)

Select an option to control the dates available to the user when requesting
an appointment in the ordering facility portal.

4. Select SAVE.

5. Optional.
e To limit what the user can view on the worklist, see Configure an administered worklist filter.
e To view a user’s devices, select the ATTACHED DEVICES sub-tab.

e To restrict the user’s access to specific ordering facilities, select the USER PERMISSIONS
sub-tab.

See also:

Create a user role

Reset a user’s password as an administrator

If a user forgets their password, an administrator can reset it or prompt the user to reset it the next time
they log in.

Procedure

1. Go to SETUP > Office > User Management > USERS.

O show Insstive
SR MAME & NAME GROUP NAME LISER TYPE MARSET
WAl W
8 adusk ADusk, Angla Frosni-dask Otars
S Arnaer i1 Anna Facdiby Admin Others Bdarkeil

£ aragin agin, frgis Faciity Admin [nli=]
2. Double-click the user in the list and do one of the following.

e Select RESET PASSWORD, and then choose a new password for the user.
e Select the User Must Change Password Next Login checkbox.

500-000577A 88



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rpAcs

RESET PASSWORD UNLOCK ACCOUNT BACK

+ After days hd

[0 One-Time Access

[0 User Must Change Password Next Login

[ Assign Claims to Follow-Up Queue for Another
User

O usercan change accounting dates
O Dragon 360
3. Select SAVE.

4. Inform the user to sign out and then sign in again with the new password, or follow the on-screen
instructions to reset their password.

Configure an administered worklist filter

In addition to user roles, administrators can use the following steps to configure worklist filters that
control which studies, patients, and other information are available to individual users and user groups.
Users can configure their own worklist filters but cannot edit filters that administrators configured for
them.

Procedure

1. Go to SETUP > Office > User Management > USERS.

O Shee Insstive

UEER MAME % HAME GROUF MAME LESER TYPE MARKET
W All w
& Wadush ADusk, Angla Frosi-dask Otrrars
Sl arnaGer Gex Anna Factity Admin Others Mdarket]
ZEaragin Tz, Argie Faciity Admin Otkers

2. Double-click a user row to open a user, and select the WORKLIST FILTER sub-tab.
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WORELIET FILTER ATTACHED DE

Diefeted

Date Operations By
C Created Dala

O Prafomatied

~
.} Dale From

WVICES SER FERMISSIONS

[ show Encaunters Gnly [ pisable Right-Click an Worklizl STAT Studies Override Current Sub-Filter

[ show DICoM Studies Only [ Show RIS Orders Only [ show Assigned Studies Only

All LY
® Siudy Date ] Study Received Date 0 Scheduled Date 2 Lant call made
From o] Ta L)
s} Data Ta 7| o

3. Perform one or more of the following procedures.

Configure general user worklist

filter settings

You can finely control the information on the worklist to which the user has access.

1. Inthe left pane, select GENERAL.

2. Enter the following settings, and then select SAVE.

Show Encounters Only

Select to show only studies involving interaction between a patient and
provider.

Show DICOM Studies Only

Select to show only DICOM (imaging) studies.

Disable Right-click on Worklist

Select to prevent the user from opening the worklist shortcut menu.

Show RIS Orders Only

Select to show only orders from RIS.

STAT Studies Override Current
Sub-Filter

Select to always show studies with assigned STAT levels, regardless of any
other filtering criteria.

Show Assigned Studies Only

Select to show only studies to which a user is assigned.

Deleted

Select whether to show all, only, or no (None) deleted studies.

Configure the following setting

s together to compose a single filtering condition.

Date Operations By

Select a study property against which to apply criteria.
Study Date
Study Received Date
Scheduled Date

Last Call Made
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Created Date

Preformatted Select from a list of preformatted date ranges, rather than manually
entering one by using the settings described later.

Example:
Date Operations = Study Date
Preformatted = Last 7 Days

“If the study date falls within the last 7 days, display the study on the
user’s worklist”

Last/Next Select a time range for the selected property.
Example:

Date Operations = Study Received Date
Select Last, type 8, select Week(s)

“If the study was received some time during the last 8 weeks, display the
study on the user’s worklist.”

Date From / Date To Select and enter a date range for the selected property.

From / To Select and enter a time range for the selected property.

Limit access to patient information
You can limit the worklist to only display studies for patients who satisfy certain criteria.
1. Inthe left pane, select PATIENT INFORMATION.

2. Under Patient Name, select a logic option, type the exact portion of the patient name that

corresponds to the selected logic option, and then select the plus button to add the criterion.
3. Under Account No., perform the previous step as appropriate for the account number.

4, Select SAVE.

Limit access to study information
You can limit the worklist to only display studies that satisfy certain criteria.
1. Inthe left pane, select STUDY INFORMATION.
2. For each criterion, select a logic option, and then type or select a value.
3. For example, to display only abdominal studies, under Body Part:

e Select the Is option

¢ Inthe list of body parts, select Abdomen
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4. Select SAVE.

Limit access to information related to specific resources
You can limit the worklist to only display studies whose resources satisfy certain criteria.
1. Inthe left pane, select RESOURCE.
2. For each criterion, select a logic option, and then type or select a value.
For example, to display only studies whose referring physician is Jane Doe, under Ref. Phys.:

e Select the Is option

e In the box, type JANE DOE, and then select the plus button.
3. Select SAVE.

Limit access to information from specific insurance providers
You can limit the worklist to only display studies for patients who satisfy certain criteria.
1. Inthe left pane, select INSURANCE.

2. For each criterion, select a logic option, and then type or select a value. For example, to hide
studies under litigation, under Insurance Provider Type:

e Select the Is Not option

e In the box, select Litigation, and then select the plus button.
3. Select SAVE.
See also:

Create a user worklist filter

Manage who is online

Users with user management rights can view a list of users who are online, view a user’s activity log, and
terminate their session.

Procedure

1. Go to SETUP > Office > User Management > USERS ONLINE.
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USERS DMLIMNE

LISER MAME LOGQED iM DATE CLIENT IF LAST ACCESEED T

D3 ra02E - 031452023

W Wigtek, Pacs QAr1ar 2023 7237 AW EOT 102278240 Sag
= Serace, Admin 03/14/2023 B;41 AM EDT = maga Isrminale
& Eerdice, Admin 03¢14/2023 7:41 AM EDT 37 mago Tetminade

2. Optional: To view a session log for a user, select the log & button.

View assigned studies and patients

You can view lists of studies and patients that are assigned to you (the current user).
Procedure

1. Go to SETUP > Office > User Management.

ASSHG NED: STUDIES

13 RE E
LIEER AZEIONED & ACCEESIDN ML AESIGHNED STUMEE STUDY STATUE ASSHENED BY AESIGANED DAT
"] Radialogiss, Richard 1156 30 RMDR IER CT MEI LE/0TH X REG POSTRCK Approved Test, Aad 0303 0TS
O Radiclogist, Richard a4 BONE LENGTH STUMES Approved Ry, Kirmila 11182023
I Rardicdogist, Richard 23 ANGRFH ADRML UKI ELCTV RES] Approved Fay. Kirmila 011B/2023

2. Do one or both of the following.

e To view studies assigned to you, select the ASSIGNED STUDIES tab, and then select a sub-
tab to filter by user type.

e To view patients assigned to you, select the ASSIGNED PATIENTS tab.

Assign access to third-party tools

You can configure which users have access to which third-party tools, such as Updox.

Procedure

1. Go to SETUP > Office > User Management > THIRD PARTY TOOLS.
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THERD PARTY TOODLS

(35 sclected) Third Party Tools
Search users... lkonopedia (i
& SELECT ALL USERS S Aoup LN i
AP1URL
Adrmin, Facility Actlon | warklist_port
Fadtrun Fi ty A
Customer [
Admin, Pacs
iy Facity Admin Extermal Asset | FPortal
Admin, Site Pertal Password
b Farity ddrmis
Study Identifier | |{occeasian_npaj)

2. If the Search users box does not appear, select Ungroup users.

3. Select one or more users:

e To select a single user, in the Search users box, type all or part of the user name, select
Ungroup users, and then select the correct user in the list.

e To select one or more user groups, select the Remove All Users button (to show the Select
All Users button), select the user group to select, and then select Select All [Group] Users.

4. In the Third Party Tools list, select which tools to make available to the selected user or users by
turning the tool’s switch from off [ Jto (=] on.

5. Optional: Edit tool configuration settings.

Configure an nVoq user account

To use nVogq for voice recognition, KM staff must configure nVoq user accounts in Symmetry PACS. Obtain
user account information from the nVoq website.

Procedure
1. On Go to SETUP > Office > User Management > THIRD PARTY TOOLS.

2. On the left side, use the group boxes to select a user.
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THIRD PARTY TOOLS

inttamey Porta

Augsstin, Emil

Farlity Amin

Autobotlast, Autobotfirst

ayinhol Facliy Admin

Dewi, Gayathri

gayal Facility Admin

Exa System, Opal

b Bk opal 140 IS 1430 EMIN1 Portal
i

fuserl, fuseri
FiEl, Anna
latha, hema
Maher, Dennis

newhilling, newbilling

Provider, Referring

n\aq

Aceaunt URL

Sarvies URL

Password | [ nror i

Updox

Ul LARL

APIURL

Accoumt 1D | Dntor the Aocoant 1D

O sdmiristraoe
O send far with Updeo

UserMame | Ertes the User Mame

APPLY TO SELECTED USERS

3. On the right side, in the nVoq box, enter the user’'s account information.

4. Turn on nVoq ) [ _u]

5. Click APPLY TO SELECTED USERS.

See also:

Dictation and transcription with Exa Trans and nVog

Copy settings from one user to another

To create new users more quickly, you can add a user and then copy settings from an existing user.

Procedure

1. Go to SETUP > Office > User Management > COPY PROFILE SETTINGS.
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COEY PROFILE SETTIRGS

Soniiee Llpar *

Destimation User * Sulect Daabnation -

2. Inthe Source User dropdown list, select the user whose settings you want to copy.

3. Inthe Destination User dropdown list, select a user to configure with the source user’s settings,
and then select the plus button.

4. Optional. Repeat to configure additional users with the source user settings.

5. Select SAVE.
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Configure general settings
You can set up study forms, custom forms, templates, and queues, and perform limited database
queries.

Create a study form

Study forms are interactive electronic forms that people inside and outside your organization can use to
gather or provide needed information quickly—and often automatically. Examples include consent forms
for HIPPA or treatments, screening forms, pain sheets, affidavits, customer payment plans, and
procedure checklists. For information on how to use forms that you create, see Add a custom form to a
patient record and Add a study form to a patient record.

Set up a study form

Use the following procedure to initially set up the form, and then see other topics to add and edit form
contents.

1. Go to SETUP > Office > General > FORM BUILDER.

FORM BUILDER

DOCUMENT MAME KARKETH

£ B contrast Consent for todinated Dye
= B CT Scresning Form

F B Echocardagraim Wadksheat

2. Select ADD.

3. Type a Form Name, and then select the the ASSIGN sub-tab.
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Form Name® Test

ASSIGM

Document Type Select..
O viewable on Patiant Portal

O auto Assign to Study
Insurance

Provider *

O Allow All with Em pty
O allow All without Empty

Physician *

O allow All with Empty

| e TS T ¥ =

-

4. Enter the following settings to define the scope of the form and filter its availability.

Document Type

Select a type in order to group forms and make them easier to find.

Viewable on Patient Portal

Select to make the form available from the patient portal and in Patient
Kiosk.

Auto Assign to Study

Select and then enter criteria for studies to which to automatically assign
the form. Assigned forms appear in the Study Forms tab of the Edit Study
screen, making them available to users without performing dedicated
searches.

Insurance Provider

Allow All with Empty

Select to restrict availability to the form to specific insurance providers.

Select to make all providers available if none are specified.
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Allow All without Empty Select to make the setting required.

Physician Select to restrict availability to the form to specific physicians.
Allow All with Empty Select to make all physicians available if none are specified.
Allow All without Empty Select to make the setting required.

CPT Codes Select to restrict the form to studies with specific CPT codes.
Allow All with Empty Select to make available for all CPT codes if none are specified.
Allow All without Empty Select to make the setting required.

ICD Codes Select to restrict the form to studies with specific ICD codes.
Allow All with Empty Select to make available for all ICD codes if none are specified.
Allow All without Empty Select to make the setting required.

Markets The form is available to patients in, or having exams scheduled in the

markets you select. All facilities in the selected markets become selected in
the Facilities dropdown list.

Facilities The form is available to patients in, or having exams scheduled in the
facilities you select.

Modalities Select to restrict availability to the form to studies from specific modalities.

Male Patient Only Select to restrict availability to the form for male patients only, such as for
prostate exams.

Female Patient Only Select to restrict availability to the form for female patients only, such as
for HSG exams.

Mammo Patient Only Select to restrict availability to the form for mammography patients only.

5. Select SAVE.

Add a header to a study form

1. Atthe top of the FORM BUILDER tab, select the Header checkbox.

2. Inthe form area, select the word “Header.”

3. Inthe left pane, on the PROPERTIES tab, select CHANGE LOGO.

4. Browse for and select a logo, and then select Open.

5. Inyour form header, select the word “Header” and then replace it by typing a new field name.

For example, type St udy Dat e:
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6.

8.

10.

11.

% Overwrite "Header” with new header text, for example:
Study Date:"$5StudyDate$S Patient: S5Lastname$s, S5FirstName$s

KOMICA MINOLTA

B
Ji

name

Merge Fields
= Patient

FirstNams

Fullname

In the left pane, on the MERGE FIELDS tab, in the search box, type search term to look for a
relevant merge field.

For example, type st udy.

In the list of results, double-click a merge field to add it to the form header.
For example, double-click StudyDate.

To the right of the $$StudyDate$$ merge field, type a new field name.

For example, type Patient Nane:

Repeat earlier steps to find and add a merge field for the patient name.
Hint: Search for “name” rather than “patient.”

In the left pane, on the PROPERTIES tab, use the Spacing and Style controls to modify the
layout.

Select Save.

Your header could look something like the following.
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Name: 55Fullnames5
Study Description:

SUMMELNY-PACS st

$$StudyDateSS

Add text controls to a study form

Use controls to gather information from or provide information to the person filling out the form.
To add a control, drag its button into the body of the form. To configure the control, select it and
enter options in the left pane.

e

% Overwrite "Header” with new header text, for example:

Study Date;"555tudyDateS$$ Patient; S5Lastnamess, $5Firsthlar
KOMNICA MINOLTA

This is a Tewt Box

| )

These are Checkboxes
O Mew

] walk-in

(] Emergency

o All

This is a Text Area

[ — The user can enter text here.

Thess are Radia Buttons

) optien 1
O option 2

b This is a Free Text box

- FH':L.'-' some static text

Italic O underline

W

Text boxes

Text Boxes to gather one-line user input
Text Areas to provide boilerplates
Free Text boxes to gather or provide information longer than one line.
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The following compares the properties of text controls.

Text Variable Scrollable Printer Inline
. Height . Controls
Formatting Friendly
Text Box | No Yesi No 1 line Yes Yes
Text Area| No No Yes 1 line No No
Free Text| Yes2 No Yes 5 lines Yes No

1. With Dynamic Input selected.

2. Font family, size, emphasis, and alignment.

To add a text control:
1. Drag the Text Box, Text Area, or Free Text button onto the form.

2. Select the word “Untitled,” and then in the left pane, in the Question box, type text to introduce
or label the text input box. For example:

For an information gathering box, type Pl ease |ist all allergies.
For an information providing box, type Li abil ity wai ver.

3. If the text control is for providing information, enter the information in the box.
Adjust vertical spacing:

e To adjust the space between the question and the box, use the Line Height slider.

e To adjust the space before and after the text control, use the Padding slider.

e To apply adjustments to all fields on the form at once, select Apply Spacing to All checkbox,
and then use the sliders.

o Ifusing a Text Box, select the following options for Inline Controls.

Fit on One Line Select to place the label one the same line as, and to the right of, the text
input box.

Inline Multiple Controls Select this option for two adjacent text boxes to place both on the same
line.

Question First Select to move the label to the left of the text input box.

Append Text Input Select to add a new input box between the label and the original input box.
This new input box is only available to the person filling out the form.

Dynamic Input Select to fit the height and width of the text box to the text it contains.

e If using Free Text to provide information, apply formatting to your text as needed by using the
Style controls.
e To adjust the width of the text control, select an option in the Size dropdown list.
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4.

Select SAVE.

Add animage to a study form

1.

2
3.
4

To add an image, drag the Image button to the form.

To give the image a title, select Untitled, and then type a title.

Double-click the box below the title, and then browse for and select an image file.
On the left pane, use the controls to modify the alignment and size.

Note: If you select a size of Original, the image expands to fit the width of the page.

Add checkboxes to a study form

1.
2.

7.
8.

To add a group of checkboxes, drag the Checkbox button onto the form.

Select the word “Untitled,” and then in the left pane, in the Question box, type text to label the
checkbox group.

For example, type: Al | er gi es.

Adjust the vertical Spacing, Inline Controls, and checkbox label Style (see “Add text controls to
your form” earlier in this topic).

To add a new checkbox to the group, select ADD ANSWER.
To label individual checkboxes, type labels in the boxes under Answers.
For example, type Peanut s for the first checkbox, and Mol d for the second.

To arrange the checkboxes in columns, select a number in the No. of columns for Answers
dropdown list.

To add an “Other” checkbox with accompanying text input box, select the Add Other checkbox.
Select SAVE.

Add options to a study form

While checkboxes make the person filling out the form able to select more than one option, options
provide an “either/or” setting. You add an option group to your form by using the same procedure as
for checkbox groups, except that you drag the Radio Button button onto the form instead of the
Checkbox button.

Add a group box to a study form

A group box is a named group that can contain one or more checkbox groups and/or one or more
option groups. To add a group box:
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Drag the Group button onto the form.

Select the word “Group Title,” and then in the left pane, in the Question box, type text to label
the group.

To add a background image to the group, in the left pane, select CHANGE IMAGE, browse for
and select an image, and then select Open.

To divide the group into columns, in the Grid Columns dropdown list, select a number of
columns.

To add a checkbox group or radio button group into a particular column, in the New Control
Placement list, select the number of the column, and then drag the Checkbox or Radio Button
button onto the group.

Configure the checkboxes and/or radio buttons as described in “Add checkboxes to your form.”

Select SAVE.

Add a footer to a study form

You can add and modify footers in the same way as headers. However, we often recommend using
the footer for a signature line with a signature merge field. After the person electronically signs the
form, their signature appears in the location of the merge field. To create a signature line in the

footer:
1. At the top of the FORM BUILDER tab, select the Footer checkbox.
2. Inthe form area, select the word “Footer,” and replace it by typing Si gnat ur e.
3. Inthe left pane, on the MERGE FIELDS tab, search for “signature” and then double-click
SudyFormSignature in the list of results.
4. Select SAVE.
See also:

Add a study form to a patient record
Add a custom form to a patient record

Export and import a study form

To save time creating a form for “Facility A,” it may be helpful to import an existing form from “Facility B”
and then modify it.

Export an existing study form

1.

Go to SETUP > Office > General > FORM BUILDER > EXPORT.
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FORM BUILDER

DCCURERNT RAME MaREETS

B Contrast Consent for lodinated Dye
Result: The form appears in the Windows Downloads folder as a JSON file.

2. Copy the JSON file to the computer at Facility A.

Import a study form

1. Go to SETUP > Office > General > FORM BUILDER > IMPORT.

2. In the Import Study Forms dialog, select CHOOSE FILE, browse for and select the copied JSON
file, and then select Open.

3. On the FORM BUILDER tab, find the new form and edit it for use at Facility A.

Create a custom form

Custom forms are non-interactive electronic forms intended for delivering information. For interactive
electronic forms that can both deliver and gather information, see .

Set up a custom form

1. Go to SETUP > Office > General > CUSTOM FORMS > ADD.

CUSTOM FORMS

Jocument Name * | Custom Form Test Labels
O inactive
Jeseription An example

O eatient Review
D Fatient Mammo Form
[ Education Material

Reference Document
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2. Enter the following settings.

Document Name Type a name for the form.
Description Type a general description.
Labels [Unused]
Patient Review [Unused]

Patient Mammo Form

Education Material Select to make the form available in the EDUCATIONAL MATERIAL area of
the patient chart.

Reference Document Select to make the form available in the DOCUMENTS and CUSTOM FORMS
areas of the patient chart.

3. Move down the page to Assign Document.

Assign Document

Facility My Company ® |*

ICD Codez * X | v

A00.9,Cholera, une
I Allow All with Empty 00.9,Cholera, un

[ Allow All without Empty

Medication * Medication +

O Allow All with Empty Ibuprofen

[ allow all without Empty

4. Enter the following settings.

Modalities Select modalities to which to assign the custom form.
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Facility Select a facility to which to assign the custom form, and then select the
add button.

ICD Codes Select to restrict availability for specific ICD codes.

Allow All with Empty Select to make available for all ICD codes if none are specified.

Allow All without Empty Select to make the setting required.

Medication Select to restrict availability for specific medications.

Allow All with Empty Select to be available for all medications if none are specified.

Allow All without Empty Select to make the setting required.

Lab Codes Select to restrict availability for specific lab codes.

Allow All with Empty Select to make available for all lab codes if none are specified.

Allow All without Empty Select to make the setting required.

Male/Female/Mammo Patient Select to restrict availability of the form to male, female, and/or

Only mammography patients.

5. Select SAVE.

About adding contents to a custom form

The custom form word processing area provides commonly recognizable tools to type, align, and
apply formatting to text, and insert images and merge fields. You can copy and paste contents by
using the Ctrl+C and Ctrl+V keyboard shortcuts. To change font sizes, select text that you want to
resize, and then select a size in the Font Size dropdown list.

e} ST =l Led1 Ta
P Pl
W4 rmas- B F EEEE E-E-33 & R
Lastnarma
Patient: S&Lastnamats, SSFirstNamets
Provider: SSApprovingPhysicanFullMamess
iddlera
Prowider
AparovingPrysicla thia
) ruaF 15 1
oy 4 1 M
"l:':l'."'u'--:":.:' mpsiciantd idclefdamo

Add merge fields to a custom form

In this example we show you how to add a signature merge field to a custom form. You must add a
signature merge field to be able to electronically sign the form.
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4.

In the right pane, in the Merge Fields area, in the search box, type search term to look for a
relevant merge field.

For example, type si gn.

In the list of results, double-click a merge field to add it to the form.

For example, double-click CustomFormSign.

To the left of the $$CustomFormSignature$$ merge field, type a new field name.
For example, type Si gnat ur e:

Select SAVE.

Editing a custom form

Note: If you edit an existing form, your changes will not appear on forms that are already attached to
a patient chart. To edit a form:

1.
2.

On the burgerE menu, select SETUP.

On the OFFICE menu, select General.

=

On the CUSTOM FORMS tab, select the form |- button of the custom form that you want to
edit.

Edit the form as needed, and then select SAVE.

Perform a quick query of database totals

As an alternative to reports, you can quickly search the PACS and RIS databases with customizable
queries. A "DB total" search tells you how many patients, studies, and images in your databases match
the search criteria.

Procedure

1.

Go to SETUP > Office > General > DB TOTALS.
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DB TOTALS

Date Range 02/14/2023 i1 || ©03/14/2023 i
(® Study Date ) Study Received Date () Approved Date
Facility All .
Modalities All
Study Description All
Institutions
All

ot

2. Enter the following search criteria.

Note: If you performed a search previously during the current session, refresh your browser
before entering new criteria.

Date Range Select a date range within which to search.
Study Date Select a category for the date range:
Study Received Date Search all studies with a study date within the date range.

Search studies whose DICOM receive date is within the date range.

Approved Date Search studies that were approved during the date range.

Facility Filter the search by facility.

Modalities Filter the search by modality.

Study Description Filter the search by study description.

Institutions Filter the search by institution.

ADD To add a new institution to the list, clear the All checkbox, type the name

of the institution in the box, and then select ADD.

3. To run the search, select UPDATE TOTALS.

4. The search results appear below the button under DB Details.
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5. Optional. To export a more detailed report of your search and results, select CSV REPORTS.

About email templates and notification templates

Email templates and notification templates contain pre-formatted text that you can have Symmetry PACS
automatically send through and along with various media. Note that the original term email template now
also applies to non-email media such as faxes. Commonly, you use email templates to auto-send
reports to providers and patients, and notification templates to auto-send study status changes to
referring providers. The following table summarizes the differences in auto-sending media based on the
type of template.

To create templates, see Configure an email template and Configure a notification template. To configure
auto-sending of media using the templates, see Set up emailing of exam results and Set up sending of
notifications.

Auto-Sending of Media Based On:

Email Templates Notification Templates

Feature

Where to Setup > [all caps button menu] > General > | Setup > [all caps button menu] > General >
configure Email Template Notification Templates

template

Who can receive | Referring provider locations/contacts, Referring provider locations/contacts

media referring provider group, referring provider's

patient (in Patient Portal)

What media are | In addition to text defined in the template: Email or fax of status changes, including text
sent defined in the template.

Reports

PDF attached to email
Link attached to email
Print and mail

Print on selected printers
Fax to referring providers

Fax to referring provider's office

Images

CD, Film, Paper

How to turn Select checkboxes in "Reports to Me" e Select checkboxes is "Notification Settings," and
ON/OFF auto-
sending e Select notification template in each status at

which you want to auto-send.
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Configure an email template

Follow the steps in this topic to configure an email template. To use the template to auto-send emails
and other media, see Set up emailing of exam results.

Procedure

1. Go to SETUP > Office > General > EMAIL TEMPLATE.

EMAIL TEMPLATE

|
TEMPLATE MARE REFORT TYPE = SUBJECT FAfILITY MARKET
&l o Ll v | Al w
|
| ## [l Hotification Bhy Study Cancelation Teess Angie Facildy My ComparyMimalla Test Fa
£ B Dataukt Confirmotion Scraan Confirmation Screan Dedaul Appoiniment Confirmation Scresn My CompanyNimdlla Test Facaity srinb Fr
|

2. Select ADD.

Template Name * Default Confirmation Scre [ Inactive

Category Canfirmation Screen w

Subject * Appaintment
Confirmation Email

3. Enter the following settings.

Template Name Type a name for the template.

Category Select the type or purpose of the template.

Subject Type text to appear on the Subject line.

Markets Select the market for which the template is available. All facilities associated
with the select market become selected in the Facilities list.

Facilities Select the facilities to whose studies the template applies.

4. Use the word processing tools to compose the body of the email.
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Formats B [

I
I
Il
I
i
i
il
Il
Gy
K

Dear S&FirstMamets SsLastnamess,

This is a reminder for your $SAppointmentTypeDescriptionss Imaging study
on $5studyDatets at $SOfficeNamess. -~

T

Mg Frakdn
& Famiel

Below are the prep instructions for your exam.
$5ExamPreplnstructionsss

If you have any quastions or need to reschedule, please call our office at S$Facilil
Otherwise, we look forward to seeing you on SsStudyDatess,

Best regards,
s3CampanyMamess

s50fficeNamess £ Provids
ss0fficenddress1ss, s30fficeCityss, $50fficestatess "

5. To automatically insert exam details into the email:
a. Inthe right pane, in the Search here box, type a category of information (e.g. Pat i ent ).
Note: Category searches are case-sensitive.
b. Inthe resultant Merge Fields list, select a merge field group (e.g. Patient).
c. Double-click a merge field to add it (e.g. FirstName).
6. Select SAVE.

See also:

About email templates and notification templates

Set up emailing of exam results

By completing the following tasks, Symmetry PACS automatically sends exam results and reports to the
referring provider locations/contacts you modify.

Prerequisite:

Administrators must configure the company’s email server (see General settings).
Tasks:

e Configure an email template.

e Add a facility, and configure all email- and fax-related settings.

e If you want to email a provider group or location, Add a provider group or location.

e Configure a referring provider location/contact, including the email address, fax numbers, and
options under Reports to Me (see Add a resource).
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See also:

About email templates and notification templates

Configure a notification template

Follow the steps in this topic to configure a notification template. To use the template to auto-send status
change emails or faxes, see Set up sending of notifications.

Procedure

1. Go to SETUP > Office > General > NOTIFICATION TEMPLATES.

ROTIFICATION TEMPLATES

TEMPLATE FAME = ELBECT FACHLITY MARKET
w | &l -
& W RafPhyeotificeson Tasl Aregpa Facditty My Company Sirmiils Test Facilgyann
2. Select ADD.

HOTIFICATION TEMPLATES

Template Name * Subject Markat

RefPhyMadification Test NONE SELECTED =

Facilities *

f nams| | £

Farmals B I

('
1]
fild
11}
(i1}

1
liid
fid
%
I

$5Fullnamess SsAccessionioss Marge Ficlds

= Patiant

FirstMama
Fudlname
Lastnarma
Middianame

Lisemama

£ Provider
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3. Enter the following settings.

Template Name Type a name for the template.
Subject Type text to appear on the email’s Subject line.
Market Select the market for which the template is available. All facilities associated

with the select market become selected in the Facilities list.

Facilities Select the facilities to whose studies the template applies.

4. Use the word processing tools to compose the template.
5. To automatically insert exam details into the notification:
a. Inthe right pane, in the Search here box, type a category of information (e.g. Pati ent ).
Note: Category searches are case-sensitive.
b. In the resultant Merge Fields list, select a merge field group (e.g. Patient).
c. Double-click a merge field to add it (e.g. Fullname).
6. Select SAVE.

See also:

About email templates and notification templates

Set up sending of notifications

By completing the following tasks, Symmetry PACS automatically sends status change email notifications
to the referring provider locations/contacts you modify.

Prerequisite:
Administrators must configure the company’s email server (see General settings).
Tasks:

e Configure a notification template.

e For each status of which you want to auto-send notification, select the notification template under
"Notification Settings" (see ).

e Configure a referring provider location/contact, and select the location/contact's Email/Fax and/or
Receive When Added as a CC Provider checkboxes (see Add a resource).

See also:

About email templates and notification templates
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Create fax cover sheets

You can create a cover sheet to automatically attach to faxes. You can create one cover sheet for each
facility. To create a cover sheet:

Procedure
1. Go to SETUP > Office > General > COVER SHEETS tab, select ADD.

2. Type a name for your cover sheet, select the facility where the cover sheet will be available, and
then select SAVE.

3. Use the word processing tools create your cover sheet, and then select SAVE.

4. Select SAVE & CLOSE.

Work with the report queue

You can open a report queue that shows reports that you previously generated or that are currently in
process. You can resend (reprocess) individual reports, or reprocess them in batches.

Procedure

1. Go to SETUP > Office > General > REPORT QUEUE.

NOTIRCATION TEMPLATES COVER SHEET? REPORT QUELIE

l REPROCESS SELECTED REPROCESS FAILED

QUELED DATE 5 LAST UPDATED -STUDY DATE ACCEES RECEIVER TYF DOCUMENT RECENVER MAME PATIENT DELIVEN DELIVERY ADDREE CURRENT & PR
all w0 Al W Adl W all b
T A O G & GO S O G A T T T T T T 5 R T S TR A TR AR o ([ '
Foannsizzs A5 J3/03/2023.1001166  Refemt B T g TesLFarmer  Fax  {F45HA54-5454 Quaued
Rasend
O30S RIS TS 000 2023 10403/ 03 2023 1001164 Raofari = : g Test, Farmer Email  mirmilla.roywiEkonici Sent
anced
R03/03/2023 1235 03072022 1221165 Refering ProvirApproved ReTesy, Reterring  Test, Frank Fau {745)454-5454 Quewed

2. To resend a report, right-click it in the list and then select Resend.

3. To resend a batch of reports, at the top of the list, select REPROCESS SELECTED or REPROCESS
FAILED.

4. To resend a report automatically at a later time, right-click it in the list and then select Requeue.

View logs
To view the various logs that are available in Symmetry PACS, do the following.

Procedure
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1. Go to SETUP > Office > Log.

2. Select tabs (AUDIT LOG, USER LOG, etc.) to view different logs.

From | (3A0R0EE 120000 AMES T To CEAQrHRIR5ESaPMEn [ I s I P HL7 B oF BR

oo | oo

LOSAED ARTE 5 GLREEN LEER PATEN L8 DESTRIP TN
[ ET .
% B 031452023 10AS AW BT Mm | Draw procadem compheted, ineguency (1000, sredes pendng (0L stud
5 e a0 i e A T '“i-fﬁ.i}. | Eirwe presimdhaie chamad
B 0EA1AK00T 1 IS AWM EDT M Craw procethans completed, Treguency ¢ 100 shedes pendng 40, sl

3. Double-click entries to view details.
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Work with the hamburger menu

The hamburger (burger) menu is the main menu of the program. To open it, select the burger menu
button circled in red in the following figure. Some of the options in the figure may not be available
depending on your product and configuration.

WORKLIST

PATIENT ARRIVAL WORKLIST

PATIENT

DISPATCHING DASHBOARD

QUERY/RETRIEVE

SCHEDULE

BILLING

PAYMENTS

REPORTS

g
E
@
@
Q
&
B
B
®
Q

TOOLS

_,
]

SETUP

INTERFACE

KONICA MINOLTA

The burger menu button... ...and menu (your options may vary)
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Work with the worklist

The worklist is the starting point for most operations in Symmetry PACS. The worklist is a searchable and
highly customizable list of patients, studies, and series, providing full access to demographics and
images.

Procedure

1. Go to burger menu E > WORKLIST.

= Worklist

ALL STUDIES

< 0 STATUS STUDY DATE 3 PATIENT MODALITY STUDY DESC

All v

Yy

+ B8 > 2 %xE m @ o * @ 01/18/2023 8:30 PM PST Test, Helen XA ANGRPH A

+ B[ ¢ xE =R S O * @ 01/18/2023 7:15 PM PST Test, Tom CR CHOLANG!

+ 2 [ ¢ xE A Y o * @ 01/18/2023 7:00 PM PST Test, Tom CR ERONCHD
See also:

Worklist settings

Use the worklist

User settings

Viewer settings

PACS Actions menu
Worklist shortcut menus
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Worklist settings

About toolbars and elements in the worklist

The worklist provides the following toolbars and other items. Notice that there is a settings menu ﬂ
button in both the upper and lower toolbar, but they open different menus.

Upper toolbar

The upper toolbar contains the following elements, from left to right.

1 Tasks Shows the number of tasks by urgency. Select to jump to the Tasks list.
2 STAT meter Shows the number of studies at each STAT (urgency) level.

3 TAT meter Shows the number of studies at each TAT (turnaround time).

4 Settings Opens the settings menu.

5 Log off Logs off the current user.

Lower toolbar

1 2 3 45 6 7 8

The lower toolbar contains the following elements.

1 Move tabs left/right Left/right justifies the worklist filter tabs.

2 Filter menu Select from any available filter tab.

3 Refresh Updates the worklist, but keeps manually entered filters.

4 Refresh all Updates the worklist, clearing all filters.

5 PACS Actions Opens the PACS Actions menu.

6 Filters Opens the Study Filters dialog.

7 Search tools Shows/hides the search bar.

8 Disagreements Opens the disagreements queue (requires a separate license for

Advanced Peer Review).
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Filters

= WorkList

PRE ORD

Filter tabs (figure above) appear on the left side of the worklist by their labels. The Exceeds Maximum
Time Limit filter (figure below) appears at the bottom of the worklist.

= o % O + @ ! Scheduled 02/17/20237:55PMPST

Exceeds Maximum Time Limit 162

The following table describes the four types of filter tab (filters) that are available in the worklist.

Optional PRE ORDERS Lists unscheduled orders. Pre orders often have no
) referring physician, and come from the patient portal (such
(Can be hidden) as exams requested by the patient).
QC Lists studies needing reconciliation.
Permanent ALL STUDIES Lists all DICOM studies and scheduled RIS orders that are

not currently on the QC tab.
(Cannot be hidden)

User Filters [user defined] Provide a highly customized view of the worklist.

(Can be hidden)

Temporary Exceeds Maximum | When you select the Exceeds Maximum Time Limit link at
Time Limit the bottom of the worklist, this tab opens and lists relevant
studies. Select the pushpin button on the tab to display a
dialog with options, including "Remove."

Display a filter of the worklist

You can display optional filters (such as PRE ORDERS or QC) in the following two ways. To display user
filters, you can use these steps if the filter was configured to appear as a tab or in the tabs list.

Procedure

1. On the worklist, in the filter bar, select a tab to display the filter.

= WorkList

PRE ORL

2. Inthe lower toolbar, select the Show all Tabs by list H button, and then select a filter.
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Symmetry PACS comes with the PRE ORDERS, QC, and other filters, but you can also create your own
filters to customize the worklist at a high level of precision.

Procedure

1. On the worklist lower toolbar, select the ﬁIterE button.

2. Inthe Study Filter dialog, select ADD.

3. Enter the following criteria. See an example below the table.

Filter Name

Type a name for the filter

Show Encounters Only

Shows only studies for outpatient encounters.

Joined Filters

Selects another filter to combine with the current filter. Studies must
meet the criteria in both filters to appear in the worklist.

Filter Order Determines the order in which filters appear as tabs or list items, from
low to high.
Is Private Restricts availability of the filter to the user who created it.

Display as a Tab

Shows the tab for the filter on the worklist.

Display in Dropdown

Shows the filter in the Show Tabs by list list on the worklist.

Show Only Exceeding Max Time

Shows only studies that are exceeding their max time as specified in
“Configure study statuses.”

Show DICOM Studies Only

Shows only DICOM studies (studies containing images).

Show RIS Orders Only

Shows only RIS orders.

Show Assigned Studies Only

Shows only studies that were assigned to the current user.

Show Pre-Orders Only

Shows only preorders.

Deleted Shows all (deleted and non-deleted) studies, no deleted studies, or
only deleted studies.
Assign Available when you select Is Private. Administrators can use these

settings to assign the filter to specific users or user groups.

Default Column/Sort By

Sorts the worklist by the column and order that you select.

DATE/TIME

Filters studies by a range of dates and times.

PATIENT INFORMATION

Filters studies by patient or account number.
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STUDY INFORMATION

Filters studies by institution, facility, modality, body part, and other
categories.

RESOURCE

Filters studies by physician or attorney.

INSURANCE

Filters studies by insurance provider.

Note: When available, you can use the Is operator and Blank criteria to search for studies that
are missing information. For example, in the INSURANCE category, under Insurance Provider,

select Is, and then select Blank to search for studies with no insurance.

Example

The settings in the figure below define a filter with the following properties:

e Appears as the first available user filter

e IsPrivate (only available to the user who created it)
e Appears as a tab on the worklist

e Appears as a menu option in the list of filters

e Shows only DICOM studies

e Isonly available to users of type Radiologist

e Only displays studies in Unread status.

Study Filter

FiHer Hame * Test |:
Joimed Filters MNONE SELECTED -
Filier Order * 1 Ba Privata

Display as 3 Tab Diplay in Drogdown [._| Shiwer Ondy Exceading Max Time

Shaw DICOM Studios Oaly [ ShowE
Dabuatad

[J Shaw Assigned Studies Oaly

all ¥ Os=

Aasign alncl Une ‘ Radialogiat H ‘

Default ColummSon By w
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Institulion Facility
O s . Angie Facility
Qs GabikaTestFacility
2 1= Mat n ) s Hat Mewra Froility
O} Comsans - Ih.1:|' cl:.‘.mlfm?..- =
L0 ‘Ordering Facility
INFORMATION 2
i AT -
B
s BR
2 15 Mot CH bl
T =, '::," s Hat
Maodality Room
Angee
2= Carmpuier Tama
O IsHat ca Flatus
cT o
O Last Changed By M
Last call cate
oy [ Tech Pause =
CAnCE i = Toch Btart
Follow-ug '::," s Hat =
0 i 37 Transcribed
Oher UnFead
G‘ = Mat Re-achedule st -
Schedule - *

4, Select SAVE.

Edit or delete a worklist filter
You can edit or delete a filter that you created.

Procedure

1. On the worklist lower toolbar, select the filter . button.

Study Filter

Default Tah All Stuedies w
FILTER MAME FILTER TYPE FILTER ORDER =
al w
Al 5tudies Glokal 4]
¢ [ foelete or Edil Me Private 2
&5 il frest Privaie 3

2. Select the edit & or delete (i button of the filter to delete.
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Show or hide a worklist filter

You can show filters as tabs on the worklist, as items in the filter menu, as both, or as neither (you can
hide them for later use without deleting them).

Procedure

1. On the worklist, on the lower toolbar, select the ﬁlter- button.
2. In the Study Filter dialog, double-click the filter to show or hide.

3. Inthe second Study Filter dialog, select or clear the Display as a Tab checkbox and the Display
in Dropdown checkbox.
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User settings

User settings (from the worklist) control how the worklist appears and functions when the user who
configured them signs in. User settings override global settings, except for security settings.

Configure worklist columns

You can show, hide, and order columns in the worklist.

Procedure

1. Go to Worklist > Settings > User Settings.

User Settings

Column Order

B status

B Study Date
Facility

B Patient

B Modality

Study Description

Account No.

2. Do one or more of the following.

e To show or hide a column, select or clear its checkbox.
e To reorder a column, drag the column to a new position in the list.

Note: You can also drag columns directly on the worklist.

3. Select SAVE.

User Set

O show !
Show |
Show (

She
Show €
O Auto-o

Auto-0
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Configure other user settings

You can configure a variety of behaviors and settings for worklist tabs, columns and rows, and other user
settings.

Procedure

1. Go to Worklist > Settings > User Settings.

User Settings

[ Show Row Mumber Double-Click Behavior Web* w
B show Priors Double-Click {Sched ... Edit C »
Show QC =

Detault Tab Al St w

Show Completed in Pending List

Default Filker (Local ... -
Show Orders Tab
[ Auto-Open Mew Order Default Column Study v
Auto-Dpen Appointment Confirmation  Sort By Dess

Audio Player Lag Time daec ¥

Aute Open Prigra Cn b
Open Prior Repaorts on w
Veoice recognition DHota w
Delay Load of Exa Tr... Off
Exa Trans Font W

2. Enter the following settings.

Show Row Number Select to display the row number column in the worklist. The column is
labeled as “#" or “No.”

Show Priors Select to show prior studies on the worklist, or clear to show series and
images instead. Whether you choose to show priors or series, you can

view them by selecting the expand + or collapse ™ button in a study

row.

Show QC Select to show the QC tab, and select the Show Completed in Pending
List checkbox to show include completed orders in the QC tab.

Show Orders Tab Select to show the PRE ORDERS tab in the worklist.

Auto-Open New Order Select to automatically open the Edit Study screen after selecting the

CREATE ORDER button (Symmetry PACS only).

500-000577A 126



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Auto-Open Appointment Select to automatically open the appointment confirmation screen after

Confirmation selecting the CREATE ORDER button (Symmetry PACS only). This screen
provides a convenient summary to read to the patient on the phone, or

to send as an email.

Double-Click Behavior The view or app in which a study appears when double-clicking a row,
unless the study is scheduled.

Double-Click (Scheduled) The view in which a scheduled study appears when you double-click it.
Default Tab The default tab for the worklist.

Default Filter (Local Cache) The default filter for the workilist.

Default Column The default column for the worklist that determines the sort.

Sort By Whether the list is sorted in ascending or descending order.

Audio Player Lag Time The amount of delay before starting audio playback.

Auto Open Priors Turns automatic opening of priors in the viewer on and off.

Open Prior Reports Automatically opens prior reports when opening a study.

Voice recognition When opening a DICOM study in the Symmetry PACS viewer:

Dragon (Exa Trans): Opens Dragon Naturally Speaking for radiologist
transcriptions rather than Exa Dictation. You must install Exa Trans on
the local workstation to use this option.

Dictation (Web Trans): Opens Exa Dictation.

Off (None): Does not open a voice recognition tool.

nVoq (Exa Trans): Opens Exa Trans with nVoq voice recognition.

Delay Load of Exa Trans Delays loading of the Exa Trans transcription screen, to focus attention
on images before the transcription.

Exa Trans Font Sets the font used by Exa Trans.
Exa Trans Font Size Sets the font size used by Exa Trans.
Default Time Increment Sets the default time increment for time blocks in the schedule book.

3. Select SAVE.

Viewer settings
See Configure the viewer.

Local service settings
See Install local cache in the appendix.
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Use the worklist

Find preorders and studies
You can find a study and open it to view or edit details.
Procedure
1. On the Worklist, select PRE ORDERS or ALL STUDIES.
2. Inthe search bar, do one or both of the following:

e In a column header (such as FACILITY), type or select one or more criteria and press Enter.

Worklist
ALL STUDMES
G FACILITY fsreros  sruov
MY COMPANY *
+ 20 2 % h 17 * @ 1 MyCompany Scheduled | 03/17/2
e B O 2k % T % @® ! MyCompany Seheduled 03/17/2
O 22 % : * (0 I My Company Seheduled {03,/17/2

e Select a column header to sort the list.

3. Double-click a study in the list to open it for viewing or editing.

See also:

Search syntax
View approved reports

View series and images
You can view series and images of any study in the worklist that includes them.
Procedure

1. In User Settings, clear the Show Priors checkbox and select SAVE.
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User Settings

O show Row Mumber

[0 show Priors

Show QC

P cheue Pomnletad in Pandina | ot

2. Inthe worklist, find a study containing images and select its expand + button.

5 #* {0 f u 101072008 12534 P EDT  Sarngler, Jabn Sample Femwur (L) &F Study

O AT TR0 1200 AW EST
12352 200026 6107 5002051 2200810101 23946 1032 CH imags Stor

0 Aa% 1900 1200 AM EST

al

O1A0E 1900 12:00 AM EST

b

DL YRI0 1200 &M EST

&

3. Expand series rows by selecting the + button.
4. To view a thumbnail of an image, select the ™ button.
Note: To view an image thumbnail, the status must be Incomplete or Unread.

5. To open series and images in the viewer, double-click the main study.

View priors
You can view the prior studies of any study in the worklist that includes them.

Procedure

1. In User Settings, select the Show Priors checkbox and select SAVE.
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User Settings

O show Fow Number

Shaw Priors

B showac

P chio Paranlotad in Bandina Uit

2. Inthe worklist, find a study and select its expand + button.

o

T P L S T

e

trmilla Test Facdity
termilla Test Facdity
wrmilla Test Facdity
wimilla Test Faciity
Warrnilla Test Faclity
Warmiila Tiest Facdity

Mmilla Tes1 Faciity

fim Fwl BEH

- xD

-EII.'IJE.IEEZEA TASPMPET =

Gheckin 0371772022 1:00 PMPOT

C2/0672023 ¥200 AMFST
OZ/05/ 2033 T.00 PM PST
DULFIEIEI A5 PM PST

O/ 2023 400 BM PET

Hirmilla Test Facality

Emdral, Ensdral

| Priors
Double-click to open

01312023 Z00 P PET e

Result: The priors appear in rows below the study row.

See also:

View roved r rt

Open a pop-up window for physicians and ordering facilities

| R R
001/02/ 2024 715 PM PST

Emdref, Emdre! &

Tesd, Valeie Ft ]
Test, Vialeme cT
Test, Valome A
Test, Valans g
Test, Valkama CR
Test, Valena CR
Test, Vakene CR

From the worklist, you can open a pop-up window to display the contact information of a study's

physician or ordering facility.

Procedure

1. On the Worklist, in the REFERRING PHYSICIAN or ORDERING FACILITY column, select the

doctor & symbol.

4+ W o
= 30 el
B Am E*
20 Fg %
+18 0 L
+ @ *
R - el &

* 0§ WyCompary
* D P WyCompany
RO e
& T P WyComgany
B E My Ty
D i

Wy Coemipearyy

* @ I Wy Compamy

OSTA023 VAP EDT

TR TIHES 625 PM EDT

e | /1702 555 7

Emdred. Ergrefde

emdred, erelref
77302z 545 R
5 2207 US Highway T0 Exst i
ETRA0EE 305 M Fa Mo, thar
ARTTINES 455 PRikdi We Edthar
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Use the study toolbar buttons

Each study on the ALL STUDIES tab or corresponding user filters of the worklist has its own toolbar on the
left side of the study row. Depending on the properties of the study, one or more of the following tools
are available.

+ /™ | Expand/Collapse Expands or collapses the study row to show or hide series or priors.
Prior Select to display a list of prior studies in a custom filter.
Checkbox Select to select the study for further processing by commands in the PACS

Actions menu.

DICOM Viewer Open the study in the Exa PACS viewer. This button is only available for
studies that contain images.

E O=

Opal Viewer Open the study in the Opal viewer (see Install Opal Viewer). This button is
only available for studies that contain images.

Edit Opens the study for editing.

0N O

View Transcription | Opens the dictation and transcription editor. See "Dictation and
transcription."

Multipanel Opens the study in the multipanel, an operating panel for working with
dictation, transcription, documents, notes, and other information.

Approved Report Opens approved reports of the study.

B EBaR H

External app. Opens the current study in an external application if configured.

Unread DICOMs Select to view unread images. In the Unread DICOMs dialog, select MARK
AS READ, or OPEN IN VIEWER to read the images in the Symmetry PACS
viewer.

Notes Opens a screen for entering and viewing notes related to patient, study,

schedule, and reason for study, and for updating the call log. The button
turns blue if study notes are available.

n Study menu Displays the study shortcut menu (you can also Right-click anywhere on
the study row to display the shortcut menu).

See also:

Work with the Symmetry PACS viewer

Edit study screen
Worklist shortcut menus

Configure opening of a third-party program
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About Linked Reporting

With Linked Reporting, radiologists can save time by dictating multiple related studies into a single report.
When the report is approved, all of the linked studies move to the Approved status automatically. When
you open an approved report from any of the linked studies (studies 1, 2, or 3 in the figure below), you
see the same combined report so that all information is available to you regardless of the study or report
you open.

Linking reports also links the studies containing those reports, so that all studies follow the main study in
terms of STAT levels, study statuses, and report approval statuses. For example, if the main report moves
to the Dictated status, so do its linked reports. If you later decide to unlink a report, those statuses revert
to their previous states (with exceptions, see Details on Linked Repotrting).

Main study and Main report:

Linked studies and | Study 2 Study 3
Linked reports: Report 2 Report 3

Once linked, Reports 1, 2, and 3 become one combined report

Note

e You can link reports any time before approval.

e You can unlink reports at any time.

e You cannot link a report that is already approved.

e Ifan addendum is added to a linked report, it applies to all linked studies, and is available for
viewing from any linked study.

What do linked reports look like?

Based on the merge fields you include in your report templates, Exa PACS/RIS automatically fills the
header with information about the main report and its linked reports. (Due to space constraints,
some fields only display information from the main report, such as the referring physician.)

The body of the report contains the radiologist's findings for the main study and all linked studies.

Approved reports always appear based on the transcription template of the main study, even if the
linked studies originally used different transcription templates.

An example of a linked report:
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Accession numbers E E XQ

of linked studies

Patient Name: N Referring Physician: Reicher, Joshua M.D.
Date of Birth: (44 Phone: (650)493-5000
Patient 1D MC1577 Fax: (319)589-5574
Study Date: 07-Feh-2023 2:00 Accession: 5629,5630,5631 l

PM,02/07/2023

¥R Ribs, 2 Views [Left),XR Thoracic Spine, 2 Views,XR Lumbar Spine, 2-3 View

Indications: Left rib pain radiating to mid and lower back. Mo known trauma. \
Study descriptions of
Comparisons: None available at time of repor, linked studies

Technique: Two-view radiographs of the left nbs, thomacic spine and lumbar spine obtained in the AF and
laterad position

Findings:

Left nbs: Multipte radiographic views of the nbs fail to reveal ewdence for displaced fracture, dislocation or
focal soft tissue pathology., Images are less than ideal and if there 15 further concem a bone scan might be
considered.

Thoracic spine; No evdence for acute fracture, dislocation or focal soft issue abnormality, There is difuse
thoracic disc degeneration and spondylosis.

Lumbar spine: There is difuse degenerative disc disease without evdence for fracture or dislocation, There
is lumbar scoliosis,

Impressions:
1. Diffuse thoracic disc degeneration and spondylosis.
2, Diffuse degenerative disc disease with levoscoliosis in the lumbar spine

3. No evidence of a displaced fracture in the left nbs. Recommend a bone scan for follow up.
4. No acute fracture in the lumbar or thoracic spine.

Link reports
To link reports:
Prerequisite: Obtain the Link Report user right from your administrator.

Procedure

1. On the worklist, find a study that is available for linking, and select the gray link “© button.
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_ - Gray: Available for linking

£ 3
e
+ B 0O & & % |a * © i Scheduled 02/23/2023 12:30 AM EST
+ B S xE B %o L O -DZITDr'20231:45AMF'ST
HH;H

~ Blue: Linked, available for unlinking

2. Inthe Link Studies dialog, select the studies whose reports you want to link to the main report.

Link Studies: Test, Michelle (Acc#TesM1006), 20000101, F, 023Y

BRONCHOGRAPY Bl RS&lI
Study Date: 2023/02/01 Accession No: 447 Facility: Mir

Modality: CR Raferring Physician:

Select studies to link or unlink for Reporting:

O select all

ETUDY STATLES MODALITY ETUDYDESCRIFTION STUDYDATE Al
Scheduled KA 30 AMER ISR CT MAI USIOTH REG POSTPCX 20230202 55
I Scheduled s DOF VELOCIMETRY FTL UMBILICAL ART 203202 aa
Scheduled ER BONE AGESTUINES. 20ZHOL0 a2

3. Select SAVE.
Result: The reports and studies are now linked.

See also:

About Linked Reporting
Unlink a report

View approved reports
Details on Linked Reporting

Unlink a report
To unlink a report:
Prerequisite: Obtain the Unlink Report user right from your administrator.

Procedure

1. In the worklist, find a main or linked study (studies with the blue Linked Studies . button), and
select the button.
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Result: Whether you chose a main or linked study, the Link Studies dialog opens with the main
study shown at the top with its linked studies listed below it.

2. Inthe Link Studies dialog, clear the checkboxes of the studies whose reports you want to unlink
from the main report.

3. Select SAVE.

See also:

About Linked Reporting
Link reports
Details on Linked Reporting

Work with Ultra Acquire

If your facility uses Ultra Acquire, you can access its functionality from the worklist. Three buttons are
available as described below.

NEW STUDY

Worklist buttons available when Ultra Acquire is enabled

Open Ultra Acquire
To simply open Ultra Acquire, select LAUNCH ACQUIRE.

Add images by using Ultra Acquire
You can add images to a study on the worklist by using Ultra Acquire.

1. On the worklist, select one incomplete study (a study in status: Scheduled, Confirmed, Arrived,
Checked In, Tech Start, Tech End, Incomplete, or Unread).

2. Select ADD IMAGE.
Result: Ultra Acquire opens in Acquire mode.

3. In Ultra Acquire, acquire the images you want to add.

Create a new study by using Ultra Acquire

You can create a new study by using Ultra Acquire as follows.

1. On the worklist, select NEW STUDY.

2. In the Select facility dialog, select your facility and select SUBMIT.

Result: The New Appointment screen appears.
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¢ New Appointment

Tom Test

SEARCH

Patient Search

Starts With ~ Al + B Showlnactive [ Break the Glass

551 MHame

o [ & ouessaus

PATIENT SEARCH RESULTS

3. In the Starts With dropdown list, select a search mode in the dropdown list (Starts With, Ends
With, or Contains).

4. Type all or part of a patient demographic in one or more of the boxes.

Optional: If the Break the Glass checkbox appears, you can select it to search for confidential
patient records.

5. 1In the list of search results, double-click the patient for whom you want to schedule an exam.

Starts With | All « B8 Showlnactive [J Breakt

test | First Marme

A CREATE & SCHEDULE CLEAR SEARCH

PATIENT SEAHRCH RESULTS

Test,\alerie - FIX_TesV1001, Tes\V'1001
DOB: 01/31,2000
P—

L_Test]Tom - TesT1028

DOB: 01/0172000

6. Ifthe Recent Schedule dialog appears, select NEW SCHEDULE.
7. Inthe APPT. INFO. tab:

a. Select a modality and appointment type.
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Appointment Information

Lecation Mirmilla Test Facility b
Modality * cT w

Appointment Type = Select Appointment Type b
Available Date 03/06/2023 7:05 AM PST v
Resource

Referring Physician Mo Reterring Physician Sele a O
Stat Level Stat Off ~

Department

Institution

b. Enter any other information as needed.

c. Select ADD STUDY.

13
03/06/2023 07:05 AM - 07:20 AM US/Pacific  CT Walk-in =
74177 CT ABD & PELVIS W/CONTRAST 1
&1 @15 -‘

8. Repeat to add more appointments as needed.
9. Select CREATE ORDER.

Result: The following dialog appears.

2 Study Created

Do you want to launch
Acquire?

Close

Reading Physician

Body Part

Orientation

Accession Mo

Study Motes

Reason

10. Optional: Select Close to save the order and return to the worklist.

11. Select Yes to open Ultra Acquire in Acquire mode.

P ¥

L) sy 3 i " Y
Saarch Read. Physlelan

Select w

Select W

Select Macro Mote | *
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12. Acquire images for the new study.

Result: Your new study appears on the worklist.

Update the worklist or viewer

After performing tasks that modify studies it may be necessary to update the worklist or viewer to show
changes.

e To update the worklist or viewer, select F5.

About color highlighting on the worklist
When the globe < button for studies on the worklist is highlighted, this indicates the caching status as
follows.

Caching completed

Caching in progress

-l Some images could not be cached

About drawing attention to orders and studies

There are several methods to draw attention to orders and studies that are of special consideration. You
can use different individual or combined methods to best meet your needs. The following gives a general
description of the available options.

STAT level The medical urgency. Setting a STAT level places the study at the top of the worklist.
You can edit STAT levels and descriptions, and add new ones. STAT levels drive
workflows.

TAT The turnaround time. Studies that are near or beyond the TAT are flagged in red and
appear at the top of a radiologist’s unread studies worklist.

Priority By default you can set the priority to High, Medium, and Low, but you can edit these
and add more options. Priority is primarily used to sort the worklist (on the Priority
column).

Critical findings Medical findings that you can customize. In Exa Trans, you can select critical findings
in a list to send notification to the referring physician.

Flag With flags you can mark a study with a customized description that can serve as a
filter. You can only assign one flag per study.
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See also:

Change the urgency of a study
Change the priority of a study
Assign critical findings to a study
Flag a study

Use local caching

Prerequisite: Install local cache.

Perform a server prefetch

You can manually initiate a server prefetch from the worklist, whereby the server decompresses a
study and copies it to a “local” cache on the server. If large studies will be opened in the near future,
you can perform a server prefetch of those studies for faster loading.

1. On a worklist study shortcut menu, select Images > Server Prefetch.

+age =2 e B MW . w0 ! MyCompany
B - B Edit Study F
+ = B Rl oo Wy Company
= ! B
* 2 I e i Himmilla Test Facility

+ B 3 m 23 = pean i Mirmilla Test Faciling
+ B8 o @ & Aclions 1 Mirwills Tead Fasilite
| B images B Serves Prefeteh
- = == [l e — _
4 DCOM Send 3 Feset Stach

Prefetch studies to your local cache
You can manually prefetch studies “on demand.”
1. On a worklist study shortcut menu, select Images > Add to My Local Cache.

Result: The server queues the images for sending.

Prefetch studies to other local caches
1. On the worklist, select the ALL STUDIES tab.
2. On a worklist study shortcut menu, select Images > Send to Local Cache.

3. In the Local Cache screen, in the list of available caches, select to the left of one or more
destination caches.

4. Do one of the following.

e To send to the selected caches, select LOCAL CACHE SELECTED.
e To send to all caches, select LOCAL CACHE ALL.
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Auto-route studies to local cache

You can create a routing rule to send studies that satisfy criteria to your local cache. Complete the
following procedures:

e Configure an application entity for your local cache.
e Configure a routing rule for type LOCAL_CACHE, and select the AE title you created.

Use an on call worklist filter to locally cache studies

You can configure a worklist filter that sends matching studies to local cache.

1.

2
3.
4

Create a user worklist filter.

In User Settings, in the Default Filter (Local Cache) dropdown list, select the worklist filter.
Select SAVE.

On your computer, in a text editor, open the localCache.cfqg file, located at the following path by
default:

C:\Viztek\exa\cfg\localCache.cfg

Find the line for “oncall_enabled” and set it as follows:

“oncal | _enabl ed”: "true",

Save and close the file.
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PACS Actions menu

The PACS Actions menu on the worklist provides top-level access to common functions.

Burn studies, series, or images to a CD or hard drive

You can burn studies to a CD or hard drive for sharing with other facilities, physicians, or patients. To burn
images and series, see later in this topic.

Prerequisite: Install Opal toals.

Burn studies

1. Place a CD in the drive.

2. Inthe worklist, select studies whose combined size does not exceed the capacity of the disc.

3. On the PACS Actions menu, select CD Burn.

Opal CD Burning - A
~Opal CD Buming

) | miame | pEscatPTION | paTE
62555 B, 5uv PI SKLULL TO THIGH W{CT W |
€ »
¥ Indusde Viewer I WWrite to Disk Only Path [
[ Cathe Images [T Create Arnotatiors Oveslay

Compression [ PEG 2000 Lossless |
[ Ancnimize DICOMS [T Remove Anmatations
I~ Fix Spit BTO ™ Force S0P Cass 1D for all files Repart |Dﬂnﬁhﬂ :j

¥ML Leaded, Chck Start to Intiate Burn Process
Current Shep Frogress
Total Progress
START | Cancel |

4. In the Opal CD Burning dialog, enter the following settings as needed.

Include Viewer

Burns a viewer program onto the CD along with the studies. Required
for viewing off site.

Write to Disk Only

Writes the study to the hard drive instead of a CD. Browse for and
select a destination folder under Path.
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Create Annotations Overlay _Converts annotations to an overlay and includes them with the
images.

Compression Specifies a compression algorithm.

Anonymize DICOMS Removes identifying patient demographics.

Remove Annotations Omits annotations from the burned studies.

Report Specifies a report storing method.

5. Select START.

6. After burning, test the results by opening an image from the CD using the included viewer.

Burnimages and series
Use this procedure to burn individual images and/or series.

1. In User Settings, clear the Show Priors checkbox.

User Settings

O show Row Number

E [0 show Priors

Show OC
F cheuw Mamnletad in Dandina | iz
2. On the worklist, find images or series to burn by expanding the study row nodes and image
preview buttons.

1010/ 2008 1224 P EDT  Sarngler, Jabn Sample Femwr (L) &F Study

O A5 TR0 12400 Akl EST

12352 700024 6107 5002051 2200210101 23946 1032 CH Irmage Stoe
3 DfQ%/ 1930 1200 AM EST
4 OO0/ 1900 12:00 AM EST

010N/ 1800 1200 &M EST

3. Select the checkboxes of the images and series.

4. On the PACS Actions menu, select CD Burn.
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Compare studies

You can open two studies of the same patient in separate viewer screens for purposes of comparison.
Prerequisite: Configure two or more monitors (see Set up connected displays).

Procedure

1. In Viewer Settings, clear the Single Instance Mode checkbox.

Viewer Settings

Other Toolbar

GENERAL

u Ask on Close

INTERFACE P
O Simgle Inatance Mode

MO ALITY [ Skip Frames in Cine to Malntain Flayback Speed

2. Inthe worklist, select two DICOM studies of the same patient to compare.

EIE- RN B W UWr @ Minmilla Test Facility
+ # {0 i Nirmilla Test Facitity
+ o O § Nirnllla Teat Faciling
+ w @ [ wimnills Test Facilitg
+ 00 =S wE m % *« 0 I Mimmilla Test Facifity

3. On the PACS Actions menu, select Compare Study.

Result: The two studies open in the Exa PACS/RIS viewer.

Merge or split studies

In Symmetry PACS, merge and split refer to a category of operations in which you move series and
images from one study to another. Additionally, split refers to moving images from a study with an
incorrect accession number to the correct order. There are many ways to perform merge/split
operations, but the following procedures are useful examples. Moving all series and images out of a study
deletes the study. As an alternative to merging studies, see Use alternate account numbers.

Move or copy a series from one study to another study

1. In the worklist, select two different studies that contain series.
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6.

L S Rl B R T w1 Ninmillle Tesi Facility

-+ EEB & o o B om &Y O D i Hiirmiilla Test Facifity

+ A0 =L %E B % O w0 i Nirnilla Teat Facility

H - & (0 ! Nimnilla Test Facility

On the PACS Actions menu, select Merge/Split.

Select the button to choose Move Selected or Copy Selected mode.

Merge/Split Study

-

in the Merge/Split From column, select the plus sign of the first study (the one on top) to reveal
its series.

Copy Selected Move Selected

Merge/Split Study

Drag the series onto the second study (the one on the lower-right) in the Merge/Split To
column.

Hame: Test, Tom{bccd: TesTI0Z Accessicn Mo 117 =
= Sudy ANGRPH ADRML BI SLCTV Referring Physician: Test, Referri g
Mo, of Seden: 1 No. of Instances: 1

Desciption: ID Card F.-!r.riaﬁl'.u'

+ ﬂ.i - : 5 gisy  Descrption: ID Card Madality
E Rl A . T |
b Ne. of Ingaes Sy ¢+ gr Mo. of Instances: Serien DT: 00719/20

Mame: Tast, Tndl:.imﬂ! TesT1004 Accession Mo, 120 ﬁ
4+  Study: DOP ECHO FTL SPECTRAL Refurring Physician: Test, Refermi &
Ha. of Sedes 1 He. of Instances: 1

Note: As you drag over the second study, it turns green to indicate when you can release the
mouse button.

Select SAVE CHANGES.

Move or copy all images in one series to a series in another study

1.

In the Merge/Split To column, select the plus sign of a study to reveal its series.

2. Drag a series in the left column onto a series in the right column.

3. Select SAVE CHANGES.

Other moves or copies

In the same manner, you can expand nodes and move or copy any study, series, or image to another

study or series.
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Splitimages into their correct order

1. In the Merge/Split Study screen, select SELECT ORDER.

Merge/Split Study

Move Salected
Merge/Split From Merge/Split To
I Mame: Test, Tom(Acc#: TesT10Z Accession Mo 117 = II Mame: Test, Tom{Acc#: TesT102

2. Find the correct RIS order, and then select its SELECT button.

Merge/Split Study

RIS Orders

STUDY DATE

PATIENT MAME STUDY DESCRIPTI ACCESSION NQ.  ACCOUNT N{

03/ 1772023 4:00 FPTest, Valerie 01/07/2000 CT ABD & PELVIS V1371 Tes\1001
§3/17/2023 5:10 PTest, Andrew 071/07/2000 DOF VELOCIMETR 1370 TesAB3

m 0:3/17/2023 5:00 PTest, Andrew 01707/ 2000 BOME AGE STUMME 1369 TesAB3

3. Drag the images to the correct order, and then select SAVE CHANGES.

Add a new series to a study

1. Inthe Merge/Split To column, select the new series = putton.
Note: The new series is added to the bottom of the list.

2. On the new series row, select the edit £ button.

3. In the Edit Study Info. dialog, type a description and then select the EDIT button.
Note: You can move series or images into the new series.

4. Select SAVE CHANGES.

Clone a study

1. Inthe Merge/Split From column, select the Clone Study 3 button.
Note: You can move series or images into or out of the new study.

2. Select SAVE CHANGES.
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See also:

Add studies to the merge queue
About the PID, MRN, and account numbers

Import DICOM images

You can import DICOM images to a study.

Prerequisite: Install Opal tools.

Procedure
1. In the worklist, select a study into which to import images.
2. On the PACS Actions menu, select Import Images.
3. Inthe pop-up window, select Open Opal Import.
4. In OpalImport, select Select Files/Folder or DICOMDIR to Import.
F 4 Open
| 245,186 Bull: X B 2021 1936133 Look p: [ | iwages z e«®mctE-
*
Sebect s Fricker o SOCOMDE tn Impet e
=
Dhzkton
03 s hiot Comprass (4] Overvite (7 Enaba Data Bt Serpt | = Decomgng
Ocpdoeody [ sovebefors Bonde |
[Jisclmsz Pads [ Hody Demograches e d
MaxFle [ Import Metod [Opal xfer = =
Musze [ Thas P
O stryker Production Mode: W’
[ stryker of DATA Mods Ntk
0 Stryvker 21P fechnee Mode
[ strykr Image Sues
O scmagsMode :
O Fuj syracsis Mode OpenFie List || Sawe Fle Ust .
| 0 Fhan Foiders Sebacied For Imgurt bemrane | [ seket
5. Inthe Open dialog, browse for and select files to import, and then select Open.
6. In OpalImport, configure the settings in the following table.

Note: This is a partial list. Other settings are self-explanatory or generally unused.

Do Not Compress

Select to store in DICOM Little Endian format.
Clear to compress in DICOM JPEG200 Lossless format.

Overwrite

Select to replace any existing instances of the studies.

Opal DB Only

Select to import DICOM data only (no images).

Save before Encode

For troubleshooting purposes: Select to place the images in a folder

on the server, and not update the database.
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Isolate Fails Select to place files that could not be imported into a separate folder.
Modify Demographics Select to reconcile demographics before import.

Max Files Type a maximum number of files to import.

Max Size Type a maximum data size to import.

7. Select Import.

8. Optional. If you selected the Modify Demographics checkbox, the Modify/Confirm Demographics
dialog appears. Do one of the following.

e Under New Info, edit the demographics and then select MODIFY.
e Under New Info, confirm that the demographics are correct, and then select USE CURRENT.

9. Select Exit.

Purge all deleted
See Undelete or purge a deleted study.

Export the worklist
You can export the worklist to a CSV file.
Procedure

1. On the PACS Actions menu, select Export Worklist.

Export Worklist X

File Name

Worklist

Include Timestamp

Include Filter Mame e

2. In the Export Worklist dialog:

e Optional: In the Filename box, edit the default file name.
e Modify the name of the exported file by selecting or clearing the Include Timestamp and
Include Filter Name checkboxes.
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Worklist shortcut menus

Symmetry PACS and Symmetry PACS have a study shortcut menu (for studies in the Unread and later
statuses). Additionally, Symmetry PACS has an order shortcut menu (for PRE ORDERS and studies in the
Ordered status). The tasks you can perform by using each shortcut menu are described in the topics in
this section. Note that the commands available on the shortcut menus vary depending on the order or
study status and other factors.

YA

Any errors in patient and study information resulting from incorrectly performing the procedures in this
section can result in problems with data integrity. Take care to ensure that entered and imported data is
correct.

Open a shortcut menu

You can open a shortcut menu by right-clicking its parent item, such as a study or order row.

Require document review

When creating a scan document (or "document") type, you can require that users review the document
before moving forward in the study workflow. For example, you can require technologists to review
physician orders prior to performing an exam to ensure order accuracy.

Procedure

1. Add a scan document type (see App settings).

2. Select your document type, and then select the Requires Review checkbox.
3. Add a study status.
4

Edit the study status, select the Document Review checkbox, and then select the document
types to review.

View or attach documents to an order
You can view attached documents, or scan documents to an order.
Procedure

1. On the worklist, select the PRE ORDERS tab.

2. On the order shortcut menu, select Attach Files.

3. In the Patient Document dialog:

e To view a document, double-click it in the list.
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e To attach a document, follow the steps in the following topics.
See also:

Scan to a patient
Scan to an order or study

Modify or reset the order authorization days

This command lets you quickly change the number of days specified in the authorization rule associated
with an exam. You can reset the days to the number of days set in the rule, or modify the days to an
arbitrary number.

Procedure
1. On the worklist, select the PRE ORDERS tab.

2. On the order shortcut menu, hover over Actions, and then select Reset Authorization Days, or
Modify Authorization Days.

3. Optional. In the Days Count dropdown list, select a new number of days.
4, Select SAVE.
See also:

Add authorization rules

Assign a study to users

You can assign one study to one or more users (such as a radiologist). When the user signs in, they can
create a filter of the worklist that displays all studies assigned to them. This feature also works in
conjunction with the “Show assigned studies only” option under Setup > User Management > [user
profile] > WORKLIST FILTER.

Procedure
1. On the worklist, select the ALL STUDIES tab.
2. On a study shortcut menu, hover over Exam, and then select Assign Study.

3. Inthe Study Assignment dialog, in the Assign to User dropdown list, select a user from the list
and then select the add button.

Note: You can repeat this step to assign additional users.

4, Optional. In the Assign to Radiologist dropdown list, select a radiologist as the referring
provider.

5. Select SAVE.
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Add studies to the merge queue

You can add studies to a merge queue from the worklist, and then merge or split them by following the
procedures in Merge or split studies.

Procedure
1. In the worklist, select the ALL STUDIES tab.

2. Optional. To start merging or splitting with one study at a time, on a study shortcut menu, hover
over Exam, select Merge/Split, and then skip to the last step.

3. Right-click the first study, hover over Exam, hover over Merge Queue, and then select Add to
Merge Queue.

4. Repeat the previous step for all studies that you want to work with.

5. Right-click one of the studies that you added to the merge queue, hover over Exam, hover over
Merge Queue, and then select View Merge Queue.

6. Perform merge and split operations.

Create a teaching study
You can create a teaching study based on an existing DICOM study. The teaching study is anonymized.
Procedure

1. In the worklist, find a DICOM study.

2. On the study shortcut menu, hover over Images, and then select Create Teaching Study.
3. Inthe Teaching Study dialog, in the AE Title dropdown list, select an AE title.
4

In the New Value column, type or select anonymous values for the new study, and then select
CREATE TEACHING STUDY.

Reset a study
If the status of a study is beyond “Scheduled” in the study flow, you can reset the status to “Scheduled”
Procedure

1. In the worklist, select the ALL STUDIES tab.

2. On a study shortcut menu, hover over Exam, and then select Reset Study.

3. In the confirmation dialog, select YES.
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Delete a study

When you delete a study it remains on the worklist but Symmetry PACS applies strikethrough text
formatting to it and disables access. You can undelete or purge a deleted study.

Procedure

1. In the worklist, select the ALL STUDIES tab.

2. On a study shortcut menu, hover over Exam, and then select Delete Study.
3. In the confirmation dialog, select YES.
4

In the Delete Reason dialog, select a reason and then select SAVE.

Download approved reports

If an approved report is attached to a study, you can download the approved reports directly from the
worklist.

Procedure
1. On the worklist, select the ALL STUDIES tab.

2. On a study shortcut menu, hover over Send Report > Download, and then select the format of
the report.

Result: Symmetry PACS downloads the report to your Windows Downloads folder.

Assign critical findings to a study
You can assign critical findings to a study (for example, “Acute Positive”).
Prerequisite: Configure critical findings. See Reason codes).
Procedure
1. On the worklist, select the ALL STUDIES tab.

2. On the study shortcut menu, hover over Actions, hover over Critical Findings, and then select a
finding.

Undelete or purge a deleted study

Undeleting a study removes the strikethrough text formatting and restores availability. Purging a study
permanently removes it from the worklist and the database.

Procedure

1. On the worklist, select the ALL STUDIES tab.
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2. To undelete a deleted study, on the study shortcut menu, select Restore Study.

3. To purge a deleted study, on the study shortcut menu, select Purge (Permanently), and then
select OK.

4. To purge all deleted studies at once, on the PACS Actions menu, select Purge All Deleted.

Flag a study

On the worklist, you can add one or more flags to a study for special consideration, such as a case study.
Users can filter the worklist by individual flags. To configure the flags that are available, see Create a

study flag.

Procedure
1. On the worklist, select the ALL STUDIES tab.

2. On a study shortcut menu, hover over Actions, hover over Flag, and then select a flag.

Copy the API URL
If you need the API URL, you can copy it from the worklist.
Procedure
1. On the worklist, select the ALL STUDIES tab.
2. On a study shortcut menu, hover over Actions, and then select Copy API URL.

3. A message box appears with the API URL.

Reset a stack

To reset a stack means to restore its images to their last-saved ordering. It can also be helpful to reset
the stack if any problems occur when displaying it in the viewer.

Procedure
1. On the worklist, select the ALL STUDIES tab.

2. On the shortcut menu of a study that contains images, hover over Images and then select Reset
Stack.

3. Inthe confirmation dialog, select YES.
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Lock and unlock a study

You can lock a study to warn other users attempting to open it, and to prevent other users from using
transcription. You can unlock a study that someone previously locked.

Procedure
1. On the worklist, select the ALL STUDIES tab.
2. To lock a study, on the study shortcut menu, hover over Exam > Lock Study.

3. To unlock a locked study, on the study shortcut menu, hover over Exam > Unlock Study.

Edit a patient, study, or order

To edit a patient, study, or order you can access the Edit Study screen from the worklist by selecting the
Edit Study, Edit Order, or Patient Information commands on the shortcut menu.

See also:

Edit study screen

View patient information

Use the Patient Information worklist shortcut command as a fast way to open the Patient Information
tab of the Edit Study screen.

Change the priority of a study

You can assign or change the priority (for example, High, Low, or Lowest) of a study in the worklist.
Prerequisite: Configure priorities. In "Configure your company," see Settings.
Procedure

1. On the worklist, select the ALL STUDIES tab.

2. On the study shortcut menu, hover over Priority, and then select a priority.

Change the study status
You can assign or change the status (such as Approved or Transcribed) of a study in the worklist.
Procedure

1. On the worklist, select the ALL STUDIES tab.

2. On the study shortcut menu, hover over Change Status, and then select a status.
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Change the urgency (Stat level) of a study
You can assign or change the urgency (Stat 1-5, or Off) of a study in the worklist.
Procedure

1. On the worklist, select the ALL STUDIES tab.

2. On the study shortcut menu, hover over Stat, and then select a stat level.

DICOM-send studies, series, or images

You can DICOM-send studies, series, or images to PACS or another destination. You can include any
approved reports in the study, but note that the report status (such as Approved or Transcribed) is not
sent. To send an approved report with its status, send as XML via Opal.

Prerequisite: Configure send destinations (see Configure application entities).

Send studies
1. On the worklist, select one or more studies.
2. On the shortcut menu of one of the selected studies, select DICOM Send.

3. Inthe Send Study dialog, to filter the list of available AEs, type at least one character in the filter
box and then select Enter.

4. In the Priority dropdown list, select a priority.
5. Do one of the following.

e Select destinations in the list, and then select SEND TO SELECTED.
Optional: To send any attached approved reports, select the Include Approved Report
checkbox.

6. Optional. To manage in-process send jobs, see Manage jobs in the transfer and SR queues.
Send series or images

1. In User Settings, clear the Show Priors checkbox.

2. On the worklist, find images or series to send by expanding the study row nodes and image
preview buttons.
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Select the checkboxes of the images or series to send.

Right-click and select DICOM Send.

In the Send Study dialog, in the Priority dropdown list, select a priority.
Select the send destinations in the list, and then select SEND TO SELECTED.

Optional: To send any attached approved reports, select the Include Approved Report
checkbox.

Optional. To manage in-process send jobs, see Manage jobs in the transfer and SR queues.

Send an approved report via Opal

You can send approved reports of DICOM studies to another Opal/Exa system.

Prerequisite: Ensure that the referring physician is configured on the sending server (your Symmetry
PACS server) and receiving server. You may need to contact the receiving facility to confirm.

Procedure
1. On the worklist, select the ALL STUDIES tab.
2. On the shortcut menu of a DICOM study, hover over Send Report > Send Report via Opal.
3. Inthe Send Report via Opal dialog, to filter the list of available AEs, type at least one character
in the filter box and then select Enter.
4. In the Priority dropdown list, select a priority.
5. Select send destinations in the list.
6. Select SEND TO SELECTED, or SEND TO ALL.
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Send an approved report via fax or emalil

You can send approved reports of DICOM studies via fax or email.

Procedure

1. On the worklist, select the ALL STUDIES tab.

2. Select one or more DICOM studies containing reports you want to send.

3. On the shortcut menu of one of the selected studies, hover over Send Report and then:
e To fax to the default recipient, select it. The report is sent to the fax queue.
e To send to selected recipients, select Fax/Email.

4. In the Send Report dialog, select the recipient types and individual recipient, and then select the
SEND FAX and/or SEND EMAIL button.

5. Optional. Repeat the previous step to send to additional recipients.

View and export audit log entries

You can view audit log entries, and export them to an XLS file.

Procedure

1.

2.

In the worklist, on the study or order shortcut menu, select Log.

In the Activity Log screen, select a date range for the log entries to view, and then select
RELOAD.

If any entries match the date range, they appear in the list.
Optional. To export an entry from the list, select it and then select EXPORT TO EXCEL.

To view information in a log, double-click the log entry in the list.

View documents attached to a study

You can view documents that are attached to a patient record.

Procedure

1.
2.
3.

In the worklist, select the ALL STUDIES tab.
On the study shortcut menu, select Attach Files.
Optional. To find a document, do one of the following.

e To show all available documents, select the Show All Documents checkbox.

e Use the search bar to find a document by type, source, or other criteria, and then select
RELOAD.

e To view a document in the list, double-click it.
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About linking patients

Linking patients means to merge patients to the master patient record by using alternate account
numbers. You can link patients from the worklist "on the fly" by following the procedure in Link patients,
or from the patient chart by following the procedures in Use alternate account numbers. Generally, you
can use linking to merge patients, and use merging to move studies, series, and images between
patients.

See also:

Use alternate account numbers
Merge or split studies

Link patients

If a patient has multiple records, each with different account numbers (or MRNs or PIDs), you can link
them from the worklist.

YA

Linking an external patient record to an internal one results in deleting the external record.
Prerequisite: Configure alternate account number functionality.
Procedure

1. On the worklist, on the shortcut menu of a study whose patient you want to link, select Link
Patient.

2. Inthe Link Patient dialog, in the Alt Account No search box, type the exact account number to
link to the current account number, and then select Enter.

3. Inthe Issuer dropdown list, select the issuer of the PID, and then select ADD.

Note: If the account number was found (it already exists in Symmetry PACS), a message
appears. Type a different number or select a different issuer.

4. Select SAVE.

See also:

About linking patients
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About attaching documents to patients, orders, and studies

The following is a list of topics in this manual that describe how to attach information to patients, orders,
and studies.

e Upload a DICOM file to a study - Attach existing DICOM files to a study.

e Scan to a patient - Scan paper or forms to a DICOM file and attach to the Documents section of the
patient chart.

e Scan to an order or study - Scan paper or forms to a DICOM file and attach to all studies in an order
or a selected study.

Upload a DICOM file to a study
You can upload DICOM-compatible files and add them to a study.

Procedure

1. In the worklist, on the shortcut menu of a DICOM study, hover over DICOM Upload and then
select Upload File.

2. Inthe DICOM Upload dialog, do the following.
a. Select a series description.
b. Select SELECT FILES, browse for and select a file to upload, and then select Open.

c. Select UPLOAD.

Open the call log

You can use the call log to save a record of communication to and from a patient regarding an
appointment or order.

e In the worklist, on the shortcut menu of a DICOM study, select Call Log. The Notes tab of the
patient chart opens. See Update the patient call log.

Scan to a patient

You can scan paper documents and forms, and attach them to the patient chart. Symmetry PACS
converts the scans to a DICOM-compatible format.

Prerequisite: Connect a TWAIN-compliant scanner, and Install Exa Scans.
Procedure
1. In the worklist, on the study shortcut menu of an unread study, select Attach Files.

2. In the Patient Documents screen, select a document type.
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3. Place a document in the scanner, and do one of the following.

e To scan to DICOM format, select the DICOM SCAN arrow H button, and in the shortcut
menu, select SCAN TO STUDY (scan, and save to the current study) or SCAN TO ORDER
(scan, and save to the current order).

e To scan without scanning options, select the QUICK SCAN arrow H button, and in the
shortcut menu, select QUICK SCAN TO PATIENT.

e To scan with scanning options, select the QUICK SCAN arrow H button, and in the shortcut
menu, select FULL SCAN TO PATIENT.

e To upload the scan to the patient chart, select UPLOAD, and then in the second Patient
Document dialog, do the following.
o Enter metadata for the document.
o Select SELECT FILES, browse for and select a file, and then select Open.

4, Select SAVE.

Scan to an order or study

You can scan an image to a DICOM file and attach the file to one or all studies in an order. On the
worklist, on a study shortcut menu, do one of the following.

e To scan to the study, hover over DICOM Upload and then select Scan to Study.

e To scan to all studies in the order, hover over DICOM Upload and then select Scan to Order.

Edit Study screen

In the Edit Study screen you can view and edit most information about an order or study.

Open the Edit Study screen

To open the Edit Study screen, follow the procedure below.

?Ea Caution: When working in the Edit Study screen, ensure that you enter all information
PR

' correctly and with correct spelling. Incorrect information can result in failure to find patient
records in future operations.

Procedure

e On a Worklist study row, click Edit < .

(]

+ 80 CE ®EB %S T «@ i [Aspoved 03/01/2023 2:45PM PST

Result

The Edit Study screen opens to the EXAM INFORMATION screen, with the most recent study sub-
tab selected.
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See also:

Screens in the Edit Study screen

View patient alerts

You can quickly check whether the patient of a study has any alerts that might affect billing, scheduling,
exam preparation, or other factors.

Procedure

1. Go to Worklist > Edit Study screen, and then select the alert button.

ﬂ.s Test, Brad (Acc#:TesB1113), 01/01/20

SLIMMNAHY

EXAM INFORMATIOM ey
The number of alerts appears in red

Result

The Patient Alerts dialog box appears.
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2. Optional: Enter notes and click SAVE.

View a summary of an order
You can view a summary of an order and its studies.
Procedure

1. Go to Worklist > Edit Study screen, and then click SUMMARY.

£\* Test, Brad (Acc#TesB1113), 01/01/2000 , M, 23V

Order Information
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Result

The order summary appears in the right pane.

Edit order information
An order defines information for one or more studies. You can edit properties of an order.
Procedure

1. Go to Worklist > Edit Study screen > EXAM INFORMATION, and then select the ORDER sub-
tab.
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Result: The Edit Order screen appears.

2. Near the top of the screen, select the ORDER sub-tab and make changes to the following

settings.

Facility The facilities performing the studies (to change, reschedule).

Modality The modalities used for the studies (to change, reschedule).

Resource The resources used for the studies (to change, reschedule).

Ordering Facility Available with Mobile RAD only. Select the ordering facility or location of
the studies. If the patient resides at the ordering facility location, select Set
as Home Address.

Patient Location Select the current location of the patient.

Patient Room No. Type the room number of the patient location.

Patient Condition Select a patient condition to consider for studies (such as "wheelchair").

Source Select the source of the patient (such as referral or previous medical
facility).

Place of Service Select the place of service for billing purposes (Box24B).

Supervising Physician Select the supervising physician (Medicare requires a supervising physician
to be present in the department or location during the exam).

Functional Status Select the patient's functional status.
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Cognitive Status

Select the patient's cognitive status.

Transition of Care in

[Unused]

Patient Visit No.

The enterprise-specific serial number for the study.

SDE Study

Select the checkbox if the order contains an echo ultrasound-related
study.

Schedule Notes

Type or select schedule notes (such as messages from the front desk).

Justification of Mobile Service

Type the justification of mobile service for reference by the physician.

Technologist

Select the technologist performing the studies.

Discharge Instructions

Type any discharge instructions.

Physician Order Status

Status from the Referring Provider portal.

PRINT ORDER

To print a summary of the order information, select one or more of the
following options, and then select PRINT ORDER.

Include Disclaimer/ Signature
Area

Includes a pre-configured disclaimer to be signed by the patient.

Include Notes

Includes schedule and study notes on the printed order.

Include Barcode Page

Prints a barcode on the order.

symmeltry-PACs

3. If DICOM settings are not available to edit, at the bottom of the screen, select DICOM STUDY,
and then make changes to DICOM settings as needed.

4. To edit or add CPT codes, at the bottom of the screen, select the edit & or add button,
enter changes, and then select SAVE.

5. Select SAVE.

Edit study information

You can edit properties of an ordered study, including DICOM settings and CPT codes.

Procedure
1. Go to Worklist > Edit Study screen > EXAM INFORMATION, and then select a study sub-tab.
2. Make changes to the following settings.

Order No. The order number to which the study belongs (to change, reschedule).

Accession No. The accession number of the study (users with rights can edit here).

Study UID The study UID as determined by the selected appointment type.
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Date The date of the study (to change, reschedule).

Study Status The current status of the study in the Symmetry PACS study flow.

Body Part Select the relevant body part for the study (for example, hand).

Orientation Select which side of the body (for example, right).

Appointment Type Select the study's appointment type (the type of exam for scheduling purposes).

Code The internal procedure code of the study (associated with the appointment type).

Modality Room The modality room where the study is performed (to change, reschedule).

Reason Type the patient-specific reason for performing the study.

Study Notes Type or select study notes (such as basic study history or notes from technologist to
radiologist).

Diagnosis Codes Select diagnosis (e.g. ICD10) codes for the study.

Referring Physician Select the physician who referred the patient for the study.

Ordering Physician Select the physician who ordered the study.
If left blank, Symmetry PACS automatically enters the referring physician.

Reading Physician Select the radiologist or other physician who will read the study.

Attorney Select the attorney for the patient. This attorney is given access to the study through
Attorney Portal.

Department Type the department of the facility performing the study.

Institution Type the institution of the facility performing the study.

Station Type an identifier for the station of the location performing the study.

3. If DICOM settings are not available to edit, at the bottom of the screen, select DICOM STUDY,
and then make changes to DICOM settings as needed.

4. To edit or add CPT codes, at the bottom of the screen, select the edit & or add button,
enter changes, and then select SAVE.

5. Select SAVE.

Edit basic patient demographics
The Edit Study screen gives you convenient access to some patient demographics in the patient chart.
Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION.
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2. Make changes, and then select SAVE.

See also:

Create and modify a patient chart

Add or edit a patient’s portal account

You can edit a patient’s portal credentials and other account information.

Procedure

1. Go to Worklist > Edit Study screen > PATIENT INFORMATION > PORTAL ACCOUNT.

Create Porial Account

Patient Account m Representative Account + [
Maires Talat w
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500-000577A 165



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Create a patient account

1. In the Create Portal Account dialog, under Patient Account, type the patient's email address,
and then click CREATE.

Result: A email is sent to the patient to verify and finalize their patient portal account.

2. Click SAVE.

Create a representative account

e Under Representative Account, fill in the options and click the save md button.

Result: A email is sent to the representative to verify and finalize their patient portal account.

Assign a representative account

If you created more than one representative, you can select which one to assign to the current
patient.

e Under Representative Account, select the account in the dropdown list and then click the save
i button.

Edit a representative account

1. Under Representative Account, select the account in the dropdown list.

2. Change information as needed, and then click the plus + button.

Reset passwords
After an account is verified, you can reset the password.
1. Under Patient Account or Representative Account, click RESET PASSWORD.
2. Type a new password, and click the corresponding Save button.
See also:

Generate a patient check-in code

View or add patient documents
You can view all documents attached to a patient record and their metadata, and add new documents.
Procedure

1. Go to Worklist > Edit Study screen > DOCUMENTS.
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3. To add a document by scanning, place the document in the scanner, and do one of the following.

e To scan one page without scanning options, select QUICK SCAN.
e To scan with scanning options, select the QUICK SCAN arrow . button, and in the shortcut

menu, select a scan type.

4. To upload the document to RIS, select UPLOAD. To add document to the patient chart, select

the arrow . button for and select Patient Document.
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Dacument Type * Other w

Created Date) Time *

03/14/2023 [
1226 PMED )
Requested By Select v
MNotas Sample

Maximum file size: 20 MEB

Reviewed

e Enter metadata for the document.

SCRATCGH txl

e Select SELECT FILES, browse for and select a file, and then select Open.

5. Select SAVE.
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View approved reports
Procedure

1. Go to Worklist > Edit Study screen > APPROVED REPORTS to open a window and display the
report.

Result: If an approved report is available, it opens (may take time).

[\' Test, Brad (Acc#: TesB1113), 01/01/2000 , M, 23Y

TranacrigHonMander, ashy

PO MENDILTA

Priasierd v Neal, Baa Pavent D TesH 1118

Rioderving Firyshoan i of Birih Drf-Jon-3000

Prissadue 30 ANDR 18R CT M1 Dhista ol Blashy. DDA 248 P
RISKITH REC) FOSTRCX

Arcassion Munbee S0 Erucy 01 oot

Exam: RAMOGRAPH OF THE _ HAND

Tochnbgqua: PA, ablque and Bl vess of the _ Ford are subimifed

Chnical Data: Pain

Prior Bhudigs

Findings: Thers is regioral csteopenia. Scadersd modebée degeneratres dranges wih

ot i e el TR i e il s i il B i+ P b, il st . kst e s

Open the transcription screen
Use this procedure to open the transcription multipanel from the Edit Study screen.
Procedure

1. Go to Worklist > Edit Study screen > TRANSCRIPTION to open a window and display the
transcription editor within the multipanel.
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(o= « & & | el
i _TH il - -

£l Test, Laura (Acc#:Tes Accession No: 167, Modality: CT, Study Date:
foana =N 00 Astosipen Ean Trane Study Description: 30 RMDR 1&8 CT MRI L

EXAM BFORLATION

= Transcription editor

L

IGONICA MO Tiuplates | XRAY H
Medical imaging POt
Tzt —

Exaen; RAMOGRAPH OF THE __ HAND

See also:

Dictation and transcription with WebTrans
Dictation and transcription with Exa Trans and Dragon
Dictation and transcription with Exa Trans and nVoq

Manage other physicians

You can add or delete other physicians (ones other than the primary, referring, or reading physicians)
who are associated with the current study.

Procedure

1. Go to Worklist > Edit Study screen > OTHER PHYSICIANS.

L\ Test, Lsura (Acc#:Teslad), 07,/01,/2000 , F, 22¥

STLUOY ; 30 RRDS 188 CT MR LEMATH AFD POSTRCE

OTHES FHYESCIAR M ADTAEES ROHHLE N OFFECE FHOnE

I REF Tesir, Aefening 217 U wighaly THEast AR [ERIFEERRLT]

2. Optional. To add a physician, in the Select Other Physician dropdown list, select a physician.

3. Optional. To remove a physician, select the trash I putton.
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Enter notes and reasons for study

You can enter patient notes, study notes, schedule notes, and reasons for the patient’s studies.
Generally, you can use: patient notes for patient specific information; study notes for basic study history
or notes from technologist to radiologist; schedule notes for messages from the front desk; and reason
notes for more specific study history.

A

Notes are permanent, and may be visible to the patient.

Procedure

1. Go to Worklist > Edit Study screen > NOTES.

I\ Test, Laura (Acc#:TesL43), 07/01/2000, F, 22¥

ETUDY - 30 RNDR IER T MEH USADTH

STUDY ROTES PATIENT NOTES SCHETAILE HOTES REAEON FOR STUDY CALL LG

o W Pacs CAMPOU0RE 1045 AN EST dh il rle, maressly wlined

2. Select the PATIENT NOTES, STUDY NOTES, or SCHEDULE NOTES sub-tab.
3. Select ADD, type notes, and then select SAVE.

STUDY NOTES PATIENT NOTES SCHEDULE NOTES REASOMN FOR STUDY CALL LOG
User Wirlak, F
Date/Time 13152023 844 AM EDT
Mates ~ Fatient requested a second opinion.

4. Select the REASON FOR STUDY tab.
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STUDY NOTES PATIENT MOTES SCHEDULE NOTES REASOMN FOR STUDY CALL LOG

Aeason for Study Patient complained of chronic headaches.

5. Type reasons in the box, and then select SAVE.

Update the patient call log

You can use the call log to save a record of communication to and from a patient regarding an
appointment or order. The worklist has columns for displaying the following information that you enter in
the call log: last call made, last call category, and last call notes. To update the call log:

Prerequisite: Add call categories (see App settings).
Procedure

1. Go to Worklist > Edit Study screen > NOTES.

£\ Test, Laura (Acc#:TesL43), 01/01/2000 , F 22¥

STUDY BOTES PATIENT NOTES SCHETAILE HOTES REAEOHN FOR STUDY CALL LG
ustn AT I & STLLY KOTES
o ek, Faca CRTO0RE 10:25 AM EST dhy Bl e, i resslly srilired

2. On the CALL LOG sub-tab, select ADD.
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ETUDY NOTES PATIENT NOTES SCHEDULE NOTES REASOMN FOR STUDY CALL LOG
User
Date/Time 031 52073 8:48 AM EET
Call Category * Schedule w
Call note * | Dot schedule on Wednesdays.

3. In the Call Category dropdown list, select a call category.
4. In the Call Note box, type notes, and then select SAVE.

Enter employment and transfer-related information

You can enter various information on whether the illness or injury was employment-related, the dates of
illness, work absence, and hospitalization. You can also enter information related to the source of a
transferred patient.

Procedure

1. Go to Worklist > Edit Study screen > ADDITIONAL INFORMATION.

J:'I. Tesl, Lovra (AccdTesL43), 071/07/2000 , F, 22¥

ST : 0 RROS L8 TT WA UROTH REQ POSTRCE. -

Paiksaty Cardon ln Belded o Bowres
] Errpopnand L Fuin Arvivkes| ] e sizeidant Hifarrad Humtes
Auraeal S
Hoamr Husmizer
Qe af Elegry Ontat, Injurpriccldast, o Frsgrarcy || MP):
Cora ]
Cehei Dixle =
Cates falient Urskls ta Wark st Semest Occugation!
Framd To B . i
L PR TIOH Ruries Patient Hosgitalined Refaned 1o Durveal Serviaes:
Fram'To | =
Schedude Motes
[ oassdaiab
Chigifal Rl
Elvim farhonzabon

2. Enter the information as needed and then select SAVE.

500-000577A 172



Symmetry® PACS 1.4.32_P4 User's Manual symmeltry-PACs

Assign or remove patient alerts

A Failure to add a needed patient alert could result in incorrect treatment or diagnosis.
You can assign or remove alerts for a patient.
Procedure

1. Go to Worklist > Edit Study screen > PATIENT ALERTS.

[\* Test, Laura (Acc#:TesL43), 07/01/2000 , F, 22Y

B Balanes Dun

B CTContrast Alleegy
O Fali Alort

MR Contrast Allergy
Hama Alert

Patient Clausiraphokic
Fatient has pacemaker

Paklent |s combative

e T o Y |

Patient naeds physical assistance

2. Select or clear the checkboxes corresponding to the alerts that you want to assign or remove.

3. Optional. To create a new alert, type it in the Custom Alerts box and then select the plus
button.

4, Select SAVE.

View activity logs
You can view a log of program activity and export the log to Excel.
Procedure

1. Go to Worklist > Edit Study screen > ACTIVITY LOG.
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C0F Test, Lsurs [Acc TesL43), 07/07/2000 , F 22¥

From DGAOAGEES 13000 AMES (] i mpMcEa e Pdes [ B ey B e ey [
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3 B B3 WTOIT 1200 PR IST  Paerd Mertn VW ry |imreras paend B
& B sy TEen P EET S b w W v el @t

|
B Eai e 11225 MAEST Sk dotwt f.l’:ua:nd,m
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2. Change the range of dates to filter the activity that you want to view.
3. To view details of an entry, double-click the entry.

4. Optional. To export the longs, select EXPORT TO EXCEL.
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Exam screen for technologists
Users signing in with a technologist user account see a technologist-specific version of the Edit Study

screen that helps them work more efficiently. To open the screen, select the edit button in a worklist
study row.

Censusl4, Censusf4 - 01/01/1999 - CenC103 2 EZ3Ea

1236

P

Appointment Type

Body Part Select b
Orientation Selent w“
Scheduled Date
Duration 4 15 Hingies
Study Onder Sty Notes

I nratian

Exam screen for technologists: top left (left) and top right (right)

See also:

Use the exam screen for technologists

Use the exam screen for technologists

To use the exam screen for technologists (the Technologist screen):

Prerequisites: Configure a technologist.

Procedure
1. Sign in to Symmetry PACS as a technologist or a user linked to a technologist.
2. Select the edit button in a worklist study row.
Result: The Technologist screen opens.
3. Near the upper-left part of the screen, select a study tab (an accession number).

4. Proceed with technologist workflow, using the settings and tools described in the following table.

E! View patient alerts.

Appointment Type If the original appointment type was incorrect or otherwise changed
after scheduling, you can select a new one.
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Note: It may be necessary to authorize all or parts of any new
appointment type you select.

[Other settings]

Select as needed.

TECH START/END

Select upon starting and ending the exam. Exam duration statistics
are recorded based on the times these buttons are selected, and are
used in reporting.

TECH PAUSE

Select when an exam is interrupted, such as by a difficult patient.

UNREAD

Select to reset the study's status to Unread.

Notes (Study, Schedule, Patient,

Select a category of note, and then type notes. If macro notes were

Reason) configured (see Configure macro notes), you can select them from
the dropdown list.
ABORT Select to abort the exam, such as in an emergency.

5. Select SAVE.

6. Optional. In the lower-right part of the screen, select one or more of the following.

Documents Select to view or add documents to the study or order.
See Scan to a patient.
Studies Select to view a list of prior studies for the current study. Opens the

STUDIES tab of the Edit Study screen.

Study Forms

Select to add, edit, or delete study forms from the study.

Opens the STUDY FORMS tab of the Edit Study screen.

Add Charges

Add new charges to an exam (see ).

7. Select SAVE.
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Dictation and transcription with Exa Trans and nVoq

With Exa Trans, you can dictate and transcribe simultaneously with nVoq voice recognition. One
advantage of nVoq is that it is a "zero footprint" solution for higher performance. Alternatively, you can
dictate findings in Exa Dictation and transcribe them manually. If your implementation of Symmetry PACS
offers nVoq, the Dragon feature is not available. Before using nVoq with Exa Trans, you must:

e Obtain account credentials from the nVoq website, or Create an nVoqg user account.

e Configure an nVoqg user account.

Turn on Exa Trans and nVoq
You must turn on Exa Trans and nVoq before using them.
Prerequisite: Install Exa Trans.

Procedure

1. On the worklist, select the settings E button, and then in the button shortcut menu, select User
Settings.

2. On the right side, under Voice recognition, select nVoq (Exa Trans).
3. Select SAVE.

4. Sign out of Symmetry PACS, and then sign in again.

Create an nVoq user account
To create an nVoq user account from within Exa Trans:
Prerequisite: Turn on Exa Trans and nVoq.
Procedure
1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Account.
3. Inthe Account dialog, on the right pane, type account information, and then select Save.
4. Configure your account in Symmetry PACS.

See also:

Configure an nVog user account
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Configure substitutions

You can add substitutions (voice macros) to nVoq.

Prerequisite: Turn on Exa Trans and nVoq.

Procedure
1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Add New Substitution.
3. Optional. To view previously saved substitutions, select Substitution List.
4. In the New Substitution dialog, enter the following settings.

Level Select Account to make the substitution available only to you. Select
Organization to make the substitution available to all.

Spoken Type the voice macro command (the word or phrase spoken to activate
the substitution).

Description Type a description of the substitution.

Written Type the text that nVoq substitutes (inserts) when the voice macro
command is spoken.

5. Select Save.

Configure vocabulary

You can add words and phases to nVoq's vocabulary for better recognition.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, find an unread study and select its transcription button.
2. In Exa Trans, on the nVoq Options tab, select Vocabulary.
3. In the Vocabulary screen, select one of the following:

e Account - The current vocabulary is available only to the current user.
e Organization - The current vocabulary is available to all users in the facility.

4. In the Written box, type a word or phrase.
5. In the Sounds Like box, type pronunciation.

Note: Usually leave this blank. Try adding pronunciation if nVoq frequently fails to recognize the
word or phrase.
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6. Select Save.

Dictate and transcribe a study

With the integrated nVoq application, you can use Exa Trans to dictate and transcribe findings
simultaneously. If you pause dictation, during the next 30 seconds you can use voice commands or
resume dictation without losing the connection to nVoq. After the 30 seconds, dictation "stops," and the
connection closes. To dictate multiple studies at once, see About Linked Reporting.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, find an unread study and select its transcription button.
2. Inthe Exa Trans window, in the Templates dropdown list, select a template.

3. Press the button on the microphone, and then begin dictating. Press the button again to
pause/stop.

Note: You can also select the dictation ® button in the bottom-right corner of the screen to start

recording, and 9 to pause.

4. Optional. To view the hypothesis during dictation, select the Show Hypothesis link.

5. Select Save.

Use voice commands

When using nVoq in Exa Trans, in addition to substitutions, you can use the voice commands described in
the following table.

[voice macro command] Runs the pre-configured voice macro to open a transcription template.

Select [word or phrase] Selects words and phrases.

Example: Say, "Select cardiac arrest" to select the word "cardiac" followed
by the word "arrest."

Select [word] through [word] Selects a range of words

Example: Say, "Select food through department" to select the phrase "food
and beverage department.”

Next variable Selects the next set of brackets within the report and their contents.
Next field
Previous variable Selects the previous set of brackets within the report and their contents.

Previous field
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Scratch that If text is currently selected, deletes the selection. If text is not currently
selected, deletes the previously transcribed phrase. Repeat the command to

Delete that delete the 10 most recently entered instances of stable text.

Undo Undoes the 10 most recent user actions, including dictation of text or use of
other voice commands (same as the Windows Undo command).

See also:

Add a transcription template

Edit and approve transcriptions
You can edit and approve saved transcriptions.

Note: If approving a main study, any activity related to TAT recording affects any of its linked studies (see
About Linked Reporting).

Prerequisite: Turn on Exa Trans and nVogq.
Procedure
1. In the worklist, select the transcription button of a dictated study.
2. In the editing screen, review the transcription, make any needed changes, and then select Save.

3. Select e-Sigh & Approve, or Approve and Next.

Add a dictation or transcription addendum

After approval, transcriptions cannot be edited. However, physicians and transcriptionists can add
addendums in order to correct mistakes or insert new information.

Prerequisite: Turn on Exa Trans and nVog.

Procedure

1. In the worklist, select the transcription button of an approved study.

2. To add a dictation addendum, repeat the steps in Dictate and transcribe a study.
Symmetry PACS reverts the status of the dictation from Approved to Dictated.

3. To add a transcription addendum, select Add Addendum.

4. Type new text, and then select Addendum Save.

5. Select Addendum Submit for Review.

Symmetry PACS reverts the status of the dictation from Approved to Transcribed.
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Dictation and transcription with WebTrans
You can dictate findings in Exa Dictation and transcribe them in Web Trans. Web Trans features a
multipanel interface with advanced functionality.

See also:

Dictation and transcription with Exa Trans and Dragon
Dictation and transcription with Exa Trans and nVoqg

Turn on Exa Dictation and WebTrans

Depending on your installation configuration, you must turn on Exa Dictation and Web Trans before using
them by following these steps:

Prerequisite: Install Exa Dictation.

Procedure

1. On the worklist, select the settings E button, and then in the button shortcut menu, select User
Settings.

2. On the right side of the screen, under Voice recognition, select Dictation.

3. Select SAVE.

Dictate a study

The Web Trans transcription editor does not currently support dictation, but radiologists can use the
following procedure to record dictation without simultaneous transcription (while Dragon is OFF). This

feature uses a dictation toolbar +& DL with record, rewind, play/pause/stop, fast forward, and
upload buttons.

Procedure
1. In the worklist, double-click an unread study to open it in the viewer.

2. Select a template from the dropdown list, or use a voice macro to open it.

3. On the dictation toolbar, select the record kil button, and then dictate your findings.
Note: If needed, you can select pause during dictation.

4. When finished, select the stop button.

5. To review your dictation, rewind the recording and then select the play button.

Note: You can record over parts of your dictation that you want to change.
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6. When you are satisfied with the results, select the upload button to add your dictation to the
study.

Note: Skip this step if you selected Auto Upload Dictation on Close.

See also:

Add a transcription template
Configure autosave options

Open and organize WebTrans

The WebTrans window contains dedicated panels for managing transcription, notes, documents, and
prior reports.

Prerequisite: Turn on Exa Dictation and WebTrans.
Procedure
1. In the worklist, find an unread study and select its multipanel transcription B3 button.

2. Inthe WebTrans multipanel, on the toolbar, select one or more of the following buttons:

ﬂ ’ B &)

1 2 3 4 5
1 Open or close all panels
2 Open or close the Notes panel
3 Open or close the Documents panel
4 Open or close the Prior Reports panel

3. Drag panels within the WebTrans screen to reposition them.

Edit and approve transcriptions in WebTrans

The WebTrans transcription editor does not currently support dictation playback, but you can edit and
approve submitted transcriptions.

Note: If approving a main study, any activity related to TAT recording affects any of its linked studies (see
About Linked Reporting).

Prerequisite: Turn on Exa Dictation and WebTrans.
Procedure

1. On the worklist, in the relevant study row, select the multipanel B8 button.
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In the Transcription editor panel, review the transcription, make any needed changes, and then
select Save.

Select Approve or Approve & Next.

In the Providers dialog, select the approving provider and select Approve.

Enter notes in WebTrans

You can add study notes and reasons for study in the Notes panel of WebTrans.

Procedure

1.

2
3
4.
5

On the worklist, in the relevant study row, select the multipanel B8 button.
In the multipanel, open the Notes panel.

In the Notes panel, select the STUDY NOTES or REASON FOR STUDY tab.
If entering a study note, select a study date.

Type notes in the space provided, and then select SAVE.

Manage documents in WebTrans

You can view all documents attached to a study in the Documents panel of WebTrans. The Documents
panel displays up to two documents at once, and you can select which documents to display.

Procedure

1.
2.

On the worklist, in the relevant study row, select the multipanel B8 button.

In the Documents panel, select the document buttons to show or hide currently open documents
in viewing frames.

m ID CARD REPORTS

The buttons labels indicate the document selected for viewing, the default document type set by
the user in the panel, or the last-viewed document types

If more than two documents are available, you can open a new one by dragging a document
metadata block from the top of the panel into a document viewing frame.
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Manage prior reports in WebTrans
You can view, download, and print prior reports from the Prior reports panel of WebTrans.
Procedure

1. On the worklist, in the relevant study row, select the multipanel B button.

2. In the Prior reports panel, in the left pane, select the block of metadata corresponding to the
report that you want to view.

3. To download or print the report, in the right pane, hover over the report, and then select the
download or print button in the toolbar that appears.
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Dictation and transcription with Exa Trans and Dragon

With Exa Trans, you can dictate and transcribe simultaneously with Dragon voice recognition.
Alternatively, you can dictate findings in Exa Dictation and transcribe them manually. If your
implementation of Symmetry PACS offers Dragon, the nVoq feature is not available. To use the features
of the Exa Panel for transcription related tasks, see Dictation and transcription with WebTrans.

Turn on Exa Trans and Dragon

You must turn on Exa Trans before using it by performing the steps that follow. You turn on Exa Trans
indirectly by turning on the Dragon speech-to-text option in the user settings.

Prerequisite: Install Exa Trans.

Procedure

1. On the worklist, select the settings {2} button, and then in the button shortcut menu, select User

Settings.
2. On the right side, under Voice recognition, select Dragon.

3. Select SAVE.

Dictate and transcribe a study

With the integrated Dragon speech-to-text application, you can use Exa Trans to dictate and transcribe
findings simultaneously.

Prerequisite: Turn on Exa Trans and Dragon.
Procedure
1. In the worklist, find an unread study and select its transcription button.
2. Inthe Exa Trans window, in the Templates dropdown list, select a template.

3. Optional. To use a voice command, with the Templates dropdown list open, say, “Macro
[template name].

4. Place the cursor where you want to add text.

5. On the Dragon toolbar, select the record = button, and then begin dictating.
Select stop when finished.

6. Select Save.
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Edit and approve transcriptions

You can edit and approve saved transcriptions. If approving a main study, any activity related to TAT
recording affects any of its linked studies (see About Linked Reporting).

Prerequisite: Turn on Exa Trans and Dragon.
Procedure
1. In the worklist, select the transcription button of a dictated study.
2. In the editing screen, review the transcription, make any needed changes, and then select Save.

3. Select e-Sigh & Approve, or Approve and Next.

Add a dictation or transcription addendum

After approval, transcriptions cannot be edited. However, physicians and transcriptionists can add
addendums in order to correct mistakes or insert new information.

Prerequisite: Turn on Exa Trans and Dragon.

Procedure

1. In the worklist, select the transcription button of an approved study.

2. To add a dictation addendum, repeat the steps in “Dictate a study.”
Symmetry PACS reverts the status of the dictation from Approved to Dictated.

3. To add a transcription addendum, select Add Addendum.

4. Type new text, and then select Addendum Save.

5. If not using Dragon, select Addendum Submit for Review.

Symmetry PACS reverts the status of the dictation from Approved to Transcribed.

About using Exa Trans and WebTrans

Exa Trans and WebTrans (with the multipanel) are designed to work in sync. Exact behavior depends on
various user rights, actions, and settings, as in the following examples.

Close Exa Trans Also closes WebTrans
WebTrans rights assigned WebTrans available
Exa Trans rights assigned Exa Trans available only if the Dragon user setting is also turned ON.
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Action/ Condition

Auto-Open Orders + “Documents”
selected

If an order auto-opens, the Documents screen auto-opens.

Auto Open Orders enabled AND
Viewer Settings > General > Display
Settings > Monitor 1 = Documents

Documents auto-open in the Documents screen of the multipanel in Monitor
1.

Auto Open Orders disabled AND
Viewer Settings > General > Display
Settings > Monitor 1 = Documents

Documents do not auto-open, but if manually opened, they open in the
multipanel in monitor 1.

Exa Trans and WebTrans enabled
within Auto Open Orders

Exa Trans and WebTrans both open when an order auto-opens.

You can configure which monitor they open in in the Display Settings, or
leave blank to open in the main monitor.

Exa Trans set to auto-open AND
WebTrans not enabled in Auto Open
Orders

Only Exa Trans opens when a study opens (but you can still manually open
WebTrans).

Set Exa Trans or WebTrans to open
on a specified monitor

Manually opening Exa Trans or WebTrans opens it in the specified monitor.

WebTrans set to auto open in Auto
Open Orders, but not Exa Trans

WebTrans auto opens when the viewer is opened, in the specified monitor, if
so configured.

User selects the Exa Trans or
WebTrans button on the worklist

Exa Trans or WebTrans opens on the same monitor as the worklist.

Exa Trans

Esign & Approve

Study is approved, viewer closes, Exa Trans minimized.

Exa Trans

Approve & Next

Study is approved, viewer and Exa Trans open with next available study.

Exa Trans

Not Approve

Study status changes to Not Approved, viewer closes, and Exa Trans
minimizes.

Pre Approve

Exa Trans Study stays in Unread status, viewer and Exa Trans open with the next
available study

Skip

Exa Trans Study status changes to Draft, viewer and Exa Trans remain open with
current study

Save

Exa Trans Study status changes to Pre-Approved, viewer closes, and Exa Trans

minimizes

Exa Trans and WebTrans

Esign & Approve

Exa Trans closes, WebTrans minimizes or closes

Exa Trans and WebTrans

Approve & Next

Study status changes to Approve, viewer, Exa Trans, and WebTrans open
with the next available study
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Exa Trans and WebTrans Study status changes to Not Approved, viewer, Exa Trans, and WebTrans
minimize or close.
Not Approve

Exa Trans and WebTrans Study status remains Unread, the viewer, Exa Trans, and WebTrans open the
next available patient or study.

Skip

Exa Trans and WebTrans Viewer, Exa Trans, and WebTrans remain open. If the user closes the viewer,
Exa Trans and WebTrans also close.

Save

Exa Trans and WebTrans Study status changes to Pre-Approved, viewer and WebTrans close.

Pre Approve
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QC operations

All DICOM studies from other AEs initially appear on the QC tab, and are automatically evaluated for
conflicts with PACS studies, RIS orders, and other data based on user-defined receiver rules. The topics in
this section describe how to resolve conflicts.

See also:

Understanding receiver rules

Prepare the QC tab

When received studies fail to match studies in the database, they appear on the QC tab of the worklist.
To find conflicts needing reconciliation more easily, you can sort studies in the QC tab of the worklist by
their QC status.

Procedure
1. On the worklist, select Settings > User Settings.
2. Under User Settings, select Show QC.
3. To show exams in Completed status, select Show Completed in Pending List.
To show exams in Confiict status only, clear the checkbox.
Select SAVE.
On the worklist, select the QC tab.

On the search bar, click inside the STATUS box.

N L

Select a status (such as “Conflicts”) and select APPLY FILTER.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order

Move QC studies to the All Studies tab

Reconcile conflicts by matching to a RIS order

When received studies fail to match studies in the database, they appear on the QC tab of the worklist.
To reconcile conflicts, start by trying to match the conflicting study to a RIS order.

Prerequisite: Prepare the QC tab.

Procedure

1. On the worklist QC tab, find a study whose status is Conflicts, and select the "reconciliation dot."
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2. In the Reconcile dialog, under Suggestions, if an order in the list matches the Current Study,
select its SELECT button, and then select OK. If no suggestion matches, skip to the next step.

Result: The conflict is reconciled.

3. Under RIS Orders, search for more potential matches by typing criteria in the search boxes. If a
match is found, select its SELECT button and continue as above.

Hint: Find patients in your EHR or other sources for possible matches.

See also:

Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order
Move QC studies to the All Studies tab

Reconcile conflicts by manually editing demographics

When received studies fail to match studies in the database, they appear on the QC tab of the worklist. If
the conflict reason on screen is Multiple matches/Account# conflicts for patients, you can edit the
demographics of the conflicting study to match a patient in the Exa PACS/RIS database, or vice versa
(edit a patient in the database to match the conflicting study).

Prerequisite: Prepare the QC tab.

Procedure

1. On the worklist QC tab, find a study whose status is Conflicts, and select the "reconciliation dot."
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2. In Chrome, open another instance of Exa PACS/RIS, and on the burgerE menu, select
PATIENT.

3. Search for a patient chart that is likely to be the match for the conflicting study.

Hint: Find patients in your EHR or other sources for possible matches.

= Patient &

Starts With || All = [ Show Inactive [J Break the Glass

122456

IMPORT PATIENT

PATIENT SEARCH RESULTS

boost*breast - FIX_123456, 123456
DOB: 01/07/1900

Browning, Patrick - 12345677128756
DOB: 02/08/ 1977

Dental*Patient - 12345677, 12345677
DOB: 1041072000

FOOT*ULTRA - 123456, 123456
DOB: 04/05/2015

In the example, the MRN matches multiple studies -- select the correct one

4. Open the likely matching chart, edit demographics as necessary, and then select SAVE.
5. Confirm that the study no longer has a status of Conflicts.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by creating an order
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Move QC studies to the All Studies tab

Reconcile conflicts by creating an order

When received studies fail to match studies in the database, they appear on the QC tab of the worklist. If
you cannot find a RIS order that matches or should match a conflicting study, you can reconcile by
creating a new order that matches.

Prerequisite: Prepare the QC tab.
Procedure
1. On the worklist QC tab, find a study whose status is Conflicts.

Record demographics you need to create an order (patient demographics, MRN, study
information, etc.).

2. Create an order for the conflicting study by following the steps in A typical scheduling workflow.
3. On the QC tab, in the conflicting study’s shortcut menu, select Reconciliation.

4. In the Reconciliation dialog, under RIS Orders, find the order you just created and select its
SELECT button.

5. Confirm that the study no longer has a status of Conflicts.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Move QC studies to the All Studies tab

Move QC studies to the All Studies tab
You can move a study in the QC tab to the All Studies tab without reconciling.
Prerequisite: Prepare the QC tab.
Procedure
1. In the worklist, select the QC tab, and then find a study that you want to move.
2. In the study’s shortcut menu, select Move to All Studies.

See also:

Reconcile conflicts by matching to a RIS order
Reconcile conflicts by manually editing demographics
Reconcile conflicts by creating an order
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Work with the Symmetry PACS viewer
Standard viewing tasks

Open a study in a viewer

In this manual, viewer refers to the Symmetry PACS viewer unless otherwise specified. To open a study,
on the worklist, do one of the following:

e To open in the Symmetry PACS viewer, select the E button of a study.

e To open in the Opal viewer, select the E button of a study.

¢ Configure Symmetry PACS to open studies in the viewer when you double-click them. Follow the
steps in “Miscellaneous user settings” to configure the double-click behavior setting.

YA

CAUTION: Check for the presence of the lossless indicator in the lower-left corner of the image frame
before proceeding with a diagnosis. If you adjust the image, wait until the lossless indicator turns green
before diagnosis.

The red lossless indicator means the image has not yet fully loaded.

View priors and prior reports
From the Exa PACS/RIS viewer, you can open priors from a list, open then from the prior bar, and open

prior reports.

Open a prior from a list

1. On the viewer toolbar, select the Show Prior List ﬂ button to open the list.

Other Patient Exams
Prior Patient Exams

R M Description Referring Exam Date Status
R US DOP VELOCIMETRY FTL UMBILICALART  Test, Referring 01/19/2023 11:15AM _ Approved
R* US ggﬁEEHO FTL SPECTRAL DISPLAY Test, Referring 01/19/2023 1100 AM  Approved

If an R appears in the R column, the prior includes a report. If the priors are linked:
R’ The report is the main report.

R* The report is a linked report (linked to the main report).
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2. Inthe list, double-click a prior to open it in the viewer.

View priors with the Prior bar

If priors are included in a study that you open, you can view them by using the Prior bar. To show the
Prior bar in the viewer, configure the Use Modified Toolbar setting (see Configure other interface

settings).

| 09/11/2015 10:47 AM 011182018 3:35 PM
MG, MAMMOGRAPHY, MG, Standard Screening -
‘SCREENING DIGITAL TomoHD

CURRENT 1¥SM16D

LMI‘_"; RMLO CWIEWRC | BTC RCC

The Prior bar contains the current and prior studies on the top row, and their image thumbnails on
the bottom row (see figure). The study boxes show the age of the study, and depending on
configuration, let you do one or more of the following:

e Hover over a study to display its details.

e Select a study to open the thumbnail bar.

e Double-click a thumbnail to open its image or series (for example, the right box in the top row
of the figure).

e Ifareportisincluded, select its symbol to view.

Open a prior report

1. On the viewer toolbar, select the Prior Reports H button.
2. Inthe Approved Reports screen, on the left pane, select a prior report.
Result: The report appears in the right pane (may take time to load).

Note: If reports are linked, the link symbol appears (in the red circle in the figure).
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% Approved Reports - Google Chrome

A Not secure | hitps;//10.227.26.93/studyReports?study_id=1188session_id=LV9GdnASTOd6OXNONGICZ1BiSUVQZOY

=  TranscriptionHa... 1 U -  82% + B 9

%01/19/2023 11:00
Al

US, DOP ECHO FTL
SPECTRAL DISPLAY
comMPL

IKONICA MINOLTA

Medical Imaging

Patient Name: Test, Ted Patient ID: TesT1004
@ /19/2023 10:45 ing Physician:  Test, Referming Date of Birth:  01-Jan-2000
4 sl Procedure: DOP ECHO FTL PLSDSPECTRAL  Date of Study:  19-Jan-2023 10:45

DISPLAY REPEAT STD;DOP AM, 0171972023
VELOCIMETRY FTL UMBILICAL

ART,DOP ECHO FTL SPECTRAL

DISPLAY COMPL

US, DOP ECHO FTL
PLSD SPECTRAL
DISPLAY REPEAT
STD

Test

About viewing CAD findings

The Exa PACS/RIS viewer automatically displays image markers contained in SR data from supported
manufacturers such as iCAD, DiA, Hologic (Malc findings, see below), and CureMetrix (such as the
CureMetrix mammography calcification and density markings). To control which markings to display,
select options in the SR CAD list (see Configure mammography).

Exa PACS/RIS uses tracking IDs in the SR data to ensure that when you click a 2D/synthesized image
annotation it jumps correctly to the corresponding 3D/BTO image. Additionally:

o Ifthe BTO series is not already open, it opens next to the 2D/synthesized view in a 1 x 2 layout. You
can go back to the original layout by selecting the backslash key (if the DM was not interrupted).

e When 3D CAD SR markings are present and you hover over a CAD SR marking on the synthesized or
2D view, the color changes to the hover color configured in viewer interface settings.

Hologic Malc findings

Hologic ImageChecker CAD has a finding type called a Malc, which is a combination of one
mammography breast density and one calcification cluster. When Malc findings are present in a CAD
SR, the Exa PACS/RIS viewer displays them as a “compass” shape. The center point marking of the
compass is determined by the center point of the child breast density. The total count of Malc findings
appears in the top overlay next to the count for densities and calcifications.
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The Malc “compass” marking and count

See also:

Configure annotation colors
View studies with CAD findings

View studies with CAD findings

The Exa PACS/RIS Viewer supports 2D CAD findings for mammography and 3D tomographic series.
Findings are displayed as overlays. To view CAD findings:

Prerequisites: Configure mammography (especially SR CAD options)
Procedure
1. Open a study containing CAD findings in the Exa PACS/RIS viewer.

Result: The CAD button becomes available.

2. Select the CAD m button, and then select findings to show.
Example: Calcification Clusters(3) > Show
3. Optional: Select a finding to select a value for the 2D or synthesized view.

Result: The screen changesto a 1 x 2 temporary view with the 2D image in one cell and the BTO
series moved to the slice with the finding in the other. For example, if you select the RCC finding,
the BTO series opens at the RCC slice.

CAD-related keyboard shortcuts

To easily move through series that include 3D CAD findings, you can use keyboard shortcuts (see
Assign toolbar keyboard shortcuts). For example, you can use a keyboard shortcut to jump to the
next finding in a BTO study, or turn Malc markings on and off.

See also:

About viewing CAD findings
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View priors with the Prior bar

If priors are included in a study that you open, you can view them by using the Prior bar. To show the
Prior bar in the viewer, configure the Use Modified Toolbar setting (see Configure other interface
settings).

| 0971172015 10:47 AM 01/118/2018 3:35 PM

MG, MAMMOGRAPHY, MG, Standard Screening -
SCREENING DIGITAL TomoHD

CURRENT 1Y 5M16 D

RCC LMIJ.; RMLO CVWIEWRC | BTO RCC
£ F.
e

The Prior bar contains the current and prior studies on the top row, and their image thumbnails on the
bottom row (see figure). The study boxes show the age of the study, and depending on configuration, let
you do one or more of the following:

e Hover over a study to display its details.

e Select a study to open the thumbnail bar.

e Double-click a thumbnail to open its image or series (for example, the right box in the top row
of the figure).

e Ifa reportisincluded, select its symbol to view.

Send an image from the viewer

You can send the current image in the viewer to an application entity. If the image includes annotations,
those annotations are included with the image according to the method you specify in the Send
Annotations as setting (see Configure application entities).

Procedure

1. Optional: To send an annotated image back to its original AE, select Viewer Settings > General
> Auto Send Annotated Images on Close.

2. Open an image in the viewer.
3. Optional: Add annotations.
Note: ROI annotations are automatically sent as weighted.

4. Right-click the image and select Send Image/Annotation.
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5. In the Send Study dialog, in the bottom pane, select one or more AEs.

6. Select SEND TO SELECTED or SEND TO ALL.

DICOM-print a study

You can print the currently viewed image to a preconfigured DICOM printer. The current image prints,
including any displayed annotations and overlays.

Note: You cannot print multiframe MR/CT or MG tomography images, or US echocardio series.

Prerequisite: Add the DICOM Print command to the shortcut menu (see Add or remove tools from the
image shortcut menu).

Procedure
1. Open a study in the Symmetry PACS viewer, right-click any image, and then select DICOM Print.
2. Inthe DICOM Print dialog, in the Printer dropdown list, select a printer.
3. Enter the following remaining settings.

Annotations Select to include annotations, or clear to exclude.

WY/L (Default) Select to print the image with its original window/level settings. Clear to
select the current window/level setting.

Overlay Text Select to include the DICOM overlay (as per-image detail), or clear to
exclude.
Selected Image Select to print the selected image, selected series, current page of images,

or all images.
Selected Series

Current Page

All Images
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Prev / Next

Select to move through pages of the print preview.

Printer

Select a printer (selected earlier in this procedure).

Configuration

Select a printer profile.

4. Select DICOM Print.
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Configure the viewer

In the Viewer Settings dialog, you can configure a wide variety of viewer options including display,
interface, modality, toolbars, and shortcut menus. For details on operations in the Viewer Settings dialog,
see other topics in this section. There are two ways to open the Viewer Settings dialog.

e Inthe worklist, on the upper toolbar, select the settings - button, and then in the button
shortcut menu, select Viewer Settings.

e Inthe Symmetry PACS viewer, in the upper toolbar, select the setting . button.

Viewer Settings

GENERAL ] )
Display Settings
INTERFACE Monitors on System 3 RO
Monitor Current Prior Full Screen Orders Type
MODALITY
[ pispLAY1 (@] @] 0O None v
MAMMOG HY r
RAAAMOGRAR DISPLAY2 @ (@) None - v
OVERLAYS DISPLAYS Qo ® None v v
TOOLS
Autosave Options
EXTERNAL ) |
TOOLS Autosave Image Properties on Close

Autosave Image Annotations on Close
Auto Mark Read Study on Close

Auto Upload Dictation on Close
Autosave Viewer Settings on Close

Auto Open Next Study

I I Y O Y 1 I B

Auto Send Annotated Images on Close

Set up connected displays

Configure all connected monitors that you intend to use with Symmetry PACS. These settings act as
default behavior for what study items open in which monitor. If DMs conflict with the settings you enter
here, the DM takes precedence.

Prerequisite: Add the Chrome extension.

Procedure
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In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.

In the Viewer Settings dialog, in the left pane, select GENERAL.

-
[

Under Display Settings, in the Monitors on System box, select the update "~ button to update

the monitor count (or enter manually), and then select the identify O button.

In the table of monitors, enter the settings in the following table.

Note: At any time you can select the update < button to preview your changes.

studies on the monitor, clear this option.

Monitor Select to make monitors available for image viewing. To display orders and

to open automatically.

in the viewer.

Current Select to make monitors available to display current studies.

Prior Select to make monitors available to display prior studies, if available.

Full Screen Select to default to full screen view.

Orders Select a section of the patient chart to open in the corresponding monitor

when manually opening that section with a viewer tool, or when configured

Document in the Orders dropdown list for DISPLAY2, the Document section
of the patient chart will appear in DISPLAY2 when you select the button

Type The color or grayscale display type.
Calibration Width/mm Type a manual calibration width (appears on horizontal calipers)
Calibration Height/mm Type a manual calibration height (appears on vertical calipers)

Select SAVE.

Configure autosave options

You can configure how the viewer performs automatic saving and other functions.

Procedure

1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting E button.

2.
3.

In the Viewer Settings dialog, in the left pane, select GENERAL.

Under Autosave Options, enter the settings in the following table.

Autosave Image Properties on Close Automatically saves image properties such as the W/L when
the image is closed. Saved properties are restored the next

time the image is opened.
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Autosave Image Annotations on Close Automatically saves image annotations when the image is
closed. Saved annotations are restored the next time the
image is opened.

Auto Mark Read Study on Close Automatically marks the study as “Read” when the study is
closed.
Auto Upload Dictation on Close Automatically uploads recorded dictations to add to the

study when the study is closed.

Autosave Viewer Settings on Close Automatically saves any changed viewer settings such as
toolbar configuration when closing the viewer.

Auto Open Next Study When the current study is closed, automatically opens the
next study in the worklist that is not partially deleted.

Auto Send Annotated Images on Close Automatically sends images if they include annotations when
the current study is closed.

4, Select SAVE.

Configure the toolbar
You can configure the appearance and other properties of the viewer toolbar.

Procedure

1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.
3. Under Toolbar, enter the settings in the following table.

Note: You may need to update the viewer for changes to take effect.

Seios peswwen

Toolbar Button Scale Adjusts the size of toolbar buttons.

Thumbnail Bar Scale Adjusts the size of the thumbnail bar.

Magnifying Glass Size Adjusts the size of the area affected by the magnifying glass.

W/L Acceleration Sets the rate or sensitivity of W/L adjustments. Typical range is 100-
600.

Span Sensitivity Sets the rate or sensitivity of span adjustments.

Auto - Adjusts the speed automatically based on the number of images
in the series.

Dflt - The default sensitivity after upgrading to version 1.4.32_P1. This ig|
the same sensitivity as the "0/Auto" sensitivity used in version 1.4.29.

Low/High - Spans slowly or quickly.
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Thumbnail Column/Rows Sets the number of columns and rows for the thumbnail bar.

Thumbnail Bar Orientation Sets the position and resultant orientation of the thumbnail bar. If you
select Mirror, the thumbnail bar in the left monitor appears on the left
side of the screen, and the thumbnail bar in the right monitor appears
on the right side of the screen (available when the modified toolbar is
not available).

Header Menu Sets the position of the toolbar and other header items.

DM Toolbar Sets the position of the DM toolbar.

4, Select SAVE.

See also:

Configure other interface settings

Configure calipers

You can configure the number and placement of calipers.

Procedure
1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting H button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Caliper Position, select checkboxes for each caliper that you want to display, and then
select SAVE.

Configure other interface settings

You can configure miscellaneous viewer toolbar and other settings.

Procedure
1. In the Symmetry PACS viewer, in the upper toolbar, select the setting H button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Other Toolbar, enter the settings in the following table.

Ask on Close Prompts you to specify which items to save before closing
the viewer.

Single Instance Mode Limits the viewer to one display frame per browser.

Skip Frames in Cine to Maintain Playback Skips large images in a cine loop so that the cine plays a

Speed fixed speed.
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Show Cutlines for First/Last Images

Shows any available cutlines only on the first and last images
of a series.

Open Key Images as Single Images

Displays any available key images separately in the thumbnail
area. When cleared, shows all series images in the key image
thumbnail area.

Use Modified Toolbar

Temporarily hides the thumbnail bar, and adds a Prior bar af
the top of the screen that displays patient priors in order.
You can hover over a prior to display series/image
thumbnails, and select the thumbnails to open the images.
Works in conjunction with the Auto Show Priors Bar option.

Caliper Zoom

If selected, you can drag the calipers to zoom the current
image.

Auto-Play Cine Loops

Automatically plays cine loops when opened.

Auto Play Cine Wait Time (ms)

Sets a pause time before auto-playing cine loops.

Default Frame Rate for MP4

Sets a default frame rate for MP4 files.

Default Cutline Thickness

Sets a default thickness for cutlines.

Auto Open Orders

Selects the options that appear in the Orders dropdown list
in the Viewer Settings dialog, General Info. screen, under
Display Settings.

Auto Show Priors Bar

Shows all prior studies in a separate bar at the top of the
viewer.

Focus-In on Zoom Point

When selected, the user can drag on an image to zoom in
and out at the initial pointer position.

Fill Empty DM Cells

Fills undefined DM frames with images in the current study.

High-Quality Interpolation

Select to use high-quality image interpolation. Frequently
used to enhance X-ray quality. You can use this compression
option to remove unwanted “gridlines” if switching between
earlier and high-resolution monitors.

Enable RGB/YBR Swap

Makes the color settings supported by the user video settings
available.

Enable Developer Mode

Shows development mode logs, and displays a vertical green
line in the right side of each frame when the server performg
a prefetch.

Show Calibrated Ultrasound Region

Server side setting.

Hide Partial Close Button

Hides the partial close button, an “X” that appears next to
the logoff button. Partial closing closes the study, but leaves
the viewer open for faster loading of future studies.

Hide All Monitor Layout Change Button

Hides the toolbar’s monitor layout change button that
appears when two or more monitors are made available.

Show Label in DM Preview

Shows the previews of hanging protocols in the DM bar.
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Show Middle Slice Thumbnail Shows only the thumbnail of the middle slice in a series on
the thumbnail list.

Enable Cardio Viewer [Unused]

Disable Queuing Forces synchronous communication; client message and
server response occur one at a time. CAUTION: We do not
recommend changing this setting. Consult with your Konica-
Minolta representative.

Stretch Prior Bar Extends the prior bar across multiple monitors. If the prior
bar exceeds the total available screen width, a scroll bar
appears.

Show Prior Index Displays the Prior index number in the thumbnail and Prior
bars.

Auto open STAT When you open a study in the Symmetry PACS viewer, this
option automatically opens any STAT images, if included.

Split W/L Region [Unused]

Color Only as Last Monitor Chooses the color monitor as the last monitor on which to

display images.

Client-Side Window/Level for US Processes the Window/Level for ultrasounds on the client
side. May reduce lag by bypassing the server.

Show Span Overlay Shows a span sensitivity adjustment slider on images.

4. Select SAVE.

See also:

Configure the toolbar

Configure annotation tool functionality
You can configure annotation tool functionality.

Procedure

1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.
3. Under Annotation, enter the settings in the following table.

Show Annotation Shows annotations by default. The user can still hide them
manually in the viewer.

One-Click Annotations Changes from the selected annotation tool to the default
cursor after each use. If cleared, the user can reuse the tool
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repeatedly without re-selecting the tool.

Show One-Click Annotations Button Shows a button for turning one-click annotation on and off.

Annotation Edit Mode Selects the Edit command in the image shortcut menu by
default.

Use Dot Cursor Changes the standard pointer to a dot pointer.

Edit Annotations after Creating Causes the viewer to enter Edit mode after initial placement

of an annotation.

Allow Drag Create Creates annotations by dragging instead of selecting.
ROI Show Size Displays the size of the selected ROL.
Confirm Annotation Delete Prompts the user for confirmation when deleting

annotations.

Persistent Annotation Tool Makes a selected annotation tool available until the user
selects a different tool. If cleared, the pointer changes to the
default operation after using the tool.

Show Measurements In Sets the units for any length measurements taken.

4, Select SAVE.

Configure annotation colors

You can configure the color of annotations to indicate whether they are selected, in edit mode, or
applied.

Procedure

1. In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Colors, to add an annotation color, select inside a color or grayscale box and then use the
color picker to select a color.

Anno Color 1-5: Annotations appear in these colors by default.
Anno Color Edit: Annotations change to this color when you edit them.
Anno Color Hover: Annotations change to this color when you hover over them.

4. Select SAVE.
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Configure annotation size and scaling
You can configure the pixel or font size of annotations, and scale annotation points.

Procedure

1. In the Symmetry PACS viewer, in the upper toolbar, select the setting ﬂ button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Under Miscellaneous, enter the settings in the following table.

Scale in Pixel Size Determines the annotation font size by the pixel size.
Scale Annotation Font By Sets the font size for annotations.
Scale Annotation Point By Sets the line thickness for annotations.

4. Select SAVE.

Configure recording

You can configure audio recording options for Exa Dictation.

Procedure

1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting ﬂ button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE SETTINGS.

3. Under Record Control, enter the settings in the following table.

Hold for Record Requires you to hold down the button for the duration of
recording.

Beep on Record Beeps when recording starts.

Blink on Record Pause Causes the microphone light to blink when recording is paused.

Monkey Chatter on Rewind Plays “monkey chatter” sound when rewinding.

FFWD/RWD Factor (200-500) Changes the rate of fast forward and rewind, in milliseconds.

Lag (0-5000) Delays the response after selecting play or record by the
specified amount of time, in milliseconds.

4. Select SAVE.
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Show or hide tool buttons
You can hide certain tool buttons.

Procedure

—

In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select INTERFACE.

Under Tool Buttons, select the checkboxes of the items that you want to hide.

> W N

Select SAVE.

Configure modality-specific viewing options
You can configure how studies appear in the viewer for all modalities, or for each specific modality.

Procedure

In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.

=

2. Inthe Viewer Settings dialog, in the left pane, select MODALITY.
3. Inthe list of modalities, select a modality to configure.
4

Enter the settings in the following table.

Layout Screen Layout Changes the layout of frames.

Series Layout Changes the layout of series frames within
screen layout frames.

Mouse Buttons Left/Right/Middle/Left+Right Assigns functions to mouse buttons. This is
frequently used by CAD users to assign
functions to extra mouse buttons.

Compression Sets the image quality, which inversely affects
viewer performance.

Presets Key Assigns shortcut keys to W/L presets.
Description Type a name for the W/L preset.
Window Width Sets the window width of the W/L preset.
Window Center Sets the window center of the W/L preset.
Set Select when finished entering Preset settings.
Options Auto Linking Turns on the Auto Linking function.
Assume Color Study Forces studies of the selected modality to

appear in the default color monitor set in the
display settings regardless of color.
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Assure All Viewed

Displays a check mark in thumbnails of images
that were opened, and warns the user when
closing before all images are opened.

Auto CLAHE

Turns on the CLAHE function.

Auto Hang DM

Enables the use of DMs. Makes the first instance
on the DM preview available to hang on the
viewer.

Auto DM Wrap

Enables moving from the final step of a DM
directly to the first step, and back again.

Auto Hang Priors

Automatically loads the first prior when the
viewer opens. Works in conjunction with Auto
Open Priors.

Auto Replace Priors

Automatically replaces prior images in the
current layout.

Auto-Invert SC Images

Inverts white and black of scanned documents
such as reports. Reduces eye fatigue.

Auto Next Series

When moving beyond the last image of the
current series, automatically opens the next
series.

Auto Next Series Cine

Automatically starts cine play of the next series
when the user opens it.

Auto Next Series Wrap

Automatically opens the first series after
viewing the last image of the last series in a
study.

Auto Next Study

Automatically opens the next study in the
worklist after closing the current study.

Auto Swap Red/Blue

Inverts colors that may not be displayed from
the modality properly (such as with non-DICOM
ultrasounds).

Auto Show DICOM Overlays

Automatically displays DICOM overlays, if
present.

Auto Show SR Overlays

Automatically displays SR overlays, if present.

Auto Show Cutlines

Automatically displays cutlines, if present. Note,
this setting also applies to synthesized
mammogram views, in which the cutlines
indicate the position of the currently viewed
image on the corresponding BTO view.

Auto Show Cine

Shows the media control bar when a series is
opened.

Auto Show W/L Bar

Shows the window/level bar when the viewer
opens.

Detect Pixel Padding

Turns detection of pixel padding ON/OFF.
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DM Allow Missing Cell

Shows a blank cell in the DM if the assighed
image is not available.

DM Save W/L

Saves the window/level with the DM.

Save Study DM on Close

Creates a new DM for each study when it
closed, or when the next study auto-opens. The
DM is named with the accession number, and
contains the last displayed stack and monitor
position.

Show PDF in Last Stack

Moves PDF files to the last place in the stack: in
the viewer, they are loaded last, if an empty cell
is available.

Instance Window/Level

Select to show each image with its own W/L

Clear to show each image with the W/L of the
first instance.

Do Not Skip Images

Prevents moving forward if subsequent images
are not yet loaded.

Ignore Frame of Reference within
Study

Disables referencing of the study’s DICOM frame
of reference UID when performing linking and
cutline functionality.

Ignore LUT

If LUT values are corrupted, Symmetry PACS
ignores the LUT values, and attempts to render
the best image possible.

Ignore Presentation LUT

Same as Ignore LUT, but select for certain
vendors that use a “Presentation LUT.”

Keep Rotate

Applies the current rotation to all images in the
series.

Keep W/L Applies the current W/L to all images in the
series.
Keep Zoom Applies the current zoom level to all images in

the series.

Extend Image Display (if Stretch)

When Stretch Across Monitors is selected,
extends a single image across multiple
monitors.

Pixel Padding as Background

Interpolates missing pixel data to fill in “dead”
spots in an image.

Note: When using this feature, reading
physicians should be aware that some pixels
may be synthesized.

Pre-generate Bitmaps

Pre-generates bitmaps automatically if
imported into PACS.
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Reset W/L for Individual Images

Select to use the original W/L of each individual
image.

Clear to use the first W/L sent by the modality
for all images.

Frequently used to optimize MRI images.

Select Last Contrast Entry

When DICOM tags include multiple W/L values,
uses the last value for all images in the series.
Clear to use the first value.

Show 3D Spine Labels

Shows the 3D spine label tool on the toolbar.

Show ‘Bone Enhance’ on Toolbar

Shows the Bone Enhance tool on the toolbar.

Show DM Toolbar

Shows/hides the DM toolbar on initial load.

Show Spine Labels

Shows the spine labels tool on the toolbar.

Sort Thumbnails by Date/Time

Sorts thumbnails by date/time.

Stop Thumbnail from Updating

Prevents W/L changes to the current image
from affecting its thumbnail.

Stretch Across Monitors

Turns on extending of items across multiple
monitors.

Cine Direction

Sets the cine playback to forward or backward.

Default FPS Causes cine play to occur at the default frames
per second, depending on modality.
Enable 4DM Opens the 4DM viewer for post-processing.

(Requires configuration to integrate with the
4DM viewer.)

Disable CINE Scrolling

Disables cine play of series.

Active Frame Based Cineplay

Playing a cine loop on one series automatically
plays all linked series.

Disable Caliper

Hides calipers for the modality.

Auto-Split Rules

Always

Splits US series into individual images.

Differing Echo Time

Splits by echo time.

Differing Series Number

Splits by series number.

Differing Series Time

Splits by series time.

Differing Acquisition Number

Splits by acquisition number to create stacks
for separate acquisitions/scans.
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Differing Diffusion Value Splits images within similar series UID by b-
value (0018,9087 MR Diffusion Value) into
separate series.

Differing Trigger Time Splits by trigger time (0018,1060).

Isolate MPEG Splits by MPEG file.

Isolate Multiframe Splits cine loops into multiple images.

Premium View Bone Enhance Displays the contrast enhance menu.

Auto Bone Enhance Highlights the bone portions of images.

Auto WL Type Selects the default W/L to use for the selected
modality.

Auto Reorder Images Automatically changes the order of images in a

series to the selected order.

Prior Options Auto Open Prior Automatically opens prior studies.

Relevant Priors When automatically opening priors, also opens
relevant priors from other modalities. See
“Define relevant priors” later in this topic.

Auto Open Prior Count When automatically opening priors, opens the
selected number of studies.

Force Relevant Only Opens only the defined relevant priors (see
"Define relevant priors" later in this topic).

Prioritize Current Modality First When opening relevant priors, display same-
modality priors first.

5. Select SAVE.

6. Optional. If you selected Relevant Priors, see the next section, “Advanced options for displaying
relevant priors.”

Define relevant priors

Defining relevant priors allows you to auto-open only priors that are relevant to the current study
based on study description, modality, or body part. To write definitions for which priors are relevant
you use a syntax called relevant prior logic:

STRING or (STRING STRING ...){.*(STRING STRING ...)}

"A single string, or multiple strings delimited with a bar, optionally followed by ".*" plus multiple
strings delimited with a bar."
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Example 1

When the main study description contains "CHEST" or "THORAX," the relevant priors to auto-open
are CT studies whose descriptions also contain "CHEST" or "THORAX."

Prior Options

ize Current Modality

Main
Study
Modality | Body Part | Deseoription Body Part | Main Snuely Deseription

{CHESTITHORAX) | (CHEST, THORAX)

Prior settings on the left... ...main study settings on the right

Example 2

e When the main study description contains "CLAVICLE," SCAPULA," or "SHOULDER" followed

by "LEFT," "LT," or "BI," the relevant priors to auto-open are those whose descriptions also
match those criteria.

e The same is true for the RIGHT shoulder.
e Priors of the same modality as the main study are opened first.

Prior Options

#arto Open Prior

Relevant Priors

Ao Open Pricr Cour | 1 o |

MWain
Study
| Modality | Body Part | Description Body Part | Main Study Description

Note: You can also define relevant priors to auto-send (see Configure routing rules).
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Configure overlays
You can configure the appearance and contents of overlays.

Procedure

1. In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select OVERLAYS.

3. Enter the settings in the following table.

Font Family Select the font used for overlays.
Size Select the font size used for overlays.
Modality Select to which modality the overlay settings apply. You can enter

modality-specific settings or select all modalities.

Left/Right Field Click inside the box and then:

Overlay
e Select a property from the list, or

e Type a DICOM tag (e.g. 0020,0010)

Prefix If you typed a DICOM tag in the Field box, type a tag prefix.

Mask Optional. Type attributes that describe mask operations for a
multiframe image (see the DICOM standard).

Bottom FOV/MAG/W/L Displays the field of view, magnification, and W/L for each series in
Overlay the bottom corner.

4, Select ADD
Result: The tag appears at the bottom of the list.
5. Optional. Drag the tag to a new position in the list.

6. Select SAVE.

Add or remove toolbar tools

You can add or remove tools from various viewer toolbars in the program, and customize your choices by
modality.

Note: Not all toolbar tools can be removed.

Procedure

1. In the Symmetry PACS viewer, in the upper toolbar, select the setting ﬂ button.

2. Inthe Viewer Settings dialog, in the left pane, select TOOLS.
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3. Under Toolbar, select the modality whose toolbar you want to customize.
4. Inthe list, select one of the following toolbars to customize.
MAIN - The toolbar at the top of the viewer.

TOP/BOTTOM/LEFT - The toolbar accessible by pointing to the top, bottom, or left edge of an
image.

5. Under Tools, select or clear the checkboxes of the tools that you want to add or remove.
6. Select SAVE.
See also:

Viewer toolbar tools

Add or remove tools from the image shortcut menu

You can add or remove tools from the shortcut menu that appears when you right-click an image, and
customize your choices by modality.

Procedure
1. In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.
In the Viewer Settings dialog, in the left pane, select TOOLS.
Under Toolbar, select the modality whose shortcut menu you want to customize.

2

3

4, 1In the list, select CONTEXT MENU.

5. Under Tools, select or clear the checkboxes for tools that you want to add or remove.
6

Select SAVE.

Assign toolbar keyboard shortcuts
You can assign keyboard shortcuts ("hot keys") to tools, and customize shortcuts by modality.
Procedure

1. Inthe Symmetry PACS viewer, in the upper toolbar, select the setting E button.

2. Inthe Viewer Settings dialog, in the left pane, select TOOLS.

3. Under Toolbar, select the modality for which you want to assign shortcuts.
4. 1Inthe list, select KEYBOARD SHORTCUTS.
5

Under Tools, select the checkboxes of the tools to which you want to assign shortcuts.
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In the Shortcut box, type the keyboard shortcut. The shortcut can be one of the following, either
by itself or preceded by the Ctrl key:

e Alphanumeric character (A-Z, a-z, 0-9)
o Arrow key (Up, Down, Left, or Right)
e Basic math operator (+, -, ¥, /)

Select SAVE.

Configure opening of a third-party program

You can configure Symmetry PACS to open third-party programs such as Ikonopedia, PowerScribe 360,
and MModal.

Prerequisites: Install Exa Launch, Add a trusted IP or URL.

Procedure

1.
2.

8.
9.

In the Symmetry PACS viewer, in the upper toolbar, select the setting ﬂ button.
In the Viewer Settings dialog, in the left pane, select GENERAL.

Under Display Settings, in the table of monitors, on the row corresponding to the monitor on
which to open the third-party application, select the row’s DISPLAY checkbox.

In the row’s Orders dropdown list, select the application (such as PS360 or MModal).
In the left pane, select INTERFACE.

Under Other Toolbar, in the Auto Open Orders group, select the application (such as PS360 or
MModal).

In the left pane, select TOOLS.
Under Toolbar, select MAIN, and then in the right pane, select the External Tools checkbox.

In the left pane, select EXTERNAL TOOLS.

10. Enter the settings in the following table, and then select ADD.

Title Type a title for the program.
Description Type a description of the program.
Command Type the command to run when you select the toolbar button (such as the path to

the executable, or a URL).

Arguments Type arguments to pass to the command at runtime.
Symmetry PACS supports the following arguments:

{{account_no}} (patient ID)
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{{id}} (study ID)
{{accession_no}}
{{facility_id}}

{{username}}

{{user_id}}

{{patientName} }
{{patientDOB} }
{{patientSex} }
{{studyDescription}}

{{series_uid}}

{{image_uid}}

Initial Directory Type the path to the root folder.

Keyboard Shortcut| Optional: Type a keyboard key sequence to use as a shortcut for opening the
program.

Toolbar Button Optional: Select to add a dedicated button for the application on the viewer toolbar.

Do not Base-64
Encode URL
Arguments

Use Facility ID for | Do no select (reserved for PenRad).
Subdirectory

Configure opening of Visage RIS
You can configure Symmetry PACS to integrate with Visage RIS.

Prerequisite: Install Exa Launch and Install Exa Tool.

Enable integration with Visage RIS

1. In the Symmetry PACS viewer, in the upper toolbar, select the setting E button.
2. Inthe Viewer Settings dialog, in the left pane, select INTERFACE.

3. Inthe Auto Open Orders list, select Visage RIS.

Select a monitor
1. Inthe left pane, select GENERAL.

2. Under Display Settings, on the Orders list of the monitor to use, select Visage RIS.
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Viewer Settings

GEMERAL

INTERFALCE

MOLALITY

MAMMOGRAPHY

OVERLAYS

TOOLS

EXTERNAL
TOOLS

Display Settings

Monitors o Sysiem 3
Monitor Currernt
O oispLAv O
B oiseLavz ®
B oispLavs o

Autosave Options

O Awosave Image Propertios on Close
[0 Awtosave image Annotations on Close
[ haste Mark Read Study on Close

[ Awte Upload Dictation on Close

[0 Awtesave Viewer Settings on Close

Create a profile for Visage RIS

1.

In the left pane, select EXTERNAL TOOLS.

Prior

0

@]

orders

Mone v

Enabled tems
Transcriplion
Others

Alle
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Viewer Settings

GEMERAL

INTERFACE

MODALITY

MAMMOGRAPHY

OVERLAYS

TOOLS

EXTERNAL
TOOLS

Title *

Descriplion *

Command

Arguments

Initial Directory

Keyboard Shortcut

Vizage
“isage RIS
exatfflaunch/g=

| accession_no=({{accession_nc Tl |

Toolbar Button
] Do not Base-64 encode URL arguments

[0 use focility ID for subdireetory

2. Enter the following settings, and then select ADD.

Title Any, such as "Visage"

Description Any, such as "Visage RIS"

Command exal : / /1 aunch/ gq=

Arguments accessi on_no={{accessi on_no}} &nd=vi sageri s

Initial Directory

[Leave blank]

Keyboard Shortcut

Optional: Type a keyboard shortcut.

Toolbar Button

Select (adds a Visage RIS button to the viewer toolbar).

Do Not Base-64
Encode URL
Arguments
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Use Facility ID for [Leave cleared]
Subdirectory

3. Select SAVE.

500-000577A 221



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Lines, curves, shapes, and text
You can draw linear shapes and add text to images.

Draw lines and shapes

You can draw rectangles and ellipses on images.
Procedure

1. On the viewer toolbar, select one of the following tools.

e Rectangle E
e Ellipse
e Straight line ﬂ
o Arrow

2. Drag on the image to create the shape.
Optional:

¢ To move a shape, drag any part of its outline.
e To resize a shape, drag any of its handles.

Draw freehand lines
You can draw freehand lines on images.

Procedure

1. On the viewer toolbar, select the pencil tool.
2. Drag on the image to draw a freehand line.

3. Optional. You can drag any points along the line to modify it.

Draw a curved shape
You can draw curved shapes on images.

Procedure

1. On the viewer toolbar, select the curve ﬂ tool.
2. Select at least three times on the image to specify a start point, a vertex, and a second vertex.

3. Double-click to close the shape.
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Add text

You can add a text annotation to an image.

Procedure
1. On the viewer toolbar, select the text tool.
2. Inthe box, type text and then select Enter.

Note: There is no character limit, but carriage returns are not supported, and long text may
extend beyond the visible image boundary.

500-000577A 223



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Markers
You can add markers to images, such as for left and right.

Add a dot
You can add a dot marker to an image.

Procedure

1. On the viewer toolbar, select the dot ﬂ tool.

2. Select on the image to place the dot.

Add a vertical or horizontal line
You can add a vertical or horizontal line to an image.

Procedure

1. On the viewer toolbar, select the vertical I. or horizontal . line tool.
2. To add the line, select on the image.
3. Drag the line to position it.

Note: To reveal the endpoints, you can drag a vertical line up or down, or a horizontal line left or
right.

Add a left or right marker

You can add a left or right marker to an image.

Procedure
1. On the viewer toolbar, select the left or right marker tool.
2. To add the marker, select on the image.

3. Drag the marker to reposition it.
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Measurements
You can take various linear and angular measurements of images. Completed measurements remain as
annotations. To adjust measurements easily, we recommend turning on Edit mode before taking

measurements (see Edit annotations).

Measure an angle

You can measure an angle on an image.

Procedure

1. On the viewer toolbar, select the angle E tool.
2. Select on the image three times to place a vertex and two endpoints.

3. Move the pointer to position the angle measurement, and then select to finish.

Measure a Cobb angle
You can measure a Cobb angle on an image.

Procedure

1. On the viewer toolbar, select the Cobb angle E tool.
2. Drag on the image to place the first angle line.

3. Drag again to place the second line.
4

Move the pointer to position the angle measurement, and then select to finish the angle.

Measure an HO angle

You can measure an HO angle on an image. An HO angle measures the degrees of the angle drawn
relative to true vertical and horizontal.

Procedure

1. On the viewer toolbar, select the HO angle ﬂ tool.
2. Select on the image to place a starting point.

3. Select to place the end point.

500-000577A 225



Symmetry® PACS 1.4.32_P4 User's Manual symmetry-rPACS

Measure a radial angle or length
You can measure a radial angle or length on an image.

Procedure

1. On the viewer toolbar, select the radial angle or radial length mal tool.
2. Select on the image to place the axes.

3. Drag the axes or their endpoints to take measurements.

Measure an elliptical or freehand ROI
You can measure properties of an ROI by drawing an ellipse or a freehand shape. The viewer displays the

ROI's length (mm), area (mmz), and the minimum, maximum, mean, and standard deviation in

Hounsfield units.

Procedure

1. On the viewer toolbar, select the ROI ﬁ or free ROI E tool.
2. Drag on the image to place the ellipse or the freehand shape.

3. Drag the outline or handles of the shape to adjust the ROIL.

Measure a length

You can measure a length (mm) on an image.

Procedure
1. On the viewer toolbar, select the measure tool.
2. Drag on the image to place the measurement line.

3. Drag the outline or endpoints of the line to adjust the measurement.

Measure and compare two lengths

You can measure the lengths (mm) from two starting points to an endpoint for comparison.
Procedure

1. On the viewer toolbar, select the M compare H tool.

2. Select three times on the image to place a starting point, endpoint, and second starting point.

3. Drag any of the three points to adjust the measurement.
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Take a freehand measurement
A freehand measurement is similar to freehand ROI, but it measures different values: angle; radius
(mm); area (mmz); and length (circumference in mm).
Procedure
1. On the image shortcut menu, select Annotations > Measures > FH Measure.
2. Select three times on the image to place a vertex and two endpoints.

3. Move the pointer to position the circle measurements, and then select to finish.

Find a center point
You can find the center between two reference points.
Procedure
1. On the image shortcut menu, select Annotations > Measures > Center Point.
2. Select twice on the image to place the first and second reference points.
Note: The center point is indicated by an x.

3. Drag either of the reference points to adjust the measurement.

Draw a circle and measure its radius
You can draw a circle and measure its radius (mm).

Procedure

1. On the viewer toolbar, select the circle @ tool.

2. Select twice on the image to place two loci.

3. Move the pointer to adjust the circle, and then select to add a third locus.
4

Drag any locus to resize or reposition the circle.
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Spine labels

You can add preset labels for spinal vertebrae and discs to MR images. Labels are grouped by region
(cervical, thoracic, lumbar, and sacral), plus another group for all discs. Basic labels do not include height
and width measurements, whereas non-basic labels do. 3D labels appear in all frames and planes,
whereas non-3D labels appear only in the individual frames to which you add them.

Add basic spine labels
You can add basic spine labels to vertebra in ascending or descending order.

Procedure

1. On the viewer toolbar, select the basic spine label tool.
2. In the button shortcut menu, select a region and starting vertebra.
Note: Choose “Up” to apply labels in ascending order, or “Down” for descending.

3. Select on the first vertebra to add the first label, and then select on the second vertebra, and so
on.

Add basic 3D spine labels
You can add basic 3D spine labels to vertebrae in ascending or descending order.

Procedure

1. On the viewer toolbar, select the quick 3D spine label tool.
2. In the button shortcut menu, select a region and starting vertebra.
Note: Choose “Up” to add labels in ascending order, or “Down” for descending.

3. Select on the first vertebra to add the first label, and then select on the second vertebra, and so
on.

Add 3D spine labels
You can add 3D spine labels in ascending or descending order.

Procedure

1. On the viewer toolbar, select the 3D spine label shortcut tool.
2. In the button shortcut menu, select a region and starting vertebra.

Note: Choose “Up” to add labels in ascending order, or “Down” for descending.
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3. Select twice on a vertebra to place a starting point and endpoint.

4. Repeat the previous step to label additional vertebrae.

Use a spine label shortcut
You can use a spine label shortcut to quickly start labeling from a common starting vertebra.
Procedure
1. On the viewer toolbar, select the spine label shortcut , 3D spine label shortcut , or 3D quick
spine label shortcut tool.
2. In the button shortcut menu, select a starting vertebra.

3. Add labels.
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3D

3D labels appear in the image where you add them, and the same slice in other series.

Use the 3D cursor

When you place the 3D cursor on one series, the cursor also appears in the corresponding location in any
cell of the same study that is open in the viewer.

Procedure

1. Open two or more series of the same study (for example, an axial, sagittal, and coronal view).

2. On the viewer toolbar, select the 3D cursor bl tool.
3. Hover over an image in one cell.

4. The cursor appears in the same location in the other cells.

Add a 3D point

You can mark a 3D point on an image. The point you place in the current image appears in the
corresponding position in all frames and planes.

Procedure
1. On the image shortcut menu, select Annotations > 3D Point.

2. Select on the image to place the point.

Add a 3D ray

You can mark a 3D ray on an image. The vertex you place in one frame extends as a ray through the
stack and is visible in other planes.

Procedure
1. On the image shortcut menu, select Annotations > 3D Ray.

2. Select on the image to place the vertex of the ray.

Add a 3D ROI

You can mark a circular ROI in one image, and the program adds the ROI to the same image in other

series in the viewer. The viewer displays the ROI's length (circumference in mm), area (mmz), and the
maximum, minimum, mean, and standard deviation in Hounsfield units.
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Procedure
1. On the image shortcut menu, select Annotations > 3D ROLI.

2. Select twice on the image to place the center point and a tangent point.

Add a 3D length measurement

You can take a linear measurement (mm) in one image, and the program adds the measurement to the
same image in other series in the viewer.

Procedure
1. On the image shortcut menu, select Annotations > 3D Measure.

2. Select twice on the image to place the first and second endpoints of the measurement line.

Add a 3D angle measurement

You can take a 3D angle measurement in one image, and the program adds the measurement to the
same image in other series in the viewer.

Procedure
1. On the image shortcut menu, select Annotations > 3D Angle.

2. Select three times on the image to place the vertex and the first and second endpoints of the
angle.
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Shutters

You can add rectangular, elliptical, or freehand shutters.

Add a rectangular or elliptical shutter
You can add a rectangular or elliptical shutter to “crop” unwanted areas of an image.

Procedure

1. On the image shortcut menu, select Annotations > Shutters > Shutter Box or Shutter Ellipse.

2. Select twice on the image to place a starting point and endpoint for the shutter.

Add a freehand shutter

You can add a freehand-drawn shutter to "crop" unwanted areas of an image.

Procedure

1. On the image shortcut menu, select Annotations > Shutters > Freehand Shutter.

2. Drag on the image to draw the shutter.
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Other annotation tasks

Add an AR annotation
You can plot points to represent angular rotation.

Procedure

1. On the viewer toolbar, select the AR ﬂ tool.

2. Select six times on the image to place guide points.

Edit annotations

After you finish an annotation, it is fixed in place to prevent accidental alteration. To move, edit, or delete

an annotation, either select the tool that created it, or select the edit tool to enter Edit mode. You
can select the edit tool again to exit Edit mode.

Saving and deleting annotations

You can save or delete annotations as follows.
- |
e To save the current annotations, on the toolbar, select the save annotations button.

e To delete all annotations, on the toolbar, select the delete all annotations ﬂ button.

e To delete all annotations for the current series, on the image shortcut menu, select Delete Series
Anno.

e To delete all annotations for the current study, on the image shortcut menu, select Delete Study
Anno.

Reset an image in the viewer
When making non-permanent modifications to images in the viewer (zoom, rotation, Window/Level
etc.), you can reset the image to its original state.

¢ On the viewer toolbar, select the reset viewerﬂ button.
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Change elements in the viewer
Show or hide overlays

You can turn overlays on or off. Note, PR (GSPS) DICOM objects from Intelerad are supported as
overlays.

e On the viewer toolbar, select the overlay ﬂ button to turn overlays on or off.

e To show a preset DICOM overlay, in the image shortcut menu, select DICOM overlay, and then select
an overlay.

Show or hide annotations
You can turn annotations on or off. Note that

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E

2. In the shortcut menu, select Show Annotations.

Show series and stacks

If the viewer is showing only a single frame of a series or stack, you can change it to display all series and
stacks.

e On the viewer toolbar, select the reset series and stacks @ button.

Show or hide cutlines

Cutlines show the intersection between two open series. The cutlines update dynamically as the user
moves through a series. A dashed cutline indicates where the first image starts and the last image ends.
A solid cutline indicates the intersection of the currently displayed locations in the series. If a series
includes intersecting images, you can show or hide cutlines.

¢ On the viewer toolbar, select the cutlines button.

Split series by image thickness
You can use slab tools to split series by image thickness.

Procedure

1. Inthe upper-right corner of a frame, right-click the menu icon E
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2. In the shortcut menu, select Slab Tools, and then select a slab thickness.

Recalibrate the scale

You can manually recalibrate the scale measurement, which is shown on the caliper of the current
series.

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E
2. In the shortcut menu, select Recalibrate.

3. Inthe dialog, type a new value (mm) for the scale, and then select OK.

Change the series layout
You can change the number of series panels displayed in the viewer.

Procedure

1. In the upper-right corner of a frame, right-click the menu icon E

2. Inthe shortcut menu, select Series Layout, and then select a layout.

Reorder a series
You can change the order of images in a series.

Procedure

1. Inthe upper-right corner of a frame, right-click the menu icon E

2. In the shortcut menu, select Reorder, and then select one of the following options.
Image Number - Arranges the images by number in ascending order.
Image Number Inverse - Arranges the images by number in descending order.

Slice Location - Arranges the images by relative location (in mm) in the plane in ascending
order.

Slice Location Inverse — Arranges the images by relative location in the plane in descending
order.

Image Time - Arranges the images by the time they were taken.
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Change the appearance of images

How the viewer chooses the initial window/level

There are many sources of window/level settings. When the viewer displays an image, it chooses the
window/level settings from the first available of the following sources, in order.

e Last display state, if “Auto saved image properties on close” is turned on

e LUT (from prefetch), unless “Ignore LUT” or “Ignore Presentation LUT” is turned on
e DICOM tags - the window center and window width tags

e VOI LUT DICOM tags - value of interest LUT tags

¢ Manual W/L settings, if adjusted by the user

Turn on auto window/level

The viewer can automatically adjust the window/level so that images are, to the extent possible, neither
too dim nor too bright.

e On the viewer toolbar, select the auto window/level button.

Adjust the window/level

You can manually adjust the window/level.

e On the viewer toolbar, select the window/level ﬂ button.
e Drag horizontally over the image to adjust the window.

e Drag vertically over the image to adjust the level.

Apply a window/level preset
You can apply a window/level preset to the current study.

e On the image shortcut menu, select Presets, and then select a preset.

Apply CLAHE enhancement

You can apply CLAHE to enhance local contrast.

e On the viewer toolbar, select the CLAHE button to turn CLAHE on or off.
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Apply bone enhancement

You can use different levels of bone enhancement to optimize the contrast between bone and other
tissues. You can also apply color inversion to further highlight fractures and other features of bone.

Procedure

1. On the viewer toolbar, select the bone enhance ﬂ button.

2. Inthe button shortcut menu, select a percentage.

Invert colors

You can invert black and white values to make certain images easier to read.

e On the viewer toolbar, select the invert colors IJ button.

Add color to images
You can add color to images.
Procedure

1. Right-click the overlay in the lower-right of the image, and then in the shortcut menu, select
Palettes.

2. Select a colorin a palette.

Apply sigmoid processing
You can apply sigmoid processing to enhance low-contrast images.

e Right-click the overlay in the lower-right of the image, and then in the shortcut menu, select
Sigmoid.

Reset and Reset study object

You can access the Reset and Reset study object commands in the image shortcut menu. Reset undoes
all unsaved changes (such as W/L and annotations) made to the current series. Reset study object
updates the viewer after new images are added to a study that is currently open.
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Add to new UNQ study

A UNQ (unique) study is a teaching study. When you select this command in the image shortcut menu, a
button appears on the toolbar to open the teaching study screen. See, “Create a teaching study.”
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Scaling images

Zoom images

You can zoom in on (enlarge) or out of (reduce) images for optimum viewing. There are several ways to
zoom:

e On the viewer toolbar, select the zoom E tool and then drag on the image.

e Select the zoom tool in the image shortcut menu: Tools > Zoom.

e Drag the pointer across a caliper (if Caliper Zoom is selected, see Configure other interface settings).
¢ Right-click the lower-right overlay, select Enter Zoom, and then type a value from .05 to 7.5.

e “Quad zoom”: Use the left or right angle bracket keys (< >).

Display one to one

If you zoomed an image you can restore it to its original DICOM size. This is essentially “life size.”

e On the viewer toolbar, select the one to one button.

Display images in their actual size

You can display images in their original size.

¢ On the viewer toolbar, select the actual image size E button.

Fit images to window

You can automatically zoom an image so that its longest dimension fits in the visible frame.

¢ On the viewer toolbar, select the fit to window E button.

Use the magnifying glass

You can use the magnifying glass tool to zoom an area of the current image.

e On the viewer toolbar, select the magnifying glass “ tool, and then select and hold over the area to
magnify.
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Linking images
When two series are open side-by-side in the viewer, linking them causes moving through images in a
second series when you move through images in the first series.

Auto link images

Auto linking means that linking turns on automatically when two or more series of the same plane (such
as axial) are open. With auto-linking, the system uses the image numbers to automatically match up the
frames in each series so that the frame in the second series is as near in stack order to the image in the
first series as possible.

¢ To auto link images, on the viewer toolbar, select the auto link button.

Manually link images

Manual linking means that you turn linking on and off manually when two or more series are open. This is
frequently used to move through a recent image and a corresponding prior, side-by-side.

e To manually link images, on the viewer toolbar, select the manual link button.

Note: For mammogram images, you can only link LCC and RCC with each other; similarly you can
only link LMLO and RMLO with each other.

Use the context tool

You can automatically jump to an image in a linked series that most closely matches the angle (X, Y, and
Z position) of the image in the current series.

e On the viewer toolbar, select the context tool .

Reset linked series

You can reset (undo) image linking by selecting the reset linked series button. This may take time
depending on the size of the series.
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Moving and jumping to images
Pan images

You can pan an image to view any portions that extend beyond the visible frame.

Procedure

1. On the viewer toolbar, select the pan tool.

2. Drag the image in any direction.

Move or span through images

You can move or span through images in a series. Spanning means to move rapidly with minimal hand or
wheel motion.

To adjust the span sensitivity, see Configure the toolbar.
e To move: Hover over the image and rotate the mouse wheel.

e To span: On the image shortcut menu, select Tools > Span Images, and then drag on the image.

Flip or rotate images
You can flip images 180 degrees, or rotate them 90 degrees. From the image shortcut menu:
¢ Select Transformation > Flip Horizontal or Flip Vertical.
¢ Select Transformation > Rotate Right or Rotate Left.
Play cine loops
When viewing a series, you can play cine loops and shuttle between frames.
Procedure
1. On the viewer toolbar, select the cine button.
2. Cine play starts, and the media control bar appears.

3. Use the media control bar to pause, move to the first or last frame, and move to the previous or
next frame.
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Specify key images

You can specify key images in a series that you can jump to at any time. You can add key images
thumbnails on reports.

Procedure
1. Display the image that you want to be a key image.

2. On the image shortcut menu, select Set Key Image.

Jump to a key image
If you specified a key image in the current series, you can jump to it (display it in a frame in the viewer).
Procedure
1. At the top of the thumbnail pane on the left side, select Keyimage.
The thumbnail pane shows thumbnails of your key images.

2. Double-click a key image thumbnail.

Open a series image in a 1x1 frame

If a series is open in a layout other than 1 x 1, double-click any image to openitina 1 x 1 layout.

Jump to a BTO image by SR finding
To quickly open a BTO image that has a specific SR finding:
Procedure
1. Open the tomosynthesis series that contains the image.
2. On the 2D or synthesized view, select the SR finding of interest.
Result: The corresponding slice opens. Note the following:

e The slice that opens is of the same view type (e.g. select a finding on an RCC to open a BTO
RCC slice).

e Ifthe BTO series is not displayed within the current layout, the series opens next to the 2D or
synthesized view in a 1x2 layout. To restore the original layout, select the backslash (\ ) key.

Triangulate images
You can move to images and points in multiple series at the same time.

Procedure

500-000577A 242



Symmetry® PACS 1.4.32_P4 User's Manual symmeltry-PACs

1. On the viewer toolbar, open two or more series.

2. Select the Triangulation ﬂ button, and then do one or both of the following.

e Double-click a series to open the corresponding slice in the other series.
e Move the pointer in one series to move the pointer to the corresponding position in the other
series.
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Use MPRtools
Multiplanar reformation (MPR) creates images in orthogonal planes (axial, coronal, sagittal or MIP)
relative to a base image. The MPR tool is hidden until you open a series.

Perform simple MPR

You can perform simple MPR to generate a single alternate planar view from the base view.
Prerequisite: If performing MPR on a fusion study, wait until both series are fully pre-fetched.
Procedure

1. Open a series, and then double-click an image to view it full screen.

2. Select the arrow on the right side of the MPR m button.
3. In the button shortcut menu, select a plane.

4. The viewer performs MPR and displays the new plane.

Perform standard MPR
You can perform standard MPR to generate three additional planar views of the base image.

Prerequisite: If performing MPR on a fusion study, wait until both series are fully pre-fetched.

e Open a series, and then select the MPR m button.

Note: The plane of the base image determines the default MPR plane.

Handle MPR images

You can handle MPR images in the following ways by using controls in the base image.

e To move through MPR images, drag the blue region bars. You can also drag the endpoints to adjust
the viewing angle.

e To move both region bars at the same time, on the toolbar, select the context tool , and then drag
on the base image.

e To change the slice thickness, double-click the thickness value, and then type a new value (or drag
the thickness value).

e To change the slab width, select Region, double-click the slab width value, and then enter a new
value (or drag the slab width value).

e To display an MPR image full screen with a large thumbnail of the base image, double-click an MPR
image.
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Save an MPR series
After you perform MPR, you can save the resultant images and series for later viewing.
Procedure
1. Perform MPR.
2. Right-click a generated cell, point to Save MPR, and then select Instance or Series.
3. Inthe Create MPR Series/Instance dialog, type a description, and then click save.
Result: A thumbnail for the saved instance or series appears on the thumbnail bar.
See also:

Perform simple MPR
Perform standard MPR
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Work with Display Management

With the viewer’s display management functions you can create and manage highly customized “DMs.”
The term DM refers to display management in general, or to an implementation of a hanging protocol. By
using DMs you can precisely customize how images “hang” in the viewer.

Configure viewer settings for DMs

Before working with DMs, configure the settings described in the following sections in this manual.

Set up connected displays
Next, configure viewer settings as follows.

Procedure

1. On the worklist, select settings E, select Viewer Settings, and then in the Viewer Settings
dialog, on the left pane, select MODALITY.

2. In the list of modalities, select a modality that you work with (such as CT or MG).
3. To turn on DMs, in the settings area under Options, select the following checkboxes.

e Auto Hang DM
DM Allow Missing Cell
e Auto Hang Priors

4. To view priors, under Prior Options, configure the following.
a. Select the Auto Open Prior checkbox.

b. In the Auto Open Prior Count dropdown list, select the maximum number of priors to open
at once.

5. Select SAVE.

6. Repeat for each modality that you work with.

Show the DM toolbar

The DM toolbar gives you quick access to DM related functions. You can manually display the DM toolbar
in the viewer, or configure the viewer to display the DM toolbar automatically for selected modalities.

¢ Manually: In the viewer, select the display managern button, and then in the button shortcut
menu, select Show DM Toolbar.

¢ Automatically: On the viewer toolbar, select the settings E button. Select MODALITY, select
modalities, select the Show DM Toolbar checkbox, and then select SAVE.

See also:
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Use the DM toolbar

Display images with a DM

You can select from a list of previously configured DMs to hang the current study. If you show the DM
toolbar in the viewer, you can select a DM on the toolbar. If you did not show the DM toolbar:

Procedure

1. Open a study in the viewer.

2. On the toolbar, select the DM ﬂ button.
3. On the button shortcut menu, select one of the DMs in the list.

Note: DMs are listed between the first item in the menu, “None,” and “DM Manager.”
4. Optional. You can change the view as follows.

¢ Rotate the wheel to page through any additional images in the study that the DM can hang.
e Drag a thumbnail onto a cell to display it there.
e Use the left or right bracket keys ( [ or ] ) to move to the next or previous DM step.

Use the DM toolbar

As in the following figure, the toolbar contains tools on the left, and DMs (RCC 3D and RCC/LCC Tomo)
on the right side of the tools. Use the toolbar as follows.

BTO RCC BTO RCC BTO LCC

RCC/LCC Tomo

e Save: Saves a new DM based on the current layout.

e Save Study: Saves the current configuration for the current study only.

e Update: Overwrites the current DM with properties taken from currently displayed images.
CAUTION: Selecting this button deletes all settings of the current DM.

e Manage: Opens the DM manager.
e Reset: Select to apply any newly created or edited DMs.
e Refresh: You can also refresh DMs to update the list of applicable DMs.
e [DM]: Select any DM on the DM toolbar to apply it in the viewer.
Find and open a DM for editing
If you have a large number of DMs you can find a specific one, and then open it for editing.

Procedure

1. On the viewer toolbar, select the display managerm button.
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2. In the button shortcut menu, select DM Manager.
3. In the DM Manager dialog, enter one or more of the following search criteria.
User Groups - Select the group to which the DM user belongs.
Users - Select the DM user.
Filters — Select whether the DM is private (user-specific) or public.
Modality - Select the modality associated with the DM.
Name - Type all or part of the name of the DM.
4. Select SEARCH.

Result: DMs matching your search criteria appear in the list at the bottom of the dialog.

5. To open the DM for editing, double-click it, or select its edit 74 button.

Edit, delete, duplicate, or copy a DM

Each DM has four buttons on the right side of the list: ¢ W >

These buttons do the following.
Edit - Opens the DM for editing (for configuration, see Add a DM).
Delete - Deletes the DM from the list.
Duplicate - Duplicates the DM and prompts you to name the duplicate.

Copy - Sends a copy of the DM to a user group or user.

Export and import DMs
You can export DMs for use in other Konica Minolta systems.
Procedure
1. Find and select one or more DMs to export.
2. Select EXPORT SELECTED or EXPORT ALL.
The DMs are added to a single JSON file and downloaded to your computer.

3. Copy the file to the destination system, display the DM Manager dialog, select IMPORT, and
then open the exported JSON file.
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Add a DM
To add a DM:

Procedure

1. On the viewer toolbar, select the display managern button.
2. In the button shortcut menu, select DM Manager.
3. Inthe DM Manager dialog, select ADD NEW DM.
4. In the second DM Manager dialog, enter the following settings.
Name - Type a name for the DM.
Inactive - Select to disable the DM until ready for use.
Private - Select to make the DM available only to you.
Modalities - Select one or more modalities to which the DM applies.
Body Part - Prevents all but the selected body part to display.
To display any body part, leave blank.
Page Count - The number of monitors that the DM uses to display images.

5. Under Preview, in the upper-left corner of the frame, select 1*1 and select a cell layout for the
study-level series/images within the monitor.

6. Optional. Select 1*1 in of the cells, and select a series layout for the series-level images within a
cell.

7. Optional. To allow missing cells, in the upper-right corner of a page or cell, select the checkbox

(see About missing cells).

Preview 8% Page Count * 3
1#1 s L 2%2 0
O O O i £ O
O

Figure. In this example, 3 pages (monitors) are configured, with 1, 2, and 4 cells added to each page,
respectively. On the second page, Allow Missing Cells is selected at the page level, which means that either the
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left, right, or both cells can be blank. On the third page, the study will hang if images for the lower-right cell are
missing, but not if they are missing in any other cells. The upper left cell is selected for adding a matching rule
group and/or matching rule. Because the validation percentage is not yet 100%, matching rules must be added.

8. Note the validation percentage, and then select SAVE.

9. If the validation percentage was not 100%, you must add a matching rule that yields 100%.
Continue to “Add a matching rule group.”

About the order of DMs in the DM manager

When you open a study in the viewer, Symmetry PACS finds all DMs that match the study, and then
hangs the study using the one that was highest in the list in the DM manager. It also makes all matching
DMs available to you in the DM toolbar and in the DM button shortcut menu. You can change the default
order of DMs in the DM manager by dragging them in the list.

About missing cells

By default, DM pages and cells do not allow missing cells. This means that if no image exists in the study
that can hang in one of the cells on a page, no images hang at all on the page. For example, if you
configured a DM to display a current image in the left cell and a prior in the right cell, but no prior is
found, then the current image does not hang.

Sometimes it is preferable to allow missing cells. For example, if you configured your DM to display up to
three priors, but only two priors are found, you still want to display the current image and the two priors.

Add a matching rule group

You can group matching rules and apply AND/OR logic to them. If set to AND, all rules in the group must
be true to hang images, and if set to OR, at least one rule must be true. Adding a matching rule group is
optional, but we recommend doing so for most applications.

Procedure

1. In the DM Manager, in the list of DMs, double-click to open the DM to which you want to add a
matching rule group.

2. Under Preview, select a cell.
3. At the bottom of the window, on the MATCHING RULES tab, select ADD GROUP.

The new group initially appears as a row of buttons under the ADD GROUP button.
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MATCHING RULES DISPLAY MANAGEMENT

ADD GENERAL RULE ADD MAMMO RULE ADD PRIOR RULE
ADD GENERAL RULE|ADD MAMMO RULEJADD PRIOR RULE|DELETE GROUP i ’

The matching rule group is the row of buttons on the bottom. No rules have been added to the group.

4. Add one or more rules to the group.
5. Inthe list on the right side of the dialog, select a relationship of AND or OR.
6. At the top of the dialog, select SAVE.

See also:

Add a general matching rule to a DM
Add a prior matching rule to a DM

Add a general matching rule to a DM

When you add a DM, the modality, body part, and allow missing cell settings you enter roughly determine
which images hang where in the DM. You can also finely determine this by using general matching rules.

General matching rules consist of an argument, logical operator, and matching value. For example:

Study Date (arg.) is Less/Equal (operator) to 01/02/2003 (matching value).

Procedure
1. Open the DM to which you want to add matching rules.
2. Under Preview, select the cell to which to apply the rule.
3. At the bottom of the window, on the MATCHING RULES tab, select ADD GENERAL RULE.

Note: If you created a group and you want the rule to be included in the group, select the button
that is inside the group.

In the Matching Tag dialog, enter the following settings.

DICOM Tag/Field - Select a tag to use as the argument.

Operator - Select an operator.

Matching Value - Type a matching value, and then select the plus sign.
Modify the rule until the validation percentage is 100%, or add another rule.
Select SAVE.

In DM Manager, select SAVE.
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Add a prior matching rule to a DM
To hang priors, add a prior matching rule to the destination DM cell.
Procedure
1. Open the DM to which you want to add prior rules.
2. Under Preview, select a cell.
3. At the bottom of the window, on the MATCHING RULES tab, select ADD PRIOR RULE.

Note: If you created a group and you want the rule to be applied to the group, select the button
that is inside the group.

4. In the Prior Rule dialog, select the index of the prior that you want to hang in the cell.
Note: Selecting ANY allows you to move through all available priors when viewing a single DM.
5. Select SAVE.

6. In DM Manager, select SAVE.

About the DM validation percentage

The DM validation percentage helps you by indicating, roughly, the percentage of cellsin a DM you are
configuring that would not display any images under the current settings. To achieve 100 percent, apply
a valid condition or rule to each cell in the DM. If the percentage is not 100, Symmetry PACS prevents
you from using the DM at all. You can view the percentage by opening a DM for editing; the percentage
appears on the right side of the Preview area title.

Use the Display Management tab

To automatically apply additional processing to all images that hang in a DM, you can use the Display
Management tab in the DM manager.

Procedure
1. In DM Manager, open a DM, and then select a cell.

2. On the DISPLAY MANAGEMENT tab, enter the following settings.

Auto-Orient [Unused]

Rotation Select a degree of clockwise rotation.

Mirror Select to switch the left and right breast view.
View Select a zoom type.
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Invert
Sigmoid
Linear
CLAHE
Fusion
CAD

Current MG Only

Select one or more processing functions to apply.

Exempts the current cell from the Stack by View and Prior option.

CAD Select to display CAD values according to the SR CAD settings when the
user reaches this step of the hanging protocol.
LUT Select an LUT to apply.

Bone Enhance

Select a percentage of bone enhancement.

Window/Level

Select Default or Custom. If Custom, type the values to apply.

Reprocess

Select to generate an additional view from the base view.

3. Select UPDATE, and then SAVE.

Create a DM from an existing layout

To create a DM more quickly, you can arrange a layout in the viewer, and then save it as a DM.

symmeltry-PACs

A The rules that are created with this method include as many parameters from the source studies

as possible, and may be overly restrictive for general use, or apply unexpected image processing.
Therefore to ensure proper hanging and rendering, review the resultant rules in both the MATCHING

RULES and DISPLAY MANAGEMENT tabs and modify if necessary.

Procedure

1.

2
3.
4

Open a study in the viewer and configure the display to your liking.

On the toolbar, select the DM button, and then in the button shortcut menu, select DM Save.

In the DM Information dialog, type a name for the DM and select or clear the Private checkbox.

Select SAVE.
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Example DM with a general matching rule
In this example we add a DM for viewing chest X-rays with an AP view on the left and a lateral view on
the right. Continuing after step 3 of “DM examples:”

Add the DM

1. In Name box, type CHEST TEST.

2. the Modality list, select CR, and then select DX.

3. Inthe Page Count box, type or select 1.

4. Under Preview, on the page header, select 1*1 and select a 1 x 2 cell layout.

Add a rule group and general rules for the left cell
1. Select the left cell, and on the MATCHING RULES tab, select ADD GROUP.
2. Inthe new group, select ADD GENERAL RULE.
3. Inthe Matching Tag dialog:
e Inthe DICOM Field/Tag list, select Modality.
e Inthe Operator list, select Equal.
e In the Matching Value box, type CR, select the plus (+) button, and then select SAVE.
Note: In practice you may also want to add the DX modality.
4. Following the previous step, add another general rule:
e DICOM Field/Tag = SeriesDescription
e Operator = Contains
e Matching Value = ap
5. On the right side of the matching rule group, in the list, select AND.

This means that the image must satisfy both rules to hang in the cell.

Add general rules for the right cell
1. Select the right cell, and select ADD GENERAL RULE.
2. Inthe Matching Tag dialog, add the following rule:

e DICOM Field/Tag = SeriesDescription

e Operator = Contains

e Matching Value = lat
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3.
4.

5.

Next to Preview, confirm that the validation percentage is 100%.
Select SAVE, and then close the DM manager.

Select F5 to update the viewer with your new DM.

Add a DM group

To keep different sets of hanging protocols for different appointment types and studies, you can combine
DMs into groups.

Procedure

1.
2.

On the burgerE menu, select SETUP.

On the OFFICE menu, select DICOM.

On the HANGING PROTOCOLS tab, under DM Group, select the plus button.
In the DM Group dialog, on the left, type descriptive information for your DM group.
Under Associate group to study by, do one of the following:

e Select APPOINTMENT TYPE, select one or more appointment types in the list, and then
select SAVE.
e Select STUDY DESCRIPTION. In the Study Description box, type a description, and then

select the plus button.

Click SAVE.

Share DMs with a DM group
To add (share) DMs with a DM group:

Procedure

1.
2.

On the burgerE menu, select SETUP.
On the OFFICE menu, select DICOM.

On the HANGING PROTOCOLS tab, find a DM to add to a group.

On the right, select the share < button.

In the Share dialog, select the group with which to share the DM, and then select SHARE.
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Share DM groups with users

By default, DM groups that you create are only available to you. To share a DM groups with other users
or user groups:

Procedure

1. Onthe burgerE menu, select SETUP.
2. On the OFFICE menu, select DICOM.
3. On the HANGING PROTOCOLS tab, under DM Group, select a DM group to share.

4. On the right, select the edit ¢ button.

5. In the Edit DM Group dialog, select SHARE.

6. In the Copy dialog, select users or groups with which to share the DM group, and then select
COPY.

About DM groups and private DMs
When a DM is created by a member of a DM group, the following apply.

Private** Original Creator Read/Write
All Others None
Copy Shared with users Read/Write
Shared with user groups Read-Only
Copy of shared copy Shared with users or user groups Read/Write
Non-Private Original Creator Read/Write
Group members Read-Only
Copy Shared with user group or DM group Read-Only
members

*Read here means view, use to hang studies, or copy to other users.

**Imported DMs are automatically marked as Private for the importing user.

Build a mammography DM

The following is an example of how to build a DM that displays priors on top and current images (RCC,
LCC, RMLO, LMLO) on the bottom. This DM shows all main views and specialty views such as spot and
cleavage, synthesized views, and implant displaced views.
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1. In the viewer, on the toolbar, select the DM button, and then in the button shortcut menu, select
DM Manager.

2. Select ADD New DM.
3. Type a name for the DM, and then enter required settings.

OPTIONAL: In the Body Part list, select Breast.

DM Manager
HP Praperties E
Hame * MG TEST O thactive [ Private
HP Identifier Modality
Meodalities *
Bady Part * Breast b

4. Inthe Page Count box, type the humber of monitors.

Preview 0% Page Count *J2
Allow missing cells
207 11
O - O @ Salect to always show the cal
181 D 141 D D evien if erilena do nol maleh
11 D ™1 D

5. Select the layout numbers (such as 2*2 or 1*1), and then select the number of cells.

6. Select the Allow missing cells check box for each page and/or cell that you want to always
display, even if empty.

7. Select a cell, and then on the MATCHING RULES tab, select ADD GROUP.

8. In the list, select OR, and then select ADD MAMMO RULE.
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MATCHING RULES DISPLAY MANAGEMENT

soinsonis | o

ADD GENERAL RULE ADDMAHMURULE .FDDPRIDRH‘I.ILE I I

“OR” means "this rule, OR any subsequent rules." We build mammography DMs in a group to
have the system look for multiple views, which allows us to use one DM for multiple scenarios.
Groups allow you to have the system look for multiple views, and use one DM for multiple
scenarios.

9. For the top left cell, add the following rule criteria.

Mammo Rule >
e * O Le -
& mght
O3
Wiew CCramly w
DONT CARE

Processing Type * D Unprocessed
> Tomosynshesis
O Eynthesized WView

® Processed
27

Image inday ARy W

-

This means, “Right side, CC Family (All views), any specialty view except ID (Implant
displacement), and processed.”

10. Select SAVE.
Result: Rules matching your criteria appear in the list.
11. Within your group, select ADD MAMMO RULE and add the following additional rules.

e Right, CC Family, Don't Care, Synthesized
e Right, CC Family, ID, Processed
e Right, CC Family, ID, Synthesized

12. From outside the group, select ADD PRIOR RULE for this cell.
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13.

14.

15.
16.

MATCHING RULES

ioomoRAE_ —Roormonmas
—

DOMT CARE / CC / / ANY - Side: Right| Processing Typa: Procassed| = I

DONMT CARE / XCC / / ANY - Side: Right| Processing Type: Processed| o [
Note: The button outside the group applies the rule to the entire group.

For Study Index, select one of the following options.

e Any: Display all allowable MG priors (the allowed number depends on Auto Open settings for
the MG modality).

e 1: Show the first prior

e 2: Show the second prior

In the Display Management tab, customize the way the image displays with the following
options.

Auto orient, rotate, Mirror flip (for Radiologists who view Left on Left, Right on Right), Zoom,
Invert, Sigmoid, Linear, Clahe, Fusion, LUT, Bone Enhance, Window/Level, Reprocess.

Repeat steps above to configure each cell of your DM.

Select SAVE at the top.

See also:

Add a mammo matching rule to a DM

Add a prior matching rule to a DM

Add a mammo rule for breast implant displacement
Add a DM group

Mammography views

Example DM for ultrasound

In this example we add a DM that hangs a 3 x 2 series layout (3 rows, 2 columns) of only ultrasound
images. Continuing after step 3 of “DM examples:”

Add the DM

1.

In Name box, type US TEST.
the Modality list, select US.
In the Page Count box, type or select 1.

Under Preview, select the 1*1 cell (not the page header), and select a 3 x 2 series layout.
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Add a general rule for allimages
1. Select inside the page’s 1*1 cell to highlight everything around the 3 x 2 series-level cells.
2. Add the following general rule.

e DICOM Field/Tag = Modality

e Operator = Equal

e Matching Value = US

3. Confirm that the validation percentage is 100%, and then save the DM.
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Gather information from images
View pixel values in Hounsfield units

You can view the value of a selected pixel in Hounsfield units.

e On the viewer toolbar, select the Hounsfield units W tool, and then select and hold the mouse button
on the pixel of interest.

Display DICOM values

You can display the DICOM tag values associated with the current image by doing one of the following.

e On the viewer toolbar, select the DICOM values button.

e On animage shortcut menu, select View > DICOM Values.

Export DICOM values

When you view DICOM values in the viewer you can export them to a CSV. This CSV file can only be
displayed correctly in Notepad, Notepad++, or Wordpad.

Procedure

1. On an image shortcut menu, select View > DICOM Values.

2. In the title bar of the screen that appears, select the download button.

Result: The file is downloaded to your Windows Downloads folder.

Print images to a standard printer

You can print the current image, series, or study to a TWAIN (non-DICOM) printer. It is a convenient,
less-expensive alternative to DICOM printing, but is not suitable for diagnostic purposes.

Procedure

1. On the viewer toolbar, select the print E button.
2. Inthe Print Image dialog, enter the following settings.
Layout - Select the number and arrangement of frames per page.
Page Size - Select the paper size and print orientation.
Compress large images — Select to compress large images (for lower quality but faster printing).
Selected Image - Select to print the current image.

Selected Series - Select to print all images in the current series.
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Current Page - Select to print the current image in all displayed frames.
All Images - Select to print all images in the current study.
3. Select Print.

4. In the Windows print dialog, configure options and select Print.

Open a third-party application or function
If you configured a third-party application or function, you can open it from the toolbar.

¢ On the viewer toolbar, select the external tool button corresponding to the item to open.

Download images
You can download images and series from studies to your desktop in various formats.

e To download the selected image as a PNG (regardless of the current series layout), on the image
shortcut menu, select Download Image.

e To download each image in the current series as a separate file, on the image shortcut menu, select
Download Series, and then select the file format.

About viewing CAD findings

The Symmetry PACS viewer automatically displays image markers contained in SR data from supported
manufacturers such as iCAD, DiA, and CureMetrix (such as the CureMetrix mammography calcification
and density markings). To control which markings to display, select options in the SR CAD list.

Symmetry PACS uses tracking IDs in the SR data to ensure that when you click a 2D/synthesized image
annotation it jumps correctly to the corresponding 3D/BTO image. Additionally:

e Ifthe BTO series is not already open, it opens next to the 2D/synthesized view in a 1 x 2 layout. You
can go back to the original layout by selecting the backslash key (if the DM was not interrupted).

¢ When 3D CAD SR markings are present and you hover over a CAD SR marking on the synthesized or
2D view, the color changes to the hover color configured in viewer interface settings.

See also:

Configure annotation colors
View tomographic studies with CAD findings
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Work with the patient chart

Symmetry PACS gives you full viewing access to patient demographics, and lets you add, edit, and import
a patient chart (or an electronic medical record or EMR). The Edit Study screen contains much of the same
information as the patient chart.

Find and open a patient chart

Find a patient chart by entering search criteria
You can find an existing patient chart by searching on various patient demographics.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. In the Starts With dropdown list, select a target for your search criteria.

This target applies to all boxes in the search bar.
4. In the All dropdown list, type or select a search filter (these are typically facilities).
5. In the search bar, in one or more of the boxes, type one or more characters.

The results appear in the PATIENT SEARCH RESULTS list.

Example

To find “John Smith:”
1. Select Starts With.
2. Select All.

3. In the Last Name box, type Sm , and in the First Name box, type Jo.

Find a patient chart by scanning a driver’s license
You can find an existing patient chart by scanning a driver’s license.
Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.
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Note: If the tab bar is hidden, select the arrow E next to Patient to display it.
3. Select SCAN LICENSE.
4. Use your barcode reader to scan the driver’s license.

The results appear in the PATIENT SEARCH RESULTS list.

Open and view the patient chart

After finding a patient chart, you can open it to view patient demographics and other information. For
more information about each of the settings within the patient chart, see Edit Study screen and other
topics.

Procedure
1. Find a patient chart, and then double-click it.

The patient chart opens with the PATIENT INFORMATION tab.

2. To view more information, next to the Patient page title, select E, and then select a tab (such
as PATIENT GUARANTOR, or INSURANCE PROFILES).

See also:

Fin atient chart entering search criteri

Find a patient chart by scanning a driver’s license
Edit basic patient information
Edit other patient information

Send reports from the patient chart
You can send approved reports by email or fax directly from the patient chart.
Procedure

1. Open a patient chart, and then select the STUDIES tab.

2. Inthe list of studies, right-click a study containing an approved report, select Send Report, and
then select Fax/Email.

3. Inthe Send Report dialog, in the Send Fax and/or Send Email sections:
a. In the Send To dropdown list, select a category of recipient.
b. In the dropdown list on the right, select an individual recipient.

4. Select SEND FAX and/or SEND EMAIL.
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Access confidential patient records (break the glass)

In emergencies you can use the Break the Glass function to open patient records that are usually off
limits. All Break the Glass operations are added to the audit trail report. Users of type Associated Patients
Only can also “break the glass” from the New Appointment screen. To "break the glass" on the
physician's portal, orin the patient chart search screen:

On Physician Portal

Prerequisite: Configure access reasons (see App settings).

1. On the My Exams worklist, select the Break the Glass checkbox.

2. Inthe Break the Glass Warning dialog, use the search tools to find a patient, and then double-
click the patient record.

3. In the second Break the Glass Warning dialog, in the Access Reason list, select a justification
for accessing the confidential record.

4. In the Verify Your Credential boxes, type your portal sign-in credentials, and then select
ACCEPT.

Result: Studies for the selected patient appear in the My Exams screen.

On the Patient screen

1. Onthe burgerE menu, select Patient, and select the Break the Glass checkbox.

2. Find a patient chart in the usual manner.
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Create and modify a patient chart

Create a patient chart
You can create a patient chart.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. Select CREATE NEW.
4. Type, select, or scan information in the available options.
5. Select CREATE PATIENT.

See also:

Edit basic patient information
Edit other patient information

About the PID, MRN, and account numbers

The patient ID (PID) is usually the same as the MRN or account number. When they differ, it often is
because the PID comes from DICOM sources and the account number comes from RIS sources. This can
happen when an incoming DICOM study with an existing PID conflicts with a receiver rule, and Exa RIS
compensates by creating a unique account number. Also, staff often enter account numbers manually
when creating preorders for new patients, because no PID would exist yet.

Alternate account numbers

Patients receive a different MRN, PID, or account number when they undergo exams at different
facilities. When Symmetry PACS receives such external studies, you can merge them into the master
patient record by linking the external MRNs, PIDs, or account numbers as alternate account numbers of
the Symmetry PACS account number. The benefits of this are:

e The viewer opens images from all records at once

e Any subsequently incoming studies having one of the account numbers are automatically linked to the
other account numbers

e Helps prevent duplicate patient records
¢ Reduces the need to merge patient records

See also:
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Configure alternate account number functionality
Use alternate account numbers

Edit basic patient information

You can edit or add new information to a patient chart. You can access the same settings from an order

tab in the Edit Study screen.

Procedure

1.

Find and open a patient chart.

2. On the PATIENT INFORMATION tab, type or select information for the following options.

Market

Select the markets that serve the patient.

Facilities

Select facilities that serve the patient.

DICOM Patient ID

Type the PID or patient MRN.

Account No./Alt.

and account numbers

Type the patient's account or alternate account number. See About the PID, MRN

PHN/ULI
Name Type the patient's first, and last name.
Optional: Type the middle name, middle initials, and/or suffix.
/ Grey = Non-VIP. Click to change to Yellow (VIP).
Alias Type first and last aliases.
DOB Select the patient's date of birth.

Marital Status

Select the patient's marital status.

Smoking Status

Select the patient's smoking status.

Racial/Ethnic

Checkboxes: Select all that apply.

Dropdown list: Select the Hispanic or Latino ethnicity or non-ethnicity.

Physician

Select the patient's primary physician.

Ordering Facility

Available when using Mobile RAD. Select the ordering facility location or contact that
serves the patient.

Sex Select the sex of the patient.
Height/Weight Type the patient's height and weight.
Patient Flag Select a patient flag.

Language Select the patient's preferred language.
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HIE Consent Select whether the patient has consented to release of demographics and medical
data through a Health Information Exchange for treatment, payment, and health
care operations purposes.

Select [more] next to words Patient Information to view the following settings

License No./Province Type the patient's driver's license number, and select the issuing state.

Exp. Date Select the expiration date of the driver's license.

Emp. Status Select the patient's employment status.

Employer Name Type the name of the patient's employer.

Emp. Address Type the street address of the patient's employer.

City/Province/Postal Type or select the city, state or province, and ZIP or postal code of the patient's
employer.

Phone/Fax Type the phone and/or fax number of the patient's employer.

Reason for Death If the patient is deceased, select the checkbox and then select the reason for death in|

the dropdown list.

Notes Type any notes you wish to include in the chart.
Users Assigned Dynamically search for and select a user to to assign to the patient, and then click
the add d button. Optional: Repeat to assign more users.

Home Address Enter the patient's primary contact information.

SMS / Email Consent: Select whether the patient consents to be contacted by SMS
text and/or email.

Contact Information Enter the patient's secondary contact information.

3. Select SAVE.

Edit other patient information

In addition to basic patient information, you can enter a wide range of other patient-related information
in the patient chart. Most of this information is mirrored in the Edit Study screen, giving you access to it
through multiple workflows. To enter or edit this other information from a patient chart:

Procedure

1. Open a patient chart.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
2. Select a tab in the following table, and then enter settings.

Refer to the descriptions and topics shown for details.
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Patient Chart Tab

PATIENT GUARANTOR Assign a guarantor for a patient
PATIENT ALERTS Assign or remove patient alerts

INSURANCE PROFILES

STUDIES Manage studies in the patient chart

ORDERS Double-click an order in the list to open it in the Edit Study screen.
STUDY FORMS Add a study form to a patient record

DOCUMENTS View or add patient documents

PAYMENT HISTORY View payment history and print receipts

ACTIVITY LOG View activity logs

NOTES Enter notes and reasons for study

Open the call log

See also:

Find a patient chart by entering search criteria

Configure alternate account number functionality

To be able to use alternate account numbers, perform the following procedures.

Configure anissuer of a PID

The issuer of a PID is an alias for the facility that issued the incoming PID (or MRN, or account
number). You must configure an issuer of a PID in advance for each facility whose PIDs you want to
use as alternate account numbers.

Some issuers require a standardized formatting for account numbers. You can prevent users from
entering invalid account numbers by typing a regular expression against which the account number
must match. Symmetry PACS will validate all future account number entries against your regular
expression.

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. On the ISSUERS tab, select ADD, and type a name for the issuing entity.
4

In the Pattern box, type a regular (pattern) expression for validating PID/account numbers for
the specified issuer.

Example: AB? matches a PID starting with AB and followed by one character, such as AB1, ABC,
and ABz.
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5. Select SAVE.

Configure an AE for use with alternate account numbers

For each application entity that receives studies whose MRNs, PIDs, or account humbers you want to
use as alternate account numbers:

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. Onthe AE TITLE tab, double-click an AE in the list to open it.
4

Under Issuer Type, select Static or Dynamic. If you select Static, in the Issuer dropdown list,
select the issuer.

5. Select SAVE.

Configure a receiver rule for use with alternate account numbers

For each relevant receiver rule:

1. Onthe burgerE menu, select SETUP.

2. On the OFFICE menu, select DICOM.

3. On the RECEIVER RULES tab, double-click a receiver rule in the list to open it.
4

Under Rule Information and Filter, select the Issuer of Alternate Account Number
checkbox.

5. Select SAVE.
See also:

A t the PID, MRN, and account numbers
Use alternate account numbers

Use alternate account numbers
To use alternate account numbers to link multiple patient records, complete the following steps.
Prerequisite: Perform the procedures under “Configure alternate account number functionality.”

Procedure

1. Onthe burgerE menu, select PATIENT.
2. On the Patient screen, find the patient and open the patient chart.

3. Onthe PATIENT INFORMATION tab, select MANAGE ALTERNATE ACCOUNT
NUM/IDENTIFIERS.
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4. In the Alternate Account Num/Identifiers dialog, select ADD.

5. Inthe Issuer Name and Type dropdown list, select an option, and then type the alternate
account number or identifier.

6. If using multiple alternate account numbers, select the Primary checkbox if you want the current
number to be the primary one.

7. Select SAVE.
You can repeat this procedure to add multiple alternate account numbers.
See also:

About the PID, MRN, and account numbers
Configure alternate account number functionality

Assign a guarantor for a patient

If the patient requires a guarantor for legal or insurance purposes, you can add one to the patient’s
chart.

Procedure
1. Find an open the patient’s chart.
2. Onthe PATIENT GUARANTOR tab, select ADD.

3. Enter the information for the guarantor, and then select SAVE.

Manage studies in the patient chart

From the STUDIES tab of the patient chart you can create, schedule, and view payment status of prior or
future studies of the patient.

Procedure

1. Open a patient chart.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
2. On the STUDIES tab, perform one or more of the following tasks.

Find, view, and edit a study Search for a study in the list. Double-click a study to open it in the Edit
Study screen.

View approved reports Select the @ approved report button of a study.

View payment status An aggregate summary of study payments appears at the bottom of the
screen.
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Fax/Email approved reports Right-click an approved study, point to Send Report and select
Fax/Email.

View the claim inquiry screen Right-click a study that has claim history, and then select Claim
Inquiry.

Schedule an ordered study Select an unscheduled study, and then select Schedule Appointment to

open the study in the Find Slots screen (see Use the Find Slots feature).

Create a study for the patient Select one of the following:
NEW STUDY: See Enter appointment information

WALK-IN: See Schedule a walk-in appointment

Order images 1. Select a study whose images you want to order in the list, and then
select ORDER IMAGE.

2. Select the patient and/or physicians to whom to send the images.

3. Type sending methods and notes, and then select PLACE ALL
ORDERS.

Import a patient

You can import a patient record (.CSV) into Symmetry PACS. If the patient already exists in Symmetry
PACS, you can update the existing record with the imported information, or create a new record.

Note: To view which options must be present for the update to be successful, select the help ? button
on the right side of the PATIENT IMPORT button.

Procedure

1. Onthe burgerE menu, select PATIENT.

2. On the Patient screen, select the SEARCH tab.

Note: If the tab bar is hidden, select the arrow next to Patient to display it.
3. Select IMPORT PATIENT.

4. Inthe Import Patient dialog, select Choose File, and then browse for and select the file
containing the patient record.

5. Optional. To update an existing patient record, select the Update Existing checkbox.

6. Select IMPORT.
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Merge patient charts

If two patient charts are accidentally created for a single patient, you can merge the charts.

1. Onthe burgerE menu, select PATIENT.
2. On the SEARCH tab, in the MRN box, enter the account number of the records to merge.

3. Inthe list of results, select the row containing the incorrect patient chart, hover and select the

settings E button, and then select Merge.

PATIENT BEARCH RESULTS

Test, Test Merge? - test1057 ) ' ‘ Select GEAR > MERGE
DOB: 071/01/2022, (333)333-3333, (586)200-0000

3 on INCORRECT chart
KISSIMBEE, FL 34742 Edi first

Activesinactive —————

Tast, Test] Merge - test1056

DOB: 01/01/2022, (333)333-3333, (3333333333

123 main st -
KISSIMMEE, FL 34742 Delito

4. Repeat the previous two steps for the row containing the correct patient chart.

5. In the Patient Merge screen, confirm the contents of the merge and then select MERGE.

Merge a “FIX_” study

If the DOB, gender, first name, and last name of a new patient chart are the same as an existing
one, Symmetry PACS prepends “FIX_" to the account number in the worklist. You can fix these by
merging them with the existing chart. This can occur in such cases as a hame change due to
marriage or divorce, an updated account number, or an error in patient entry.

1. On the search bar of the worklist, in the ACCOUNT NO. box, type fix and then select Enter.
2. Inthe list of results, copy the account number (without the “FIX_" prefix) of a study.

3. Paste the account number in the ACCOUNT NO. box, and then select Enter.
4

In the list of results, compare the “FIX_" record with the other to determine whether they are for
the same patient.

5. Ifthe same, merge the records by following the earlier procedure.

Work with Mobile RAD

Mobile RAD is a mobile Android app that technologists use to manage their mobile exams.
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Install Mobile RAD

All technologists and other users of Mobile RAD must follow the steps in the following sub-topics to install
the Mobile RAD app on their Android mobile device. If you do not have access to the SETUP area of
Symmetry PACS, request assistance from an administrator.

Configure Symmetry PACS

1. In Symmetry PACS, on the burgerE menu, select SETUP > [full caps menu] > Scheduling &
Codes > STUDY STATUS.

2. In the Facility dropdown list, select your facility.

3. For each status in the list related to mobile orders:
a. Double-click the status to open its settings.
b. On the STUDY STATUS sub-tab, select the MobileRad Related checkbox.
c. Select SAVE.

Install a PDF viewer

1. On your mobile device, go to the Google Play Store.

2. Install a PDF viewer, such as Adobe Acrobat, WPS Office-PDF, or Microsoft Office.

Install the APK

1. In Symmetry PACS, on the burgerE menu, select Tools > MOBILE RAD.
2. Copy mobilerad.apk to your mobile device (such as through email, chat, or File Explorer).
Result: The browser downloads the mobilerad.apk file.

3. On your mobile device, in the Blocked by Play Protect message, select INSTALL ANYWAY.
Configure Mobile RAD
1. Tap and hold the Mobile RAD icon, and then select App info > Permissions.

2. On the App permissions screen, on the options : menu, select All Permissions.

3. In the Storage folder of your mobile device, confirm that the MobileRAD sub-folder appears. If it
does not, create the sub-folder.

Sign-In to Mobile RAD
1. From your site administrator, obtain the host name for Mobile RAD.

2. In Symmetry PACS, on the burgerE menu, select SETUP > [full caps menu] > Office >
COMPANY.
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3. Write down the value in the Code boxes.

4.
5.

Tap the Mobile RAD icon, and on the sign-in screen, select HOST NAME 2.

In the HostName field, enter the host name, and then select YES.

On the sign-in screen, enter the following:

Username

Your user name for Symmetry PACS.

Password

Your password for Symmetry PACS.

Company Code

The code you wrote down earlier.

Select LOGIN.
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Perform query and retrieve

You can query a server and retrieve studies.

Prerequisite: Configure DICOM settings for the server to query and for Symmetry PACS on the server.

Procedure

1. On the burger E menu, select QUERY/RETRIEVE.
2. Inthe dropdown list on the left side of the QUERY button, select a server to query.
3. Type criteria in the search bar and do one or more of the following.

e To query the server, select QUERY.
e To retrieve all matching studies, select RETRIEVE.
e To retrieve some matching studies, select the studies, right-click, and then select Retrieve.
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Work with reports
Create, view, and deliver reports

Create a report

You can create various types of reports based on configurable criteria, and then export them in formats
including PDF, XLS, CSV, and XML.

Procedure

1. Onthe burgerE menu, select REPORTS.

2. On the top navigation bar, select Report, and then select a report type in the list.
3. Below the Filter Fields label, select criteria to define the content of the report.
4

Select VIEW, or select an output format (PDF, EXCEL, CSV, or XML).

View your saved reports
You can view open and download reports that you previously saved.

Procedure

1. Onthe burgerE menu, select the arrow ll next to REPORTS, and then select MY
REPORTS.

2. Select a report in the list, and then:

e Select to download
e Select @ to open

Send reports to providers

You can configure Symmetry PACS to automatically send reports and images through email to specified
provider locations/contacts and their provider groups.

Prerequisite: Add a referring physician or ordering physician to any studies whose reports you want to
send (see Edit study information).

Procedure
1. On the burger menu, select SETUP > [full caps menu] > Providers & Resources > RESOURCE.
2. Inthe list of resources, double-click a provider type resource.

3. On the LOCATIONS/CONTACTS sub-tab, double-click a location/contact in the list.

500-000577A 277



Symmetry® PACS 1.4.32_P4 User's Manual

symmeltry-PACs

4. Double-click a location/contact in the list. In the Contact Information area, in the Email box,
type the email address of the provider contact.

5. Inthe Reports to Me area, under Contact Information, enter the following settings. To send
reports to other members of the provider location/contact's provider group, under Reports to

Group, enter the same settings.

Email Report Link

Select to send a link to the report in an email.

Postal Mail Select to send a hard copy of the report to the mailing address entered
in the Contact Information area.
Fax Select to send a fax of the report to the fax number entered in the

Contact Information area.

Email Attachment

Select to send the report as an attachment to an email.

Auto-Print Available when you select postal mail. Select a printer in the dropdown
list to automatically print reports.
Office Fax Select to send a fax of the report to the office fax number entered in

the Contact Information area.

6. Optional: Under Report Password, type a password to require to open reports.

7. Select SAVE & CLOSE.

Note: You can view your sent reports at: Burger menu > SETUP > General > REPORT QUEUE.

Records are processed and sent to the specified user or group based on the email service

configuration.
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Work with tools

Symmetry PACS includes a suite of tools that provide a variety of functionality. Some tools must be
installed locally on the client computer (see Install and configure tools).

Use importtools

Import studies from CD

You can perform a “CD import.”

YA

Ensure that the data to be imported, and the data after import are correct.
Prerequisite: Install Opal tools.

Procedure

1. Onthe burgerE menu, select the arrow next to TOOLS, and then select CD IMPORT.

2. Ifthe “Open Opal Import?” message appears, select the checkbox, and then select Open Opal
Import.

3. Inthe OpalImport dialog, select Select Files/Folders or DICOMDIR to Import, and then
browse for and select files to import.

4. Enter customization settings and then select Import.

Import studies to a specific AE (APl mode)

You can import studies to a specific AE.

Procedure

1. On the worklist, on the PACS Actions E menu, select Import Images.

Note: If the “Open Opal Import?” message appears, select the checkbox, and then select Open
Opal Import.

2. Inthe OpalImport dialog, turn on API mode by typing 1g2w3e4r 5t .

Note: You only need to perform this step once. API mode will remain on permanently.
3. Select the Exa API transfer option.

4. Select Select Files/Folders or DICOMDIR to Import, and then browse for and select files to
import.
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5. Enter customization settings and then select Import.
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Work with Patient Portal

Patient Portal is a website that patients can use to view or modify information about their past and future
exams, demographics, insurance, guarantors, and representatives, and to schedule appointments.

About creating a patient account

Before the patient can use Patient Portal, clinical staff must work with the patient to create an account.
You can choose one of two workflows to create an account: initiated by clinical staff, or initiated by the
patient.

Create a patient account

To create a new patient portal account:

As clinical staff

1. Provide the patient portal URL to the patient. You can contact the patient directly, or add the URL
to the appointment confirmation screen or automated appointment reminders.

2. In the patient’s chart, select PORTAL ACCOUNT.
3. Enter information as needed, and then select CREATE.

Result: Symmetry PACS sends an email to the patient with a link they can use to set their
password.

3. Click SAVE.

As the patient
1. On the patient portal sign-in screen, select NEW USER.
2. Inthe New User Registration dialog, fill out the form, and then select Save.

3. Open the email from your healthcare facility, and then select the verification link to verify your
email address.

Link the portal account to a patient chart

When a patient initiates creating their own Patient Portal account, the demographics they enter are sent
to Symmetry PACS. You must reconcile that information to the patient’s existing chart, or use it to create
a new chart.

Procedure

1. Onthe burgerE menu, select PORTAL REG USERS.
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2. On the Portal Registered Users screen, open a user of Verified status.

3. In the Portal Registered Information screen, in the Patient Match area, search for a matching
patient. If no matching patients appear, select CREATE NEW, edit the patient’s information as
needed, and then select CREATE PATIENT.

4. Open the matching patient, and check the Registration Information pane on the right; if any
information appears in yellow, decide whether you want to update the patient chart with the new
information.

5. Do one of the following:

e To update the patient chart and link the account, select SAVE AND LINK, and then select
UPDATE.

e To continue linking the account without updating the patient chart, select SAVE AND LINK,
and then select CONTINUE WITHOUT UPDATING.

e To reject the registration request altogether, select REJECT.
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Use the patient portal
Only patients and authorized representatives can use the patient portal, but you can refer to these
instructions to assist patients. See also the Patient Portal user's manual.

Sign in to the patient portal

Procedure

1. Go to the URL given to you by your healthcare provider.

B Login

example@email-address

LOGIN

In the Login pane, in the first box, type your email address.
In the second box, type your password.
Select the I Agree to the HIPAA Privacy Notice link to open the notice, and then read it.

If you agree, select the I Agree to the HIPAA Privacy Notice checkbox.

o U A W N

Optional. To automatically fill in your email address whenever you go to the sign-in page, select
the Remember Me checkbox.

7. Select LOGIN.

| forgot my password
If you forget your password, you can reset it from the sign-in page.
1. On the sign-in page, on the right pane, select FORGOT PASSWORD.

2. Inthe Forgot Password box, type your email address and select SUBMIT.
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3. Open the email sent to the address you entered, and use the link to reset your password.

Go to the Home screen

e Inthe left pane, select Home.

Find a location
You can search for a healthcare facility near you on a map.
1. In the left pane, select Our Locations.

2. In the list of locations, select a location to show it on the map.

View appointments and appointment confirmations

You c an view information about your past and future appointments, and view and print the appointment
confirmation card.

Procedure

1. On the home screen, select the Future Appointments or Past Appointments tab. Each
appointment appears in a row.

2. To open the appointment confirmation card, on the left side of an appointment row, select the

appointment card button.

3. To print the appointment confirmation card, open the confirmation card, and then select Print.

Upload a document

You can send us documents such as scans of your insurance card, forms, and reports from prior exams by
uploading them in the patient portal.
1. On the home screen, select the Future Appointments or Past Appointments tab.

2. Find the row containing the appointment that pertains to your document.

3. On the right side of the row, select the upload 1] button.

4. In screen that appears, enter any of the following that may be helpful to manage the document:

Document Type - Select the type of document to upload.

Document Notes - Type a description, or other notes, if needed.

Created By - Type the originator of the document (such as a doctor, or yourself).
Import/Upload Date - Type the current date.

5. Select Upload.
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View your appointments in a calendar

You can open a calendar view of your appointments.

e On the home screen, select the Calendar @ button.

Request an appointment

symmeltry-PACs

You can request an appointment for specific study on a specific date at a selected location. If you do not
know this information, leave the options blank (this does not affect how quickly your appointment will be

scheduled).

Procedure

o
-

1. On the home screen, select the menu *** button.

2. Select the Schedule button.

3. On the Appointments tab, select Add.

4. Under Add Information, enter the following settings.

Location

Select your first choice of healthcare facility for the appointment.

Modality

Select the type of imaging to receive from one of the following.

AT

BD Bone density

BR

BTO | Breast tomography

CR Computed radiography

CT CT (computed tomography)

DG Diaphanography

DX Digital radiography

MG Mammogram

MGK

MR MRI (magnetic resonance imaging)

NM Nuclear medicine

oT Other
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PT PET (positron emission tomography)

RF Radio fluoscopy

RT Record of treatment

SC Secondary capture

SP Stereo-photogrammetry

™

us Ultrasound

XA X-ray angiography

Referred By

Select your first choice of date for the appointment.

Requesting Date

Select your first choice of date for the appointment.

Schedule Notes

Type any special instructions or notes to the healthcare provider.

Appointment

The appointment type corresponding to the selected modality, if available. Filled in

Type automatically.
As Soon as If the appointment is urgent, select this checkbox.
Possible

5. Click Save.

Result: The appointment request is sent.

Update insurance information

If your insurance policy changes, you can update it.

Procedure

o
-

1. On the home screen, select the menu *** button.

2. Select the Insurance @ button.

3. On the Insurance tab, find the policy you want to update, and on the right, select its edit (o)

button.

4. Edit the information as needed, and then select Save.

Add an insurance policy

If you obtain new a insurance policy, you can add it.

Procedure
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1. On the home screen, select the menu *:* button.

2. Select the Insurance @ button.
3. On the Insurance tab, select Add.
4, Enter all relevant information.

Note: If this is your only policy, in the Level list, select Primary. Otherwise, select Secondary for
your second policy, or Tertiary for your third policy.

5. Select Save.

Add a guarantor

A guarantor is a person who accepts financial responsibility to pay the medical bill for the patient. To
designate a guarantor:

Procedure

1. On the home screen, select the menu *:* button.

2. Select the Guarantor i button.
3. On the Guarantors tab, select Add.
4. Enter information about the guarantor, and then select Save.

Note: Options with an asterisk (*) are required.

Update my profile
If your personal information changes, you can edit it.

Procedure
1. On the home screen, select the menu it button.

2. Select the Edit My Profile ’ﬁ button.

3. On the Credentials tab, edit information as needed, and then select Save.

Reset my password
For security and protection of your personal health information, periodically reset your password.

Procedure

1. On the home screen, select the menu 2t button.
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2. Select the Edit My Profile 'ﬁ button.

3.

On the My Account tab, select Reset Password.

4. Type your current and new password (twice), and then select Save.

Add an email address

To add a new email address to your account:

Procedure
1. On the home screen, select the menu 2t button.
2. Select the Edit My Profile ’ﬁ button.
3. On the My Account tab, in the Secondary Email box, type an email address, and then select the
plus ® sign.
Result: An verification email is sent to the address you entered.
4. Use the link in the verification email to verify your new address.

View account activity

To see a history of activity on your account:
Procedure

1.

2.

On the home screen, select the menu it button.

Select the Activity Log @ button.

Optional. To search for a specific log entry, select Search, and then:

a. Select a search key (Logged Date, Screen Name, Email Address, or Log Description).
b. Type a value to search for (for example, 01/31/2021).

c. Select Search.

View authorized representatives

An authorized representative is a person you authorize to use your patient portal account. To view a list
of your authorized representatives:

Procedure

1.

On the home screen, select the menu =*% button.
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2. Select the Authorized Representative & button.

Sign out of the patient portal

When finished using the patient portal, sign out immediately.

e In the upper-right corner of the screen, select the power (!1 button.
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Appendix

Reference
User reference

Search syntax

Various lists in Symmetry PACS have a search bar with column headers that accept search criteria. The
following general rules apply when entering search criteria.

e In most numeric boxes, you can search for any part of the number. For example:
In the account number box, type: 20
Symmetry PACS finds: 203, 1203, and 01203.
e In a name box (such as patient name or payer name), you can type the full name in the format:
lastname, firstname
bUt not:--
firsthame lastname.
e In a name box, you can type the first or last name only. For example:
Type: Anderson
Symmetry PACS finds: Cooper, Anderson
...and...
Anderson, John.

e In a name box you can type all or part of the first or last name, but using as many letters as possible
improves accuracy. For example:

Type: Oswa

Symmetry PACS finds: Oswald, Trevor
-3 nd e

Davis, Oswald

However, if you type: Os

Symmetry PACS finds only:  Oswald, Trevor.
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Keyboard shortcuts and commands for Exa Trans

When using Exa Trans, the following keyboard shortcuts are available.

Remove last dictated piece

undo that
delete that

scratch that

Next variable placeholder

next variable

Alt+]

Previous variable placeholder

previous variable

Alt+[

Capitalize previous word

capitalize that

cap that

Remove word left of the cursor

remove left

Ctrl+Alt+Back

Start recording Ctrl+F1
Toggle recording Ctrl+F3
Stop recording stop recording Ctrl+F2
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The following table lists all of the reports available on the Exa platform. Some reports may not be
available to you depending on your product and configuration.

Billing/Reports

Aged AR Detail

AR aging by facility, responsible party, and payer by cutoff
date and selected facilities, in detail

Aged AR Summary

AR aging by facility, responsible party, and payer by cutoff
date and selected facilities

Charges Charges for reconciling and reviewing the charges populated
for any date of service
Claim Activity Detailed claim activity history by claim date range

Claim Inquiry

All submitted claims, and order payments and balances

Claim Transaction

All claims, and claim payments and balances

Collections

Claims in the Collections Review status

Credit Balance Encounters

Credit balance encounters

Diagnosis Count

Aggregate diagnosis count by ICD code and facility, by order
date range

Modality Summary

Modality summary

Monthly Recap

Monthly recap

Patient Statement

Patient statement

Patients by Insurance

Patients seen within a date range by insurance

Payer Mix

Payer mix

Payments

Totals by payment and payer type, and how each charge line
item is applied by accounting date range

Payments by Insurance Company

Calculated payments to each insurance company, by patient

Payments Realization Rate Analysis

Accounts with a zero balance

Procedure Analysis by Insurance

Procedures by insurance

Procedure Count

Number of procedures approved by radiologist fee schedule

Reading Provider Fees

Reading provider fees

Referring Provider Count

Referring provider count

Referring Provider Summary

Referring doctor summary information

Transaction Summary

Transaction summary

Reports -
Schedule &

Daily Schedules

Information on studies performed by day
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Reports Export Completed Studies CSV export of patient, study, and insurance details for
completed or approved studies
Marketing Rep Activities Notes and activities that marketing representatives enter
about referring physicians
Unsigned Orders not signed by referring physician. No longer used.
Operations Statistics on canceled studies with cancellation reason as a

Cancellation Reason

key filtering criterion.

Scheduler Activity

Number of orders (based on the current order status) by
time of day that a user ordered, scheduled, rescheduled, or
canceled, by facility and date range

Unfinished Studies

not having selected study statuses, by facility and date range

Referrals Variance

Number of studies referred by referring physicians in the
past 13 months, by facility, modality, and month

Studies Breakdown

Number of studies by facility, modality, study date, and study
status

Studies by Modality

Aggregate study count by facility, modality, study date, and
study status

Studies by Modality Room

Aggregate study count by facility and modality room

Modality Breakdown

Number of studies performed based on CPT or appointment
type, by modality

Technologist Productivity

Number of studies performed per technologist by facility,
modality, appointment type, and procedure code

Peer Review Operational

Progress and results of peer reviews performed

Fees by Radiologist and Modality

Summary and breakdown of fees for a modality, by
radiologist

Turnaround Time (TAT) - Calculated

Shows turnaround time (TAT) calculated based on selected
date, type, and study's approved date, by date range,
facilities, and/or ordering facilities

Relative Value Units

CPT and RVU totals for reports signed off, by date range

Referring Physician Study Count

Number of studies referred by referring physicians by date
range

Completed Schedules

Shows information about completed studies

Monthly/Daily Study Goals

Number of studies performed in the month compared to the
goal set in Monthly Goals Setup

STAT Tracking

Number of studies marked as STAT

Transcription Study Count

Aggregate study count of reports transcribed by
transcriptionists, by facility, modality, and study date

500-000577A

293



Symmetry® PACS 1.4.32_P4 User's Manual

symmeltry-PACs

Insurance vs LOP

letter of protection/personal injury studies

Aggregate study count by modality for insurance paid vs

Marketing Rep Export

referring physicians and marketing reps

Study information, bill fees, and allowed amounts for

Audit Trail Break the glass Audit Trail report
Same Last Name User Audit Alberta only.
Patients Patients Worksheet Patient and study face sheets in form
My Reports My Reports Allows opening the My Reports tab to view operational

reports

Settings in insurance profile screens

The settings related to insurance profiles are slightly different depending on which of the following screens

you use to view them.

1. Edit Study > Insurance Profile > Add
2. Edit Study > Insurance Profile > Edit
3. New Appointment > Insurance

4. Patient > Insurance Profiles > AddEdit

The following table lists all settings that are available.

Set As Default

Available only from the patient chart and when scheduling.

Select to set the current policy as the default policy. Useful when the
patient has multiple policies at the same level.

Level Select whether the insurance is the patient's primary, secondary, or
tertiary policy.
Inactive Select to inactivate the policy while retaining its information.

The Valid To Date is automatically set to the current date.

Existing Insurance

Not available on all insurance screens. If you entered insurance for the
patient previously, you can select it here to automatically fill in other
options.

Insurance Carrier

Select the insurance carrier.

Insurance Provider Type

Entered automatically.

Policy Number

Type the patient's insurance policy number.

Group No.

Type the insurance group number of the policy.
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Type contact information getting pre-certification.

Accept Assignment

Select if the insurance policy can accept assignments.

Address / Phone No.

The contact information of the insurance carrier.

Website

The website of the insurance carrier.

Group Name

Type the name of the insurance group.

Valid From/To Date

Select the period during which the current policy is effective.

Medicare Ins. Type

Select the Medicare insurance type of the policy.

Available after you save the profile.

Relationship

Select an emergency contact person for the patient.

Subscriber Name

Type the name of the insurance policy subscriber.

Sex Select the sex of the subscriber.

Country Select the country of the subscriber.
Address Type the address of the subscriber.

DOB Select the date of birth of the subscriber.

Employee Status

Select the employment status of the subscriber.

Work / Home Phone

Type the phone numbers of the subscriber.

Measurement accuracy

limits

Length Ruler mm £2 mm
Angle Protractor S +2°
Area Calculated cmnA2 +5%
Ratio Calculated +2%
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Viewer toolbar tools

The following table lists all toolbar tools that are available in the viewer. See corresponding topics for the
functions of the tools.

=18

3D Ray Draws a 3D ray on an image. Select to place a vertex on one plane, and

the ray extends through the image on all planes.
) 3D Cursor Displays a cursor in other open planes that follows the motion of the

cursor in the active plane.

3D Angle Click three points to create the angle. The angle appears at the same
coordinates on all series with the same frame of reference.

3D Measure Click two points (or drag and click). The measurement appears at the
same coordinates on all series with the same frame of reference.

3D Point Click to add the point. The point appears at the same coordinates on all
series with the same frame of reference.

3D ROI Available in a future release.

AR Plots points to represent angular rotation.

Actual Image Siz¢g

Displays images in their real-life anatomical dimensions.

Angle Marker

Measures and annotates an angle.

Arrow

Draws an arrow.

A CEH H H H

Auto W/L

Automatically optimizes the W/L.

Bone Enhance

Controls contrast between bone and other tissues.

CAD

Displays CAD findings, with a button menu for selecting specific findings.
Available when CAD findings are present in the opened study.

Center Point

Click two points. The center point between them is indicated.

BE 32

Change Slice Sets the slice thickness.
Thickness
@ Circle Draws a circle.
CL CLAHE Contrast limited adaptive histogram equalization. Turns CLAHE mode
on/off. Improves image contrast.
Close Series Keyboard shortcut for the Close Series option in the image cell's upper-
right shortcut menu.
Close Study Keyboard shortcut for Partial Close.
Cobb Angle Measures a Cobb angle.

)

Context Menu

Displays the view shortcut.
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Tool

Context Tool

Function

Displays a linked image at the same X, Y, Z angle as the current image.

IR

CT Ratio Displays the angle between two lines. Use to calculate the angle between
vertebra.
Curve Click two points to estimate curvature from the center of the end
vertebrae to the center of the apical vertebrae.
Cutlines Shows/hides cutlines, if present.
Default Selects the standard pointer tool.

Bl Ed| @

Delete All Image
Annotations

Deletes all annotations.

Delete Series
Annotations

Deletes all annotations in the current series.

Available only in shortcut menu.

Delete Study
Annotations

Deletes all annotations in the current study.

Available only in shortcut menu.

Deselect Last
Annotation

Deselects the last-selected annotation.

Available only in shortcut menu.

DICOM Print

Sends the image to a DICOM printer.

DICOM Values

Displays a list of DICOM values associated with the current image.

NQH @A

DM Settings Opens display management settings.

Dot Draws a dot.

Edit Turns Edit mode on/off. Edit mode allows editing of previously set
annotations.

Ellipse Draws an ellipse.

External Tools

Reserved for opening an external application.

0 O Ne

Fit to Window Restores original zoom level.

Flip Flips the image across its horizontal or vertical axis (hover over the tool
to select between axes).

Frames Selects the number and arrangement of frames to display in the viewing
area.

FH Measure Takes freehand measurements.

EOT

Freehand ROI

Freehand-draws an ROI.

T
H H =

Histogram

Displays a histogram.

500-000577A
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HO Angle

Function

Draws a horizontal orthogonal angle.

Horizontal Line

Draws a horizontal line.

HU

Displays the pixel value in Hounsfield Units.

Invert Color

Inverts black/white values.

CIGIGILIL]

L Marker Adds an L (left) marker.

Line Draws a straight line.

Link Auto Links two or more series that are open.

Link Manual Links user-specified frames between panels.

M Compare Measurement comparison. Click a first and second point, then double-

click a third point. Displays the distances between the points.

Magnifying Glass

Displays a movable zoomed area.

NHEEELE

Measure Measures between two specified points.

MPR Multiplanar reformation. Select to generate and display coronal, sagittal,
and MIP (maximum intensity projection) stacks from an axial image.

Next Series Keyboard shortcut for moving to the next available series in the study.

One to One Displays the image in its original DICOM size.

Open Next Study

Keyboard shortcut for the Auto Open Next Study option.

11

ﬂ Overlay Turns overlays on/off.

Pan Drags the image any direction.

n Patient Opens an independent window for viewing, scanning in, and attaching
Documents patient documents. Turns blue when documents are available.

Pencil Freehand-draws a line.

Play Frames Starts cine looping.

Previous Series

Keyboard shortcut for moving to the previous series in the study.

Print Images

Sends images to a non-DICOM printer.

Prior Reports

View reports. Turns blue when reports are available.

R Marker

Adds an R (right) marker.

= aan

Radial Angle

Draws a radial angle, which is the angle of the distal radial surface with
respect to a line perpendicular to the shaft.

500-000577A
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Radial Length

Function

Draws a radial length.

Rectangle

Draws a rectangle.

Reset Frame

Undoes all unsaved changes to the image within the active viewing cell.

Reset Linked
Series

Removes any linkages.

Reset Stack

Restore images in a stack to their last-saved ordering.

Reset Viewer

Reverts non-permanent modifications to images in the viewer (zoom,
rotation, Window/Level etc.) to their original state.

ROI

Draws an ellipse to specify an ROI.

G H B0 E Q) S

Rotate Right

Rotates the image 90 degrees clockwise.

Hover over the rotate button to reveal the rotate left button.

[@

Rotate Left

Rotates the image 90 degrees counterclockwise. Hover over the rotate
button to reveal the rotate left button.

Save Annotations

Saves the current state of annotations.

Scroll/Span
Images

Switches between moving and spanning.

Set Key Image

Sets the current image as a key image.

Settings

Displays the settings dialog.

Show Prior List

Opens a dialog with a list of priors that you can select to display in the
prior bar.

[ § B H 8[

Shutter Box

Adds an rectangular shutter.

[
X
m

Shutter Ellipse

Draws an elliptical shutter.

Shutter Freehand

Draws a freehand shutter.

Spine Label

Adds vertebrae labels to spinal images.

Spine Label Short

Adds vertebrae labels from common starting points.

Spine Label 3D

Adds vertebrae labels on all series with the same frame of reference.

NN NNH

Spine Label 3D
Short

Adds vertebrae labels from common starting points on all series with the
same frame of reference.

\2

Spine Label Quick]
3D

Adds vertebrae labels to the same anatomy on all series with the same
frame of reference.

2

Spine Label Quick]
3D Short

Adds vertebrae labels from common starting points to the same anatomy
on all series with same frame of reference.
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Study Notes

Displays a dialog for reading/writing notes.

Text

Draws text.

Toggle
Annotations

Shows/hides annotations.

Toggle DICOM
Overlays

Shows/hides DICOM overlays.

Transcription

Opens an independent dictation and transcription window.

Triangulation

Displays the context tool at the same coordinates on all series with the

symmeltry-PACs

same frame of reference.

unq Creates a teaching study.

Vertical Line Draws a vertical line.

Window/Level Adjusts the window/level.

Zoom Zooms the image in/out.

BEEEHA Oa H HHEE

Details on Linked Reporting

Statuses of linked reports

e Any activity related to retaining the STAT level of a main study also applies to any of its linked

studies.

any of its linked studies.

Any activity related to TAT recording (approval time) on a linked main study also applies to

When you unlink an approved study, the study reverts to Unread status.
When a main study changes to Approved status, so do its linked studies. In addition:
¢ The order status of the linked studies changes to Check-Out.

e The approving physician and/or pre-approving physician and approved date are added

to the main and linked studies.

Draft
Transcribed
Pre-Approved
Dictated

Approved-Coded (APCD status)

change to the same status, including the following.

500-000577A
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Draft - Addendum
Transcribed - Addendum
Approved - Addendum

Dictated - Addendum

When you right-click a main study and select Exam > Reset Transcription, the main study and
linked studies are reset to Unread status.

When you change a main study from Approved to an earlier status, you are prompted to
unlink its linked studies. The main study changes to the selected status, and the linked studies
change to Unread status. The report remains with the main study.

When you change the status of a linked study, you are prompted to unlink it from the main
studies. The linked study changes to the selected status, and no other studies are affected.
When you reset the transcription of a main study, this resets the transcription for the main and
linked studies, and sets their statuses to Unread. The studies remain linked.

When you reset a main study with an approved report, you are prompted to unlink its linked
studies. The main study changes to Scheduled status, and the previously linked studies
change to Unread status.

When you reset a linked study with an approved report, you are prompted to unlink it from
the main study. The study changes to Scheduled status, and other studies are unaffected.

Considerations when transcribing linked studies

When transcribing a main or linked study, the transcription lock is applied to the main study
and all linked studies (in both Exa Trans and WebTrans). The following actions release the
transcription lock on all studies:

Close the transcription
Sign out of Exa PACS/RIS
Approve the study (E-sign and Approve, Approve and Next, or Pre-Approve)

Using Skip or Not Approve

Immediately after you link studies, Exa Trans and WebTrans updated accordingly, even if a
transcription is open. This includes updating of the report header with information from the
linked studies.

Exa Dictation audio files are available in the viewer and in WebTrans for all main and linked
studies.

Which reports can you link?

When you select to link reports, Exa PACS/RIS automatically displays a list of reports that are
available to link. These studies:
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e Have a study date 3 days before or after the main study

e Have a status other than Ordered, Cancelled, Rescheduled, No Show, Read, or Approved

e Are from the same facility as the main study

Mammography views

In mammography there are two main view "families," CC and MLO. Each family contains multiple sub-

views.

symmeltry-PACs

CC Family

MLO Family

Craniocaudal
Superior — Inferior

Mediolateral Oblique
Superomedial —

&

Craniocaudal
Superior — Inferior
C-Arm Angle: 0 degrees

e

CcC MLO
‘ e C-Arm Angle: 0 degrees Inferomedial
X ¢ C-Arm Angle: 30-60
degrees
o Exaggerated Mediolateral

Medial-Lateral
C-Arm Angle: 0 degrees

Lt d

Superior — Inferior
C-Arm Angle: 0 degrees

XCCL o Exaggerated LMO o Lateromedial Oblique
= - Craniocaudal Lateral o Inferolateral — Superomedial
+ e Superior — Inferior Oblique
= e C-Arm Angle: O degrees d e C-Arm Angle: 90-180
. degrees
XCCM o Exaggerated LM e Lateromedial
Craniocaudal Medial = = Lateral-Medial

C-Arm Angle: 90 degrees

From Below:
Caudocranial

Inferior — Superior
C-Arm Angle: 0 degrees

oA

Superolateral to
Inferomedial Oblique
Superomedial —
Inferomedial Oblique

C-Arm Angle: 1-90 degrees

The following views are also available:

ID - Implant displacement
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CV - Cleavage view
AT - Axillary tail

RL - Rolled lateral
RM - Rolled medial
RI - Rolled inferior
RS - Rolled superior
MAG - Magnification
S - Spot compression
TAN - Tangential
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Install and configure tools

Add the Chrome extension

You can add an extension that configures your Chrome browser to work with multiple monitors. After
adding the extension, you can configure display settings for the monitors you will use.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select CHROME EXTENSION.
2. On the Chrome_MultiMonitor page, select Add to Chrome.

Note: If the '"Add Chrome_Multimonitor? message appears, select Add extension.

3. On the worklist, on the upper toolbar, select the settings E button, and then in the button
shortcut menu, select Viewer Settings.

Monitors on System 3 <

4. On the GENERAL tab, under Display Settings:
a. Select the Monitors on System box

=

b. Select the refresh ‘-~ button

c. Select the identify <= button.
5. In the table of monitors:
a. Inthe Monitor column, select all monitors that you want to use.
b. Inthe Current column, select the monitor to hang current images and thumbnails.
c. Inthe Prior column, select the monitor to hang prior images and thumbnails.

Note: When using a hanging protocol, the Current and Prior settings in the table only control
where the thumbnails hang.

6. Optional. In the Orders column, select an item to auto-open in the monitor.

7. Select SAVE.

Install Exa Trans
Radiologists who use Dragon for transcription must install Exa Trans.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select EXA TRANS.
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Note: Chrome downloads ExaTransSetup.msi in the lower left corner of the browser. Wait until
the download is finished before continuing.

2. Select ExaTransSetup.msi. Windows installs Exa Trans.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install Exa Dictation
Radiologists who use Dragon for dictation must install Exa Dictation.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select EXA DICTATION.

Note: Chrome downloads exa_dictation_setup.msi in the lower left corner of the browser. Wait
until the download is finished before continuing.

2. Select exa_dictation_setup.msi.
3. Windows installs Exa Dictation.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install OPAL tools

Many functions in Symmetry PACS require that you first install OPAL tools, such as CD import and CD
burning.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select OPAL TOOLS.

Note: Chrome downloads OpalToolsSETUP.exe in the lower left corner of the browser. Wait until
the download is finished before continuing.

2. Select OpalToolsSETUP.exe. Windows installs Opal tools.

Note: If the User Account Control dialog appears, select Yes.

Install OPAL Viewer

Symmetry PACS uses a server-side viewer, but you can also install the client-side Opal viewer.

Procedure

1. Onthe burgerE menu, on the TOOLS submenu, select OPAL VIEWER.
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Note: Chrome downloads ExaClientViewerSETUP.exe in the lower left corner of the browser. Wait
until the download is finished before continuing.

Select ExaClientViewerSETUP.exe. Windows installs the Opal viewer.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

Install Exa Scans

With Exa Scans, you can scan paper and other media and attach the scans to studies as DICOM data.

Prerequisites: You must uninstall any existing version of Exa Scans before installing a new one.

Procedure

1.

© N o u

On the burgerE menu, on the TOOLS submenu, select EXA SCANS.

Chrome downloads exa_docscan_setup.msi in the lower left corner of the browser. Wait until the
download is complete before continuing.

Select exa_docscan_setup.msi.

Note: If the Windows protected your PC dialog appears, select More info, and then select Run
anyway.

In the Welcome to the EXA Document Scan Setup Wizard, select Next.

On the End User License Agreement page, select I accept the terms in the License
Agreement checkbox, and then select Next.

On the Destination Folder page, select Next.
On the Ready to Install EXA Document Scan page, select Install.
If the User Account Control dialog appears, select Yes.

On the Completed the EXA Document Scan Setup Wizard page, select Finish.

Install local cache

Local cache is a service that manages the copying of studies from the server to your local workstation for

local use.

Configure the server

1.

2.

On the burgerE menu, select SETUP.

On the OFFICE menu, select DICOM.
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3. On the AE Title tab, select Add, and then enter the following settings.

AE Type Local Cache
AE Title (Remote) [Name with no spaces]
Description [Friendly descriptive name]

4. Select SAVE.

Configure the client

1. Onthe burgerE menu, on the TOOLS submenu, select CLIENT SERVICE.

Result: Your browser downloads exa_localcache_setup.msi to its specified folder for downloads
(usually the Windows Downloads folder).

2. Run exa_localcache_setup.msi and follow the prompts to install it.

3. Inthe Symmetry PACS worklist, select Settings E and select Local Service Settings.

4. Inthe Rendering Options screen, under Prefetch Configuration, enter the following settings.

AE Title Type the AE Title (Remote) name that you created in “Configure the server."
User Name Type a user name with user rights to access studies on the server.

API URL Type the address of the server hosting the studies that you want to locally cache.
Debug Mode Select to add additional troubleshooting information to logs.

Disable Oncall Leave cleared.

5. In the Rendering Options screen, under General Configuration, enter the following settings.

API Timeout Type the number of seconds to keep the connection to the server open.
Study Timeout Type the number of hours to keep the imageservice/study thread open.
Prefetch Interval Type the number of minutes keep to studies in the send queue.

Cache Timeout Type the number of days to keep locally cached studies before purging.
Cache Directory Type the fully qualified path to the local cache

(default = c:¥viztek¥exa¥cache¥localcache)

Study Count Type the maximum number of studies to keep in local cache.

RAM Usage Type the maximum number of megabytes of RAM to use for prefetching and local
rendering.

Max Threads Type the number of simultaneous threads available to download studies.
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Parallel Prefetch

Leave blank.

Cache Disk Usage

Move the slider to set the maximum percentage of hard disk to use for prefetching and
local rendering.

Oncall Interval

Type the number of minutes to elapse before checking for new studies to prefetch.

Prefetch Priors

Select to include priors when prefetching.

Enable Skinline
Detection

Select to make Skinline Detection available when viewing prefetched studies.

6. Select ACTIVATE.

Location and contents of screens

Burger menu

The burger menu contains the following options.

Burger > Worklist

500-000577A
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Viztek, Pace
COMAGURATION
DREHBOARD
WORKLIST
PATEEMT ARRIVAL WORKLIST
PATENT
QUERY FRETRIEVE
SCHEDRLE
DILLING
PAYMENTS
REPORTS
TOOLS
SETUR
FORTAL REG. USERS

INTERFACE

~

Burger > SETUP
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Witk Poca
DASHEDART
WORHLEST
PATIENT ARRTVAL WORKLIST
PATIENT
QUERT/RETRIEVE
SCHEDULE
BILLIG
PAYMENTS
BEPOHTS
TS
SETUP

PORTAL RED, USERS

INTERPALE

Burger > BILLING
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Wiriek, Pas

QAEHHOAHD

WORKLIFT

PATIENT ARRIVAL WORKLIST

PATIENT

OQUETY!RETRIEVE

SCHEDIRLE
BRLLING
PRYMENTS

REPORTE

EETIR
PORTAL REG. USERS

INTERFACE

eright (]

Worklist
Worklist > ALL STUDIES

= Worklist

ALL STLNRES

Worklist > Settings > User Settings
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User Sei‘tings
Viewer Settings

Local Service Settings

Worklist > Settings > Viewer Settings

User Settings

Viewer Seftings

Local Service Setfings

Worklist > Settings > Local Service Settings

User Settings

Viewer Settings

Local Service Settings

Worklist > PACS Actions
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PACS ACTIONS

Mew Study

Walk-In Appointment
CD Burn

Compare Study
Merge/Split

Import Images
Purge All Deleted

Export Worklist
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Office menu

The setup area (or "office") menu contains the following options.

OFFICE > Office

Providers & Resources

Co Scheduling & Codes
0O DICOM
Billing
Meaningful Use
User Management
General
HL7

Co
Log
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Billing

Billing > Claims

CLAIMS

ALL CLAIME

STUDY DATE CLATA DATE

12 52032 - G R E

O @@ & ewoizaes o01A202F
U ¢ E B eyoagzz el el e
(W] ¢ B & avirrioea (1P R ] i

Billing > Setup

ELECTROMNIC CLAIM {ED)

CLEATNORCHEE DiLLIK

A wl oA

\Worker Compensation Board DireciE

Patiznk

Paliens
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PATIENT MAME

Test, Richard
Test, Jiil

Test, Judy
Test, Judy
Test, Judy
Test, Stephane
Test, Stephans
Test, Stephane

Test, Helen

VALIDATE

CLEARIE

All

Warker C

Refresh Settings

Adjustment Codes
Billing Codes
Billing Clagses
Claim Status

Collections Process

Delay Reasans
Billing Providers
Provider Id Code Qualifiers

Billing Messages
Fayment Reasons
CAS Group Codes
CAS Reazon Codes

Status Color Codes

Ei||ing Validations
EDIVERA Templates
EDI Clearinghouses
Insurance Mapping
Printer Templates

Auto Billing
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Screens in the Edit Study screen

Edit Study > PATIENT INFORMATION
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